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Copyright and Trademark Notice

Copyright © 2009 by Parker Automation. All rights reserved. No part of 
this publication may be reproduced, transmitted, transcribed, stored in a 
retrieval system, in any form or by any means, mechanical, photocopying, 
recording or otherwise, without the prior written consent of Parker 
Automation.

While every precaution has been taken in the preparation of this manual, 
Parker Automation and the author assume no responsibility for errors or 
omissions. Neither is any liability assumed for damages resulting from the 
use of the information contained herein. All product and company names 
are trademarks of their respective companies and licenses.

The following products are copyright their respective owners: Microsoft, 
Microsoft Windows, and Windows CE.

Product Warranty Information

Parker Automation provides top quality products through rigid testing and 
the highest quality control standards. However, should a problem occur 
with your hardware, Parker’s standard product warranty covers these 
items for 24 months from the date of shipment from Parker. Exceptions 
appear below:

• Software revisions that occur within 60 days after purchase are 
available under warranty upon request. Please review the PFD License 
Agreement for additional software warranty information.

Should you have any questions about your application or need technical 
assistance, please call Parker Electromechanical Product Technical Support 
department at 513-248-1714, 8:00 a.m. to 5:00 p.m., Monday through 
Friday, Eastern Time. You may call this same number after hours for 
emergency assistance. See Customer Support Services on page 1-4 for 
more information about support products and services.
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OVERVIEW AND SUPPORT SERVICES 1
Thank you for purchasing our Parker Factory Display Manager Human-
Machine Interface (HMI) product. The Parker Factory Display is an 
embedded HMI platform with a distributed user interface. The Parker 
Factory Display employs a unique embedded client/server architecture 
providing a highly functional HMI solution that is extremely easy to 
configure and deploy.

Please take time to review this manual before configuring and designing 
your Parker Factory Display Manager projects.

Using this Manual

This manual is designed to help you configure, design, and deploy your 
Parker Factory Display Manager projects. The manual and describes all 
areas of the HMI interface including the configuration of tags, alarms, lists, 
and message displays. Also included are tutorials to assist you in getting 
up and running in a short period of time. 

This manual is divided into the following chapters:

Chapter 1 — Overview and Support Services: Presents an overview of 
this manual, and the other documentation components provided with the 
Parker Factory Display. This chapter also describes Parker Automation’s 
customer support services.

Chapter 2 - System Requirements & Installation: This chapter 
describes the minimum system requirements to use the Parker Factory 
Display software. Also described are the system installation procedures 
and product licensing requirements.

Chapter 3 - What is the Parker Factory Display: Provides an overview 
of the Parker Factory Display product. Describes the Parker Factory 
Display, Shell, Designer, and the Runtime interface. 

Chapter 4 - Using the Parker Factory Display Manager: This chapter 
describes the Parker Factory Display interface along with all the features 
and menus associated with it. Information in this chapter can also be found 
within the Parker Factory Display help system.

Chapter 5 - Using the Shell Environment: Provides a complete 
description of the Shell interface. User Administration, configuring 
communication drivers, import/export features are just some of the topics 
discussed in this chapter.

Chapter 6 - Using the Design Environment: Provides a description of 
all the common menus and dialogs available within the Parker Factory 
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Chapter 1: Overview and Support Services Using this Manual
Display Designer interface. Also provides a brief introduction to each of the 
editors such as the tag, alarm, and list editors.

Chapter 7 - Using the Tools: This chapter provides a specification sheet 
for each tool object in the Parker Factory Display. These specification 
sheets describe all the properties and commands associated with a tool. 
Also included in this chapter is a tutorial that steps you through a simple 
project containing a couple tools.

Chapter 8 - Working with Graphics: This chapter provides a 
specification sheet for each graphical object in the Parker Factory Display. 
These specification sheets describe all the properties and commands 
associated with a graphic. Also included in this chapter is a tutorial that 
steps you through a simple project containing a couple graphic objects.

Chapter 9 - Using the Tag Editor: Provides a complete description of the 
Tag Editor. Presented is information on system tags, how to create tags 
within the Tag Editor, the available functions and operators, and topics on 
scaling and tag validation rules.

Chapter 10 - Using the Alarm Editor: Complete description of the Alarm 
Editor features and functions is provided. Alarm Editor menus and dialogs 
are described along with steps on how to create alarms within the editor.

Chapter 11 - Using the List Editor: This chapter describes all the menus 
and dialogs associated with the List Editor. Steps on how to create lists are 
provided.

Chapter 12 - Using the Message Editor: Message Editor menus and 
dialogs are completely described within this chapter. Also included are 
steps to create, modify, print, and delete message files.

Chapter 13 - Working with Animation: This chapter describes in detail 
the five types of animation connections that can be created and applied 
within the Parker Factory Display. Grouped animation is also discussed 
along with a tutorial that steps you through configuring each type of 
animation connection.

Chapter 14 - Using the Runtime Environment: Provides an overview of 
the Parker Factory Display runtime interface. Runtime error icons are 
described within this chapter.

Chapter 15 - Multiple Language Support: Provides an overview of the 
Parker Factory Display language support features and procedures.

Chapter 16 - Working with Communication Drivers: This chapter 
provides configuration and overview information on the Parker Factory 
Display drivers. Each Parker Factory Display driver has help information 
available and this chapter directs you where to access this information.
 Parker Factory Display User Guide  1-2



Chapter 1: Overview and Support Services Documentation Library
Documentation Library

The Parker Factory Display documentation set contains all the information 
you need to configure, install, and use the Parker Factory Display HMI 
product. The Parker Factory Display documentation set is described below.

Parker Factory Display User Guide - This is the document you are 
reading. It provides detailed information about the Parker Factory Display 
product and describes how to configure, and deploy a Parker Factory 
Display project. Most of the information contained in this manual can also 
be accessed through the online help system within Parker Factory Display.

Parker Factory Display Manager Help - Parker Factory Display Manager 
has a complete help system to allow easy access to information specific to 
the PFD Manager interface. This help system is also included in this 
manual, refer to chapter 4.

Parker Factory Display Help - Parker Factory Display help refers to the 
help system that resides on the PFD device. This help is contact sensitive, 
providing you information at the point where you most need it. The 
information contained within this help system is also within this manual in 
it’s entirety for your reference.

Parker Factory Display Quick Start Guide - This manual is a tutorial 
that enables you to develop an application that closely resembles the type 
of data most likely desired from the PFD installation. This manual is 
available on the Documentation, Utilities CD shipped with the PFD. It is 
strongly encouraged that you read the Quick Start Guide and perform the 
tutorial as that will enhance your understanding of the product and also 
allow for quick project development.

Parker Factory Display Hardware Installation Guide - This manual is 
a detailed installation document. It describes the complete installation 
requirements and specifications of the PFD display. 

Vendor Display Documentation - This document is from the vendor of 
the display unit. This document contains information on the programming 
of the various features available within the display. 
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Chapter 1: Overview and Support Services Documentation Standards
Documentation Standards

As you read this manual, notice that it uses the following documentation 
standards:

Text Conventions

ISO Symbols

Customer Support Services

Parker welcomes your thoughts and suggestions on our products and 
services. You can contact Parker by telephone, E-mail or fax. You can also 

Style Type of Text

Bold Names of buttons, tabs, menus, menu items, commands, files, 
keyboard keys, dialog boxes and other important terms.

Italic Titles of User Guides, chapters, or sections and cross-references.

Courier 
font

Text to be entered from a keyboard.

+ Indicates two or more keyboard keys that must be pressed 
simultaneously. For example, Ctrl+Alt+Delete.

Note Alternative approaches or issues you should be aware of while 
using a particular function.

Important Information that will save time and minimize problems.

Warning Information that will prevent equipment damage or personal 
injury.

Symbol Meaning

 
This symbol is the International Standards Organization (ISO) 
symbol for Caution (ISO 3864 No. B.3.1). This symbol denotes 
information that could affect operation of the monitor if the 
information is not properly followed. 

 
This symbol is the ISO symbol for Caution - risk of electrical 
shock (ISO 3864 No. B.3.6). This symbol denotes information 
that could cause personal injury from electrical shock or damage 
to equipment if the information is not properly followed. 
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Chapter 1: Overview and Support Services Customer Support Services
visit us on the World Wide Web to learn about the latest hardware, 
software, and customer support services.

Parker recognizes that every customer and every application has different 
support needs, as a result Parker offers a variety of support services 
designed to meet these needs. Parker offers two types of customer support 
services:

• Product Technical Support

• Technical Training

Customer Support

Main Telephone 513-831-2340

Technical Support 513-248-1714

Fax 513-831-5042

E-mail Sales: emn_sales_ctc@parker.com

Support: emn_support_ctc@parker.com

Training: emn_training_ctc@parker.com

World Wide Web http://www.Parkermotion.com
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Chapter 1: Overview and Support Services Customer Support Services
Product Technical Support

The Product Technical Support department welcomes any questions that 
might arise as you develop or run your applications. We offer 
complimentary support for all customers, including end users, original 
equipment manufacturers (OEM), system integrators or distributors.

If you have a question about the product, be sure to complete the following 
steps:

• Check any release notes that shipped with the product. These notes 
provide important information about the product.

• Consult the documentation and other printed materials included with 
the product. 

• Visit the Parker Automation Web site and register for the support 
forum. You can find the support forum from the Web site’s home page: 
http://www.parkermotion.com.

If you cannot find a solution using one of the above sources, contact our 
Product Technical Support department at 513.248.1714, 8:00am to 
5:00pm Eastern Standard time. 

Technical Training

Parker offers training on all of our products, either at Parker in our state-
of-the-art training facility, or at your site.

You can contact the Training Coordinator by telephone or e-mail:

• Telephone: 1-800-233-3329

• E-mail Parker Training: emn_training_ctc@parker.com

You can view a current training schedule on our web site at 
www.parkermotion.com.
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SYSTEM REQUIREMENTS & INSTALLATION 2
This chapter lists requirements for the installation of the Parker Factory 
Display (PFD) software. For information on installing the Parker Factory 
Display device, refer to the PFD Installation Guide. Information regarding 
licensing your PFD installation is also presented. 

The Parker Factory Display Manager is a Windows-based program for a 
desktop or laptop computer. It makes the development of HMI projects 
portable by allowing you to create and edit projects “offline”, and then 
deploy those projects to the Parker Factory Display platforms. 

The Parker Factory Display is an embedded HMI platform with a distributed 
user interface. The Parker Factory Display employs a unique embedded 
client/server architecture providing a highly functional HMI solution that is 
extremely easy to configure and deploy. Since the software is embedded 
within PFD devices there are no system installation requirements or 
installation procedures. Your PFD device already comes with the software 
installed. 

Parker Factory Display Manager System Requirements

The following table lists the system requirements for installing the Parker 
Factory Display Manager software.

Component Minimum System Requirements

Processor Pentium III 800 MHz

Operating System Microsoft®  Windows®  2000, or XP Professional

Memory 256 MB RAM

Disk Space 50 MB free hard drive space

Additional Drives CD-ROM drive

Display 1024 x 768 video resolution, 16-bit color

(recommended: 1280 x 1024 video resolution or 
higher)

Mouse Microsoft compatible mouse or other pointer input 
device

Networking (Project Deployment) 10 MB Ethernet network interface card 

Additional Software Microsoft Internet Explorer®  6.0 or higher
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Installing the Parker Factory Display Manager Software

Complete the following instructions to install the Parker Factory Display 
Manager on your workstation.

1 Insert the CD and the installation wizard launches. You may also 
double-click the Setup.exe file located on the CD within the Parker 
Factory Display Manager folder. 

2 The installation wizard launches. 

Follow the directions provided by the installation wizard. 

You can now design, create, and deploy Parker Factory Display projects to 
Parker Factory Display devices. You can also perform a whole host of other 
operations. Refer to Chapter 4 - Using the Parker Factory Display Manager 
for a complete description of the features and capabilities of the Parker 
Factory Display.
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DISPLAY? 3

This chapter introduces you to the Parker Factory Display software 
package, it provides an overview of the Parker Factory Display, the Shell 
environment, the Design environment, and the Runtime environment. 

Introducing the Parker Factory Display 

Parker Factory Display is a compact and economical Human-Machine 
Interface (HMI) solution that leverages the availability of the Internet and 
IP networks. Using an Internet connection or an internal LAN (or other IP-
based network) and a web-browser, you can easily create, view, edit, and 
publish HMI applications from anywhere in the world. 

The Parker Factory Display (PFD) runs in a browser-based environment 
combining a rich, graphical runtime interface with HMI development tools. 
The PFD employs a client/server architecture providing a highly functional 
HMI solution that is extremely easy to configure and deploy. 

The PFD offer the following features:

• Simple, yet powerful development tools

• Feature-rich runtime operation

• Advanced networking and Web publishing

• Global remote support

Development Tools

PFD software offers an integrated development environment where you 
can design and edit applications on the Runtime system or on a Windows-
based workstation. With the PFD, HMI applications can be served and 
edited remotely from any standard PC Web browser - in real time. 

Development features include:

• Sophisticated graphics

• Easy, object-based development tools including: pushbuttons, numeric 
entry and displays, selection entry, bar graphs, meters, gauges, 
sliders, message displays, input lists, and more

• Drag and drop editing

• Integrated graphics library and preconfigured styles
 Parker Factory Display User Guide  3-1



Chapter 3: What is the Parker Factory Display? Introducing the Parker Factory Display
• Ability to develop and save your own styles

• Complex graphic and animation development

• Alarm tool with automatic collection of historical data

• Integrated Tag, Alarm, List and Message editors

Runtime Operation

PFD software is pre-installed and bundled with Parker’s PFD hardware 
which is designed to optimize the performance, storage and connectivity 
features of the PFD HMI. The PFD device is available with 32”, 40”, or 46” 
displays, the latest AMD LX800 processor technology, 128MB to 512MB 
DRAM and a full range of standard features such as CompactFlash storage, 
2 USB ports, 2 RS-232 and RS-232/422/485 ports, and a 100-base T 
Ethernet port. For more information, refer to the Parker Factory Display 
Hardware Installation Guide. 

The Runtime interface contains a rich, graphical environment that runs 
sophisticated graphics, animations, and video to enhance the operator 
experience. 

Networking and Web Publishing

PFD provides industry-leading Web publishing and multi-client support in 
an affordable distributed HMI package. Supporting local or remote 
development, there are no version control issues or online development 
costs. Since PFD applications are developed, edited, and run in a browser, 
you can easily publish upgrades and applications using a client/server 
approach to any global location with an Internet connection and a Web 
browser. 

Choose between point-to-point ethernet connection, LAN connection, or 
Internet connection for access from virtually anywhere in the world, using 
only a standard Web browser on a desktop or laptop computer. 
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The diagram below shows a standard Web browser interfacing with the PFD 
Shell located on the PFD device. 

Global Remote Support

The most cost-effective way to support machinery installations or remote 
stations across geographical distances is through the Internet or other IP 
connections. The PFD makes it easier than ever to develop, edit, monitor, 
diagnose, share, and control machine applications online because it is just 
as capable of serving over an ethernet connection, as it is to the local 
display. 

This offers the benefit of optional remote access for HMI development, 
deployment, and execution with no additional cost, complexity, or effort. 

Putting it All Together

At the heart of the Parker Factory Display lies an embedded server also 
known as the Shell, which houses the full-featured HMI Design and 
Runtime environments, as well as communication drivers for connecting to 
control devices. This core component provides the complete set of services 
for the creation, management, and runtime execution of operator interface 
projects. 

To accomplish all of this, the PFD software is made up of the following 
components: 

• PFD Manager

The Manager is what allows you to create and edit projects offline, as 
well as deploy them to PFD platforms. For more information on using 
the PFD Manager, refer to Chapter 4, Using the Parker Factory Display 
Manager.

• Shell Environment

The Shell environment is where you setup your initial project, manage 
users, as well as change properties and settings as needed during 
 Parker Factory Display User Guide  3-3



Chapter 3: What is the Parker Factory Display? Parker Factory Display
development. For more information on using the Shell, refer to Chapter 
5, Using the Shell Environment.

• Design Environment

The Design environment is where you build all of your message tables, 
lists and panels using tools, graphics, tags, and alarms. The bulk of 
your development is spent in the design environment. For more 
information on using the Designer, refer to Chapter 6, Using the Design 
Environment.

• Runtime Environment

The Runtime environment is where you test your project and simulate 
it running on the PFD device. For more information on using Runtime, 
refer to Chapter 14, Using the Runtime Environment.

Parker Factory Display

The Parker Factory Display Manager is a Windows-based program for a 
desktop or laptop computer. It makes the development of HMI projects 
portable by allowing for the creation and editing of projects “offline”, and 
deployment of the projects to PFD platforms. Parker Factory Display 
(Manager) includes a PFD emulator which is used for editing and testing 
HMI projects, therefore replicating what you would see on the PFD device.
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.

The Manager functions as an HMI project editing, deployment, and 
distributed maintenance environment. The Manager can connect directly to 
remote devices for editing projects online, sending or getting projects to 
and from the device, or updating the device system files. It has many 
features that make it easy to maintain and manage multiple local or 
remote PFD installations.

All project data is kept in a single file on your personal computer, making it 
extremely easy to back up, archive, or exchange projects with other users 
via E-mail, network, or removable storage.

The Manager is an optional application as you can design HMI projects 
directly on the PFD device or through a remote browser. Using the Manager 
does provide you with the ability to manage multiple PFD projects within a 
single application. 

Refer to Chapter 4, Using the Parker Factory Display Manager, for a 
complete description of the features and functions associated with the PFD.
 Parker Factory Display User Guide  3-5



Chapter 3: What is the Parker Factory Display? Shell Environment
Shell Environment

The PFD Shell is a software program that runs on the PFD device. Each 
time you open a project, the Shell window is displayed as shown below. 

The Shell environment is used for a variety of device configuration 
operations. You can also use the Designer and Runtime environments from 
the Shell interface. Some of the tasks the Shell performs are listed below. 

• configure user administration settings 

• launch utilities 

• import and export files into and out of the device 

For detailed information on working in the Shell, refer to Chapter 5, Using 
the Shell Environment.

Design Environment

Once you have setup and created your project, you are ready to design all 
of the components of your application. All HMI panels are developed in the 
PFD design environment. 
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The Designer is where you build all of your panels, message tables, and 
lists. The bulk of your development is spent in the design environment. 
From the Designer, you can access the following editors:

• Project Editor

• Panel Editor

• Tag Editor

• List Editor

• Continuous Improvement Editor (Alarm)

• Message Editor

Refer to Chapter 6, Using the Design Environment, for a complete 
discussion of all the functions and features of the Designer.
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Runtime Environment

The Runtime environment refers to the software environment that lets you 
run your project. Runtime mode includes the ability to display and interact 
with panels, monitor real-time and historical alarms, communicate with the 
built in drivers, and serve tags to clients. 

The server residing on the PFD device is the run mode component that 
drives your project. Your project can reside on a local PC, such as in offline 
development mode and remote access mode, or it can reside on the PFD 
box itself as in normal run mode operation. 

Refer to Chapter 14, Using the Runtime Environment, for a complete 
discussion of the Runtime environment.

What is a Project?

An Parker Factory Display project is composed of the following 
components:

• Panel configuration

• Tool assignments

• Tag configuration

• Message and Input List configuration

• Alarm configuration

• Shell settings

• Communication and driver configurations

Parker Factory Display supports the development of multiple projects. 
Parker Factory Display devices support one active project only. Therefore, 
using the Parker Factory Display software, you can develop many projects 
for use with many different applications.

Projects are sent to the Parker Factory Display device through the project 
transfer capabilities within the Parker Factory Display software. However, 
you can also get projects off the Parker Factory Display device. Projects 
can not be manually added to Parker Factory Display devices. 

Projects are maintained as a single file with a .pfd extension. This makes it 
easy to transfer to the PFD device. The individual project files will then be 
extracted from the .pfd file once successfully transferred to the device. 
With the project existing as a single file, it is easy to back up, archive, or 
exchange projects with other users via E-mail, network, or removable 
storage.

Note: For project tracking purposes, each project may be tagged with a 
custom version number. This is described in detail in Project Versioning 
and Compatibility.
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What are Local and Remote Projects?

The Parker Factory Display uses the terms local and remote to differentiate 
between where Parker Factory Display projects are located. 

A local project is one that is stored on the development workstation where 
the Parker Factory Display software is installed. A remote project is one 
that is stored on an Parker Factory Display device that is connected to the 
development workstation. The Parker Factory Display software has the 
capability to work with projects that are either local or remote. 

Sections of the Parker Factory Display Shell may be grayed out because 
they access controls that are only meaningful in the local context.

For more complete information on working with local and remote projects, 
refer to Using the Local and Remote Panes on page 4-5.
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This chapter describes the Parker Factory Display Manager and its 
components. Using the Parker Factory Display (PFD) Manager provides you 
with the ability to manage multiple PFD projects within a single application. 

Overview of the Parker Factory Display Manager Interface

The Parker Factory Display Manager is a Windows-based program for a 
desktop or laptop computer. It makes the development of HMI projects 
portable by allowing for the creation and editing of projects “offline”, and 
deployment of the projects to PFD platforms. PFD Manager (Manager) 
includes a PFD emulator which is used for editing and testing HMI projects, 
therefore replicating what you would see on the PFD device.

The Manager functions as an HMI project editing, deployment, and 
distributed maintenance environment. The Manager can connect directly to 
remote devices for editing projects online, sending or getting projects to 
and from the device, or updating the device system files. It has many 
features that make it easy to maintain and manage multiple local or 
remote PFD installations.

All project data is kept in a single file on your personal computer, making it 
extremely easy to back up, archive, or exchange projects with other users 
via email, network, or removable storage.
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Using the Manager Workspace

The Parker Factory Display allows you to develop projects on a local 
workstation for later transfer to remote devices. The PFD Manager can also 
connect directly to a remote machine, open the remote project, and edit 
the project all the while connected to the remote device. 

The PFD workspace is an integrated browser that is used for editing and 
running projects in a local PFD unit. The workspace emulates what would 
be seen on an actual PFD workstation. 

With no project loaded a welcome screen appears in the workspace as 
shown below.
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Before creating a project, you should become familiar with the PFD 
Manager window: 

With a project loaded in the Shell workspace, the name of the project 
preceded by either Local:\\ or Remote:\\ is displayed in the upper left 
corner of the Manager window. 

When a project loads, the Shell environment is displayed. If the project is a 
local project, then your user rights are set to Administrator. If the project 
is a remote project, then your user rights are determined by the PFD 
device. For more information on user administration, refer to Chapter 5, 
Using the Shell Environment.

The Manager window contains the following components:

• Menu

The menu allows you to select your display size, whether you want to 
be prompted to upgrade your software, access help information and 
close a project or exit out of the PFD software. 

Status Bar Local Pane Remote Pane Progress Bar

Shell Tab COMM Tab Project name and path
PFD Manager Menu

Shell Workspace
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• Shell Tab

The Shell tab (or environment) is displayed after opening a local or 
remote project, and is an integrated browser that is used for editing 
and running projects on a local computer. The Shell workspace 
emulates what would be seen on an actual PFD workstation. The Shell 
is where you initially setup your project, manage users, and change 
properties and settings as needed during development. 

• COMM Tab

The COMM tab is displayed once a local project is open. A local project 
is an application currently in development and resides on your local 
computer. Use the COMM tab to add channels and devices to your 
project. 

• Project Tab

The project tab is displayed only when choosing a project to open. You 
can either create a new project or open a recently viewed project. 

• Local Pane

The Local Pane lists all of the PFD projects that currently reside on the 
local workstation. If the project is a local project then your user rights 
are set to Administrator. 

• Remote Pane

The Remote Pane lists all of the PFD machines that are accessible from 
your local workstation and the corresponding projects that are 
currently running. 

• Status Bar

The status bar, located on the bottom of the Manager window, is used 
to display any messages from the PFD Manager. 

Resizing the Workspace 

The workspace may be resized, enabling you to observe the size of the 
screen and how it should appear on the PFD device.

To change the size of the workspace, select one of three menu items: 
Display�Small, Medium, or Large from the Manager menu. 

Opening a Project

When you open or load a project, the PFD copies the project from the 
project folder into a temporary folder for editing purposes. The file in the 
temporary folder is then loaded into the Shell. 

To open a project, highlight the desired project in the local or remote pane 
and double-click on it. You can also choose the project from the welcome 
screen under “Open a Recent Project”. 
 Parker Factory Display User Guide  4-4



Chapter 4: Using the Parker Factory Display Manager Using the Local and Remote Panes
You can only open one project at a time per instance of the PFD Manager 
software. Opening another instance of the Manager allows you to open a 
second project if desired. 

If the project was created in an earlier version of the PFD Manager, and the 
Prompt to Upgrade option is selected, then the Upgrade Project dialog is 
displayed. Select Upgrade Now to upgrade the project or Do Not Upgrade 
to leave the project in it's current version. The project is opened in the 
browser with the Shell main page displayed.

If the Prompt to Upgrade option is not selected, the project is opened in 
the browser with the Shell main page displayed. 

Saving the Project 

To close and save a project, select the Close�Close Project, from the 
Manager menu. Closing a project moves your project file from the 
temporary folder and saves it in the project folder. After closing the 
project, the welcome screen is displayed.

Using the Local and Remote Panes

The lower section of the PFD workspace includes two panes. The left pane 
is used to display local project information while the right pane is used to 
display information concerning a remote PFD device or removable drive.

The left pane is referred to as the “local” pane while the right pane is 
referred to as the “remote” pane. 

Projects located on the local system appear in the local pane. For the 
remote pane, the PFD detects remote devices and populates the remote 
pane with those devices. The Machine Name or IP address of the device is 
displayed in the remote pane. 

Viewing the Local and Remote Panes

You can adjust the lower section of the PFD window by moving the divider 
that separates the workspace from the local/remote pane area. This 
provides more space to work with your panels.

To hide or display the Local and Remote panes in the PFD Manager 
window, click on the horizontal divider as shown below. This expands (or 
 Parker Factory Display User Guide  4-5



Chapter 4: Using the Parker Factory Display Manager Using the Local Pane
collapses) the window. You can also expand or collapse the Remote pane 
by clicking on the vertical divider. 

Using the Local Pane

The local pane displays a list of all of the PFD projects that currently reside 
on the local computer. The project list contains information such as the 
project name, version, and last modified date. The list of projects appears 
in alphabetical order as shown below.

In the project list, the project column displays the name of the project that 
resides on the local workstation. The version column displays the version of 
the project. Finally, the modified column lists the date and time the project 
was last modified.

The local pane displays a "pencil" icon next to the project that is loaded. 
This indicates the project is currently being edited.

Horizontal Divider

Vertical
Divider
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Icons displayed at the top of the pane are also available from the Local 
Pane menu. To access the menu, right-click on the Local Pane. The menu 
options are described in Table 4-1, below. 

Table 4-1: : Local Pane Menu Commands

Icon
Menu 
Option Definition

New Creates a new project. Enter the project name in the New 
Project dialog box. The name must be alphanumeric and is 
limited to 64 characters. Special characters such as 
underscores and dashes are not allowed. 

The default path to where the project is located on the local 
machine is:

C:\Program Files\Parker\Parker Factory Display 
Manager\Projects

The project path is setup during installation.

Open Opens a project in the Shell. Highlight the project you want to 
open and use the icon or menu option to open it. You can also 
double-click a project within the local pane and it launches 
within the browser. 

Opening a project created in an earlier version of the PFD 
Manager will display a prompt if the Prompt to Upgrade option 
is selected in the Settings menu.

Open projects are displayed with a pencil icon next to the 
project name.

Once a project is opened, if you try to copy, delete, rename, 
or send the project, a prompt appears stating that you will 
need to close the project in order to continue with the 
operation.

If another project is already open in the browser, you are 
prompted to close the project before opening the newly 
selected project. 

Copy Use the Copy command to copy a project then paste it into 
the local pane. Copying and pasting of projects works just like 
Windows Explorer.

If no project is selected, the Copy icon is grayed out.

Paste Use the Paste command to paste the copied project into the 
local pane. Pasting a project automatically renames it to 
<project_name>(1).
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Selecting and Opening Projects 

Select a project by clicking on a project within the pane. Open the project 
by selecting the Open icon; the highlighted project is launched in the 
browser. You can also open a project by double-clicking on the project 
name within the Local Pane.

When you open or load a project, the PFD copies the project from the 
project folder into a temporary folder for editing purposes. The file in the 
temporary folder is then loaded into the Shell. 

Delete Use the Delete command to remove the selected project. Only 
one project at a time can be deleted. Deleting a project 
removes the project .pfd file from the projects directory on 
the local machine.

If no project is selected, then the Delete button is grayed out.

Rename Use the Rename command to rename the selected project in 
the pane. Enter the new name for the project in the text box.

You can also rename a project by either double-clicking a 
project name or pressing F2 with the name highlighted. When 
editing the project name, press the Enter key to save the 
name, or press the Esc key to revert back to the original 
name.

Modify 
Version

Use the Modify Version command to change the version 
number of the selected project. This allows you to keep track 
of any changes made to the project, if desired.

The version number of a project is a two digit number. The 
first digit represents the major release of the PFD software 
(and cannot be changed), while the second digit represents 
the unique number assigned to the selected project. 

Use the scroll box to change the second digit of the version 
number. The maximum number that can be entered is 100.

Upgrade 
Project

Use the Upgrade Project command to select a project to 
upgrade for use with the latest version of the PFD. 

Refresh Use the Refresh command to reload the local pane with the 
current list of projects.

Icon
Menu 
Option Definition
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To open a project, highlight the desired project in the local or remote pane 
and double-click on it. You can also choose the project from the welcome 
screen under “Open a Recent Project”. 

Sorting Columns 

You can sort the columns in the local pane by clicking on the column 
header you want to sort. The PFD defaults to sorting the local pane 
alphabetically then numerically by project name.

User Administration Settings 

Through the Shell, a project is configured with user administration 
settings. These user settings determine the editing and viewing rights of 
each user of the project. For a complete description of User's and User 
Levels, refer to Chapter 5, Using the Shell Environment. 

Working with local projects in the PFD bypasses all of the user 
administration settings. Therefore, you never have to logon to a local 
project. 

Each time a local project loads, it starts up in the Shell with administrator 
rights. It does not matter what the user administration settings configured 
for the project actually are. 

Once the project is loaded in the workspace and you enter the Designer, 
the project then follows the specified user administration settings. Once in 
the Designer, you can then test the project, which behaves like it would 
normally on the remote device. If the project is closed down and then 
reopened, it opens in the Shell with Administrator rights again.

Project Path 

The default project path is determined by the Manager installation path. By 
default, all projects on the local workstation are saved to the following 
directory:

C:\Program Files\Parker\Parker Factory Display Manager\Projects 

Change the project path by selecting Settings � Local Project Path 
from the Manager menu. You can change the path to edit a project that is 
located on a removable drive or a network drive. 
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Using the Remote Pane

The remote pane consists of a project list, icons and menu commands, and 
project transfer buttons. The project list contains information such as the 
machine name, project name, version, and last modified date. The list of 
machine names are displayed in alpha-numeric order.

In the project list, the machine name column displays the machine name 
or IP address of the PFD device as it was configured in the Shell of that 
device. The project column displays the name of the project that resides on 
the remote device. The version column displays the version of the project. 
Finally, the modified column lists the date and time the project was last 
modified.

Icons displayed at the top of the pane are also available from the Remote 
Pane menu. To access the menu, right-click on the Remote Pane. The 
menu options are described in Table 4-2, below. 
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Table 4-2: : Remote Pane Menu Commands

Icon Menu Option Definition

Open Opens a project in the Shell. Highlight the project you want to 
open and use the icon or menu option to open it. You can also 
double-click a project within the local pane and it launches 
within the browser. 

Before opening the project, the PFD checks to see if the 
selected device is set to require a logon or not. If a logon is 
required, then you must enter a user name and password in 
order to open the project. 

Open projects are displayed with a pencil icon next to the 
project name.

Once a project is opened, if you try to copy, delete, rename, 
or send the project, a prompt appears stating that you will 
need to close the project in order to continue with the 
operation.

If another project is already open in the browser, you are 
prompted to close the project before opening the newly 
selected project. 

Add Machine Use the Add Machine command to manually add a machine to 
the remote pane. Enter either the device IP address or the 
device name in the Add Machine dialog box. 

For more information, refer to Adding Devices on page 4-13.

Remove 
Machine

Use the Remove Machine command to remove the selected 
device from the Remote pane. Only one device at a time can 
be removed.

You can not use this command on a removable drive such as a 
Compact Flash (CF) drive. Therefore, the Remove Machine 
button is disabled if a CF drive was selected. 

For devices that are automatically detected by the network, if 
you remove the device, then refresh the screen, the removed 
device reappears in the remote list if it is still online.

Update 
PowerStation 
Firmware

Use the Update PowerStation Firmware command to update 
the highlighted PFD device with the latest system file. 
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Selecting Projects 

Select a project by clicking on a project within the pane. Open the project 
by selecting the Open button and the project is launched in the browser. 
You can also open a project by double-clicking on the project name within 
the pane. If a machine is not online, the Open button is grayed out.

The remote pane displays a “pencil” icon next to the project that is loaded. 
This indicates the project is being edited.

The remote pane is populated based on the PFD software automatically 
locating the PFD device on the network as soon as it boots up. Any PFD 
devices that are found on the network display within the remote pane. It is 
possible to manually add a device if the device has not appeared 
dynamically, refer to Adding Devices on page 4-13. 

Restart 
Machine

Use the Restart Machine command to reboot the selected 
remote device using the PFD. 

Before restarting the remote device, the PFD checks for a 
logon requirement. If a logon is required, enter the user name 
and password in the dialog box.

When the reboot is initiated, the device being rebooted sends 
out a message to all remote devices that are connected. The 
message informs the remote users that a particular machine 
is being updated and they should try to logon again in a few 
minutes. 

Restarting a device causes a project on the PFD device to 
enter lock out mode. Restarting the device also checks the 
“Edit Project" permission of that user. If the logon user has 
the correct permissions, the PFD then sends a command to 
reboot the device.

After a successful reboot, remote users are able to reconnect 
to the project. 

Removable drives such as CF drives have the Restart Machine 
option disabled.

Update 
Drivers

Use the Update Drivers command to update the drivers on the 
highlighted remote machine. A list of drivers currently 
installed on the local machine is displayed in the Update 
Drivers dialog box. For more information, refer to Updating 
Drivers on page 4-16

Refresh Use the Refresh command to rebroadcast on the network for 
available online devices.

A machine icon indicates a device was found and is online. An 
X indicates the device can not be found.

Icon Menu Option Definition
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Working with the remote project in the Shell environment allows access to 
all options just as if you were working on the local device. Sections of the 
PFD Shell may be grayed out because they access controls that are only 
meaningful in the local context.

Sorting Columns 

The columns are sorted by selecting a column header. The PFD defaults to 
sorting the remote pane alpha-numerically by machine name.

User Administration Settings

Working with remote projects applies all of the user administration logon 
and password settings configured in the Shell. 

Each time you choose to either Open, Send, or Get the project, or Upgrade 
the system file, the PFD checks to see if that device is set to require a 
logon.

If the device requires a logon, a logon dialog appears. The dialog has a 
checkbox to remember the user name and password. If checked, you are 
automatically logged on the next logon attempt and you are not prompted.

The password and user name are only persisted for the current PFD 
session. As soon as the PFD exits, all persisted passwords are removed. 
However, if the password or user name are changed, you are prompted 
again. 

Online Machines 

The Remote Pane detects all devices on the network. Once detected, the 
device displays an icon indicating whether it is connected or not connected. 
Selecting a particular device in the remote pane lists a message in the 
status area indicating whether the device is connected (online) or 
disconnected (offline).

Right-clicking on a project in the remote pane displays several options 
depending whether a device is online or offline. Devices that are offline 
have the Open, Update System File, and Restart Machine options grayed 
out.

Adding Devices 

The Remote Pane is populated with devices that have been automatically 
detected as well as manually added. The remote pane displays a mix of 
device names and IP addresses depending on how the device was added to 
the list. 

When a device is manually added it persists even after the PFD software is 
shut down and restarted. However, if the PFD is not physically connected 
to the network, the list of manually added devices are not present.
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You can use the Add Machine dialog box, shown below, to add a remote 
PFD machine. To open this dialog box, click on the Add Machine icon or use 
the Remote pane menu command. You can add a machine using it's IP 
address or it's machine name. 

To add a machine using it’s IP address, select the IP Address radio button 
and enter the IP address in the box below it. To use the machine name, 
select the Machine Name radio button and enter the name of the remote 
machine or select the "..." button to browse for it's location on the 
network. 

When manually adding a device using the IP address of the machine, the 
remote pane displays the device name if it is connected. If the device is not 
connected, then the IP address appears in the list.

If you add two devices, one using the IP address and the other using the 
name, and they happen to be the same device, both of them display using 
the device name. One of these added devices displays a warning icon and a 
message in the status area indicating that it's a duplicate.

The Parker Factory Display Port number is the machine network port used 
to communicate between the Parker Factory Display and the device. The 
port defaults to number 1235. You may need to change this number if 
there is a service already using this port or if there is a system firewall 
between the Parker Factory Display and the device. Contact your network 
administrator for a valid number to enter in this field. 

If the device you are adding is known to be on your network but does not 
appear in the Add Machine dialog list when you select the Find button, then 
you may need to assign a different Parker Factory Display Port number. 

If the Parker Factory Display finds the manually added device, then finds 
the same device through the network auto-broadcast process, then only 
the manually added device appears in the list. The auto-broadcast process 
occurs each time the Parker Factory Display is launched. 
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Using Removable Drives 

Removable drives are detected and displayed within the remote pane. The 
PFD allows sending and getting projects from removable drives such as 
Compact Flash (CF) drives. Removable drives appear with the drive icon 

shown in the pane. 

If the removable drive does not contain a project, then the drive is 
displayed without a project name next to it. A removable drive can not be 
deleted from the remote pane.

For the CF to be able to run a PFD project, the CF must contain a system 
file that is compatible with the particular PFD device in which the CF 
resides as well as being compatible with the project that you send to the 
device.

If the CF is not properly set up for the PFD device, the PFD displays a 
prompt that the selected media does not contain a valid system file. 
Installing a system file will erase all existing files on the CF. 

Use the PFD to send the system file to the CF if it detects that the media 
has a proper PFD image on it. Refer to the Update System Files section for 
more information on installing a system file.

After a compatible system file is installed on the CF, then the project can 
be sent to the device. 

Updating PFD Device Firmware Files

Selecting the Update PowerStation Firmware button allows you to update 
the PFD software on a remote machine. The Manager automatically filters 
out the system files and only displays the files compatible with the 
hardware in the remote machine. Select the system file you want to send 
to the remote machine from the System drop down box. 

Select the remote machine you want to send the file to from the Send 
System To drop down box. Enter a Username and Password to log on to 
the remote machine as a user before sending the file. You can also attempt 
to connect to the remote machine using the default Remote User Startup 
login on the target machine by checking the box in the middle of the 
screen. 

Select the Send button to begin the file transfer. A confirmation message 
is displayed. Click OK to start the update process or Cancel to cancel out 
of the dialog box.

Note: The system file consists of all files that are not specific to the project 
file, this includes: OS files, COMM server files, swf files, hmi files, 
and help files. The system file is the NK.BIN file. It is not possible to 
transfer a system file from the remote machine to the local machine. 

Once you have selected the OK button, the PFD Manager goes through a 
validation process before sending the system file to the remote machine. 
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1 First, the Manager checks to see if it is compatible with the remote 
machine and able to perform the file transfer. If the local machine is 
not compatible, a message is displayed. 

2 If the local machine is compatible and can connect to the remote 
machine, the Manager checks to see if the remote machine is in a 
lock out mode. If it is locked out, a message is displayed. 

3 If the remote machine is not already in lock out mode, the Manager 
puts the remote machine in lock out mode and the new system file is 
sent. The old system file is deleted and is replaced with the new 
system file. Note that the project file is not deleted. The remote 
machine is then rebooted. A progress bar is displayed during the 
update of the system file.

Updating Drivers 

You can update the drivers on a remote machine using the Parker Factory 
Display. From the Send Drivers To drop down list, select the remote 
machine where you want to send the .dll file(s). The default machine is the 
last one selected. 

Enter a Username and Password to log on to the remote machine as a user 
before sending the driver files. You can also attempt to connect to the 
remote machine using the default Remote User Startup login on the target 
machine by checking the box in the middle of the screen. 

A list of drivers currently installed on the local machine is displayed in the 
scroll box as shown below. 
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Click on the driver you want to send to the remote machine. To select 
multiple drivers, hold down the CTRL button and select the desired drivers. 
To select a series of drivers, select the first driver and hold down the SHIFT 
button, then select the last driver in the series, all drivers in between are 
also selected. 

Select the Send button to send the highlighted driver files to the remote 
machine. 

Transfer Buttons

There are three types of transfers that can take place between the PFD 
workstation and remote PFD devices. 

• Send Projects

• Get Projects

• Update System File

During any project transfer, a progress bar, located below the remote 
pane, is displayed. When a transfer is initiated, a message displays in the 
status area indicating the current activity. 

If the PFD can connect to the remote device, then the transfer process 
begins.
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If the PFD can not connect within 30 seconds a message displays informing 
you to retry.

Sending a Project 

The Send button is used to transfer a copy of a project from the local 
machine to the selected remote device or a removable drive. This is also 
known as replicating a project. 

The remote device goes into a lock down condition for this process and the 
remote user is prompted about the lock down. While in a lock down 
condition, no edits can be made to the project.

When sending a project, the Send Project dialog box is displayed as shown 
below. 

The following table provides a description of the options available from the 
Send Project dialog box. 
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Table 4-3: Sending a Project

Option Description

Send Project To Use this drop down box to select the target remote device. The 
selection list defaults to the name of the remote device that was 
highlighted in the remote pane before selecting the Send Project 
button. 

The drop down box contains a list of all available remote devices. 
Click on the drop down list to change to the device you want to 
download to. 

Username Enter the user name and password within the text box. Both text 
boxes default to blank the very first time. Once you enter your 
information, and select the Send button, it is saved for the 
highlighted remote device.

When another remote device is chosen and its user name and 
password have never been set up before, these text boxes 
automatically fill in with the last sent user name and password.

Password

Attempt to connect... Selecting this box enables PFD Manager to check the Remote 
Startup User setting on the remote device. The Remote Startup 
User setting is located on the Security Options page of the Shell. 
The User name and Password fields are disabled if this checkbox is 
selected. 

If the Remote Startup User setting is configured to Login Required, 
the Manager issues a prompt.

If the Remote Startup User setting is configured to a specific user, 
the Manager checks to see if that user has permission to edit the 
project. If you do not have project edit rights, the Manager alerts 
you.

If you have project edit rights, then the Manager checks the 
number of clients that are connected to the remote device. If there 
are other clients connected to the device, then a message is 
displayed noting that other clients are connected. 

Note: Continuing with the Send operation forces all connected 
clients off the device.

Send Complete Project Select this option to send the complete project to the remote 
device. The complete project includes the Panels, Tools, Tags, 
Alarms, User Admin Settings, and Driver configuration settings. 
This option is checked by default. 

Application Files Select this option to send the Panels, Tools, and Alarms, in the 
transfer. This option is only available if the Send Complete Project 
option is not checked.
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Choosing one of these options retains the selection so that the next time 
you send a project, the same configuration files are sent.

Select the Send button to download either the entire project or selected 
files to the remote device. The files that are sent to the remote device are 
dependent on which option button was selected on the Send Project dialog.

Once you click the Send button, the program saves and retains the settings 
located under the Options section of the dialog.

For example, if you choose to download only application and driver files, 
the next time you download to the device, the PFD Manager retains this 
configuration.

Send Project Validation 

Before sending a project, the PFD Manager performs several validation 
steps to ensure that you have the correct permissions to send the project 
to the remote device. These validation steps ensure that the remote device 
is secure from unauthorized users attempting to download projects to the 
device. These steps are summarized below.

• System file and project compatibility are checked.

• Remote Startup User setting is checked against the current user name 
and password.

• User edit permissions are checked.

• Available space on the remote device is checked.

The PFD Manager first checks the compatibility of the system file on the 
remote device and the project that is selected. If the project is newer than 
the version of the system file located on the remote device, then the PFD 
Manager prompts you to update the system file, if one is found. You must 
update the system file on the remote device before replicating the project. 
Refer to Updating System Files for more information.

User Admin Settings Select this option to send the User Administration settings in the 
transfer. User administration settings are configured in the Shell. 
This option is only available if the Send Complete Project option is 
not checked.

Communication Driver 
Configuration

Select this option to send the selected driver (dll) and the driver 
configuration file (database file) in the transfer. Also included in 
the transfer are the help and templates files. This option is only 
available if the Send Complete Project option is not checked.

Alarm Log Select this option to send the alarm log associated with the 
selected project to the remote device. This option is only available 
if the Send Complete Project option is not checked. By default, this 
option is not checked. 

Option Description
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If the system file on the remote device is compatible with the project that 
is selected to download, the PFD Manager begins a series of additional 
validation checks. 

The PFD Manager validates the Remote Startup User configured in the 
Shell of the selected project. You can set the Remote Startup User option 
to either require a log on or a specific user. 

A log in prompt is displayed if a user name and password are required. If 
the Remote Startup User is set to a specific user, then the current user is 
validated against this setting. For details on setting the Remote Startup 
User option, refer to Chapter 5, Using the Shell Environment.

Once logged onto the remote device, the PFD Manager checks to see if you 
have permission to edit the project. If you have edit permissions, then the 
project transfer takes place. If edit permissions were not granted, then the 
project transfer does not occur.

Once all validations are confirmed, the PFD Manager notifies all other 
clients connected to the remote device that they will be disconnected. 

Finally, a check for available space on the target remote device occurs. If 
there is insufficient storage memory on the device then the project can not 
continue to be sent and you are prompted, otherwise the transfer takes 
place.

When sending a different project to the remote device than what is 
currently on the unit, the transfer process replaces the old project with the 
new one. You can see the new project in the list box of the Remote pane 
after the transfer is completed.

Get a Project

The Get project button is used to transfer a copy of a project from a 
remote device or removable drive to the local machine. The button is 
grayed out if there is no remote device or drive selected. 

Initiating a Get project process transfers the complete project which 
includes the application, user administration, and driver configuration 
settings. Driver dlls are not transferred, only the configuration settings.

During a Get project process, the remote device is not placed in a lock 
down condition. Remote users can still edit or run the project.

If a project with the same name already exists on the local machine, you 
are prompted to overwrite the existing project. You can continue with the 
transfer, cancel the transfer, or rename the project. Renaming the project 
continues with the transfer.

If a local project is opened and you try to get a project that has the same 
name, the local project is closed as the transfer takes place. You must then 
reopen the local project. 
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Get Project Validation 

Before getting a project from the remote device or removable drive, the 
PFD Manager performs several validation steps to ensure that you have the 
correct permissions to get the project from the selected device. These 
validation steps ensure that the device is secure from unauthorized users 
attempting to retrieve projects from the remote unit. The following 
conditions must be correct:

• Remote Startup User setting is checked against the current user name 
and password.

• Available space on the local machine is checked.

• A check for the same project on the local machine is performed.

The PFD Manager checks to see if the selected remote device requires a 
user name and password. If the unit does not require a user name, the 
Manager does not prompt you to log in and continues validation with the 
next step.

If the remote device does require a user name, the Manager displays a 
user name and password login dialog. Once logged on, the Manager then 
checks for the available disk space on the local machine. If there is enough 
space, the Manager continues validation with the next step. If there is not 
enough space, the Manager prompts you with a notification of insufficient 
disk space.

Finally, PFD Manager checks to see if a project of the same name already 
exists on the local machine. If the project does exist, you are prompted 
with a warning message. You can rename the project, overwrite the 
project, or cancel out of the transfer.

Status Bar 

The status bar is located at the bottom of the Parker Factory Display 
software. This area is used to display any status messages.

During any project transfer process a progress bar at the bottom right of 
the Parker Factory Display interface displays the transfer progress. 

Project Recovery 

The Parker Factory Display has features that allow recovering projects from 
a system crash. If the workstation where the PFD is installed crashes while 
editing a local project, upon reopening the project you are prompted with a 
Resume/Revert dialog. 

Select Resume to cause the PFD to load the project where it was at before 
the crash.
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Select Revert to cause the PFD to load the project at the point where it 
was last saved.

Any local project that was not opened will not be affected by the local 
workstation crashing. The Resume/Revert dialog will only appear if the 
project that was being edited is a local project.

Project Versioning 

There are two factors that determine if a project is compatible with a 
specific PFD device. These factors are the device’s hardware configuration 
and system file version.

The hardware configuration of the PFD device is determined by the specific 
hardware components that make up the unit such as the display size, 
processor type, etc. Newer PFD hardware is backward compatible with 
older units.

The system file is composed of the operating system, COMM server, help 
files, and other files that are an integral part of the HMI software. When a 
product enhancement such as new tools or capabilities are added to the 
HMI software, a new system file is generated that incorporates these 
updates. A new system file will always be able to read and upgrade 
projects created with an older version of the system file. Once a project is 
upgraded it may not be able to be opened with older versions of the 
system file. 

A PFD device’s hardware configuration is designed to work with specific 
versions of system files. These system files are able to operate with a 
specific set of hardware components and configuration. The PFD ensures 
that only projects that are able to operate with a specific set of system files 
and hardware can be sent to remote devices. 

The PFD software also has a specific version number. Installing a newer 
version of the PFD does not overwrite or delete any projects. With the 
latest version of the PFD software, you are able to communicate and 
deploy to all PFD devices that have any version of the system file. 
Therefore, the PFD is able to open and develop projects for any previous 
version of the system file. 

The latest version of the PFD can be downloaded from the Web site listed 
below by selecting the Dedicated HMI link.

www.parkermotion.com

The PFD includes a feature in which you can assign a revision number to 
the project. This revision number is a useful tool in tracking project 
changes. Right click a project in the local pane and select Modify Version to 
keep track of changes if desired.
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The Parker Factory Display has three main environments: 

• Shell

• Designer 

• Runtime 

The Shell environment (or Shell tab) is where you setup your project, 
manage users, and change properties and settings as needed. You can 
access the Shell environment through the PFD Manager or directly on the 
PFD device. This section covers all of the options available from the Shell 
environment. 

For information on using the Designer, refer to Chapter 6, Using the Design 
Environment. For information on using the Runtime environment, refer to 
Chapter 14, Using the Runtime Environment.

The Shell environment displays information about the PFD device and 
allows you to monitor and configure many of the system's hardware and 
software settings. You can also launch the Design and Runtime 
environments directly from the Shell. Because the PFD is a web-based 
application, you have the option of editing and running your applications, 
as well as managing your device from anywhere with internet access. 

Shell Window

Each time you enter the PFD from a remote device, the Shell window is 
displayed as shown below. Notice that the Design button is active in this 
example. When you load an application for the first time, PFD is not 
connected to the controller and only the Design environment is available. 
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When you press the red Connect button, the following occurs:

1 PFD connects with the remote device, 

2 the status light changes from red to green, and 

3 the red Connect button is replaced with a green Disconnect button, 
indicating that Runtime is active. 

You can now enter the Run environment; notice however, that you cannot 
enter the Design environment while connected to the controller (the Design 
button turns grey). 

Before entering the Design or Runtime environments, you need to setup 
user accounts and configure project settings in the Shell environment. You 

Buttons to 
access project 
settings.
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can access and change these settings using the buttons on the left-hand 
side of the Shell page. 

Using the User Admin Menu

With the User Admin menu you can manage user accounts and security 
options such as how many failed login attempts to allow or whether or not 
a login is required. From this menu you can add, edit, and delete users as 
well as change individual user access levels (administration, shell access, 
etc.). 

Setting Security Options

With the Security Options screen, you can specify what level of security 
you need in your project. For example, you can determine how many failed 
login attempts to allow or whether or not a login is required for each user. 

To edit any of the displayed security options, click on the Edit... link in the 
upper-right hand corner of the Security Options table. The Security Options 
screen is displayed as shown below. 
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The following table describes the options that you can change. 

Click OK to accept the changes and return to the Security Options screen. 
Click Reset to reset the values to the default settings and return to the 
Security Options screen. Click Cancel to return to the Security Options 
screen without changing anything. 

Setting User Levels

With the User Levels screen, you can view and change user access levels. 
The user level names displayed on the screen are the default user levels in 

Property Description

Local Startup User Use these options to select the initial user level when entering the 
Parker Factory Display. 

You can force the user to login by selecting Login Required from the 
drop down box. Or you can select a specific user: administrator, 
engineer, supervisor, technician, operator, or guest.

Remote Startup 
User

Disable User After 
X Failed Login 
Attempts

Use this option to revoke login privileges after a specified number of 
failed attempts.

To use this option, check the box next to Disable User. Use the drop 
down box to enter a maximum number of failed login attempts (from 1 
to 10) before the user is locked out. 

User Inactivity 
Timeout

Use this option to specify an amount of time that the Parker Factory 
Display can be inactive before the user is automatically logged out. The 
timeout period is in minutes. 

Use Timeout for 
Local Users 

Use these options to select a timeout period for local and/or remote 
users.

Use Timeout for 
Remote Users 
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the PFD. On occasion, you may want to change the name of a user level, 
for example it may make more sense to change "Engineer" to "Developer" 
for your particular project. 

You can edit all of the user levels except for the Admin user. To do so, click 
on the Edit... link in the table next to the name of the user level you want 
to change. The User Levels dialog box is displayed as shown below. 

The following table describes the options that you can edit. 

Property Description

User Level There are six User Levels: 0,1, 2, 3, 4, and 5. However, you cannot edit level 0 
(Admin). 

User Level Name Enter a new name for the user level up to 32 characters. The User Level Name 
can begin with a number, letter, or an underscore and is not case sensitive. 

The default user names are: Admin, Engineer, Supervisor, Technician, Operator 
and Guest. 

Permissions

Shell Access If this box is checked, the selected user (for example, the Engineer) is allowed 
to enter the Shell environment. 

If Shell Access is not checked, User Administration and Edit Project are grayed 
out. 

User Administration If this box is checked, the selected user is able to access User Administration 
functions. 

Edit Project If this box is checked, the selected user is allowed to enter the Design 
environment. 
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Click OK to accept the changes and return to the User Levels screen. Click 
Reset to reset the values to the default settings and return to the User 
Levels screen. Click Cancel to return to the User Levels screen without 
saving. 

Setting Up User Accounts

With the Users screen you can setup and disable individual user accounts. 
The User screen displays all of the users currently added to your project. 
These users can logon to a local or remote PFD machine with a correct 
username and password. When a user is online, there is an icon that is 
displayed in the title box indicating online status. 

From the Users screen you can:

• Add or Edit Users

• Disable a User

• Delete a User

The PFD sets up a default user administrator. You cannot delete or disable 
this account. The only option you can edit on the Admin account is the 
default password. 

Add or Edit Users 
From the Users screen, you can: 

The Users dialog box is displayed as shown below, allowing you to add or 
edit a user account. 

Add users to your project Click on the Add User... link in the 
top, left corner of the Users screen. 

Edit any of the displayed users Click on the Edit... link in the table 
next to the user you want to change.
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The following table describes the options available from the Users screen. 

Property Description

Name Enter a name for the new user up to 32 characters. The user name can begin 
with a number, letter, or an underscore. The user name field can not be empty. 
If it is left blank, the last user name added is used. 

The default name is User1, with the number incrementing for each new user. 

User Level Select a user level from the drop down list: administrator, engineer, supervisor, 
technician, operator, or guest. 

Locale Select a project language for this user. The next time this user logs in and 
enters runtime, the project language will switch to match the selected 
language.

The default setting is English (United States).

Password Enter an initial password for the new user up to 32 characters, including 
spaces. You can opt to leave this field blank therefore not requiring a 
password. Passwords are case sensitive. 

The default setting is a blank field, thus requiring no password.

Confirm Password Re-enter the password exactly as entered in the Password field. Passwords are 
case sensitive. 

If the Password field and the Confirm Password field do not match, while 
exiting the Users screen a message is displayed stating that "The entered 
password and password confirmation do not match." 
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Click OK to accept the changes and return to the Users screen. Click Reset 
to reset the values to the default settings and return to the Users screen. 
Click Cancel to return to the Users screen without saving.

Disable a User
You can disable a user without deleting their profile from the PFD. From the 
Users screen, find the user you want to disable and select the Disable link. 
If the user is currently logged on and you select Disable, the following 
message is displayed:

Username will be logged off immediately. Are you sure you want to disable 
user Username? 

Click OK to disable this user and return to the Users screen. The Disable 
link changes to Enable and the disabled user information is grayed out in 
the Users screen. Click Cancel to return to the Users screen without 
disabling the user. 

If a user is in Runtime mode and is disabled, they are logged out 
immediately from the Runtime session and will not be able to log back in. If 
the user is in the Shell and is disabled, they are logged out on the next 
action (such as clicking on a link or submitting information), the PFD can 
not immediately boot the user off without any action. If the user is not 
online at all and is disabled, they will not be able to logon.

Change at Next 
Logon

Select this option if you want the new user to change the password at the next 
login. 

Startup Program When the user logs on, select where you want this user to go: the Shell 
environment or directly into Runtime mode. The default is Runtime. 

If the User Level is set to a level that does not allow Shell Access, the PFD Shell 
option is grayed out and Runtime is automatically selected. 

Allow Local Access If this option is checked, the user can access the PFD on a local machine. This 
is the default setting. 

If this option is unchecked and the user attempts to log on at the local 
machine, they are not allowed access to the PFD and the system stays on the 
Logon page. 

The user privileges are set according to the User Level specified. 

Allow Remote 
Access 

If the user needs to access a remote machine, select the runtime access 
allowed for this user: no access, view only access, or viewing and controlling 
access. 

The default option is None, no access to Runtime remotely. 

If View Only is selected, the user can log on and only view live data and 
navigate through panels. 

If View & Control mode is selected, the user can log on and use the Runtime 
mode as if they are on a local machine. 

Property Description
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To re-enable a user, click on the Enable link while logged on an account 
that has Admin privileges. The user information text is no longer grayed 
out on the Users screen. Go to top

Delete a User
You can delete a user permanently from the PFD. From the Users screen, 
find the user you want to delete and select the Delete link. A confirmation 
dialog is displayed, "Are you sure you want to permanently delete user, 
User1?". 

Click OK to delete this user and return to the User screen. The user 
information is then permanently removed from the Users screen. Click 
Cancel to return to the Users screen without deleting the user.

Note: If you delete a User from the PFD, all user information is 
permanently removed from the project. You will have to Add User if you 
need to add that user back into the project. 

You cannot delete the default Admin user account. 

Using the Settings Menu

With the Settings menu you can determine how the PFD starts up, as well 
as enable and disable online editing capabilities and use of an on-screen 
keyboard. You can also set or change the name and versioning of your 
project, change time and date settings, and setup network connections. 

For detailed information on each of the options available from the Settings 
menu, refer to the table below.

Button Description

General With the General menu option you can enable PFD to 
automatically connect to the controller at startup, as well as 
enable online editing and an on-screen keyboard. 

Project With the Project menu option you can view and set your 
project's name and version level.

Time and Date With the Time and Date menu option you can change local 
time and date settings. Only available on a remote project.

Network 
Settings 

With the Network Settings menu option you can view the 
status of each network setting including: Device Name, 
Network Connection, IP Address, Subnet Mask, Default 
Gateway, Primary DNS, Secondary DNS, Primary WINS, and 
Secondary WINS, and Proxy Server configuration options. 
Only available on a remote project.
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Setting General Options

With the General screen, you can enable the PFD to automatically connect 
to the device at startup, as well as enable online editing and an on-screen 
keyboard.

To enable or disable the General project settings, click on the Edit... link in 
the top right-hand corner of the screen. The following table describes the 
different properties. 

Click OK to accept the changes and return to the General screen. Click 
Reset to reset the values to the default settings and return to the General 
screen. Click Cancel to return to the General screen without saving. 

Using the Online Editing Feature

If you enabled the Online Edit option, you can enter the Design 
environment while connected to the PFD device. However, any changes 
made to the project are updated immediately, therefore be sure you want 
to do this!

All of the regular Design features are available while working in online edit 
mode, with the following exceptions: 

• Tags

The Tag editor is available, however you cannot add, delete, or modify 
a tag. You can however, add a local tag at the tool level. 

• Alarms

The Alarm editor is available, however you cannot add, delete, or 
modify the alarms. 

If an alarm is triggered during online editing, the alarm will beep both 
in the Shell and the Runtime test on the device. If you are accessing 

Property Description

Connect at 
Startup 

Enables the PFD to automatically connect to the device at 
startup. 

Online Edit Enables you to access the Design environment while 
connected to a remote PFD device. By default, this option is 
disabled. 

For more information on using this feature, refer to Using 
the Online Editing Feature.

Use Popup 
Keyboard in 
Designer 

Enables the on-screen keyboard to display whenever a value 
needs to be entered into the system. This helps to eliminate 
the need for a keyboard to be connected to the PFD machine. 

You can choose to use the popup keyboard in the Designer 
only, the Shell only, or both the Design and Shell 
environments. 

Use Popup 
Keyboard in 
Shell 
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the Designer remotely using the online editing feature, the alarm is 
only audible in the Runtime test. 

Alarm logging works the same as it would in true Runtime, however the 
start and stop log times list a test run time. 

Any changes you make are updated on the next alarm event. 

• Popup Tools and Runtime Settings

These options are not accessible. 

• Test Runtime Button

The Test Runtime button is disabled when using the Designer in online 
editing mode. 

Changing Project Settings

With the Project screen, you can set your project's name and revision level. 
This is useful for long term projects with multiple releases. 

To edit the project settings, click the Edit... link on the Project screen. The 
following table describes the options available from the Project screen. 

Click OK to accept the changes and return to the Project screen. Click 
Reset to reset the values to the default settings and return to the Project 
screen. Click Cancel to return to the Project screen without saving. 

Setting the Time and Date

With the Time and Date screen, you can change the local time and date 
settings in your project. The time and date is updated in real time on the 
remote PFD machine. 

Property Description

Name Enter a name for the new project up to 32 characters. The 
project name can begin with a number, letter, or an 
underscore. 

The default project name is App.

Version Enter a revision number for your project. The Version number 
is actually a combination of the predefined system version 
and a definable revision number. The first digit, which cannot 
be edited, is the system version. The second digit, which you 
can edit, is for project versioning.

The revision number can be anything between 0 and 9999. 
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The following table describes the options available from the Time and Date 
screen. 

Click OK to accept the changes and return to the Time and Date screen. 
Click Reset to reset the values to the default settings and return to the 
Time and Date screen. Click Cancel to return to the Time and Date screen 
without saving. 

Configuring Network Settings

With the Network Settings menu option you can view the status of each 
network setting including: Machine Name, Port Number, Network 
Connection, IP Address, Subnet Mask, Default Gateway, Primary DNS, 
Secondary DNS, Primary WINS, Secondary WINS, and Proxy Server 
configuration options..

Click on the Edit... link to change the network settings. The following table 
describes the options available from the Network Settings screen. 

Property Description

Set Time Zone Use the drop down list to select the time zone. 

Set Time Use the drop down lists to set the hour (1-12), minutes (0-
59), and whether or not it is am (A) or pm (P). 

Set Date Set the Month, Day, and Year by using the drop down lists. 
When February is selected, if the date is set to 30 or 31, it is 
automatically updated to 29. The years displayed are from 
2000-2100. 

Daylight 
Saving

Select this option to activate the daylight savings settings. 
Your time and date will update accordingly throughout the 
year. 

Property Description

Machine Name Enter a unique machine name to identify this machine on a network. The 
machine name can be a maximum of 15 characters, using a-z, A-Z, 0-9, or 
underscore. The machine name must start with letters and cannot end with '-' 
or '_'. 

Port Number The PFD server makes a connection with a browser on a remote machine 
through a specific port. You can set the port to a specific number. The port 
number must be 1024 or greater. The port number must be 4 numbers. 

The default port number is 1235. 

Network Connection

Disable Select the Disable radio button to prevent networking on the specified 
machine. All information should all be set to 0. 

Note: Disabling the network connection through a remote browser results in a 
loss of connection which can only be restored locally. 
 Parker Factory Display User Guide  5-12



Chapter 5: Using the Shell Environment Using the Settings Menu
Click OK to accept the changes and return to the Network Settings screen. 
Click Reset to reset the values to the default settings and return to the 
Network Settings screen. Click Cancel to return to the Network Settings 
screen without saving. 

Dynamic Select the Dynamic radio button to allow the local machine to automatically go 
out and request for an IP address from the server. This IP address then is used 
to identify this unit on a network. 

All of the information (IP address, subnet mask, etc.) is displayed but cannot 
be changed in the section below Network Connection. 

Static Select the Static radio button to assign a fixed IP address and other network 
settings to this machine. This IP address and the Subnet Mask will be used to 
identify this unit on a network. 

The information below Network Connection (4 IP address and 4 Subnet Mask 
text boxes) is available and no longer grayed out. Also 4 text boxes for each 
Default Gateway, Primary DNS, Secondary DNS, Primary WINS, and Secondary 
WINS are displayed. Every IP address and subnet mask must be filled in 
otherwise you will receive an error. The Default Gateway, Primary DNS, 
Secondary DNS, Primary WINS, and Secondary WINS do not need to be filled 
in, they are optional. 

For further information regarding the remaining settings on this page, refer to 
your IT department.

Subnet Mask Enter the subnet mask required to identify the host on the network. The subnet 
mask provides a means of hiding the network address portion of the IP 
address.

Default Gateway Enter the gateway IP address. The gateway node serves as the access point to 
a network. 

Primary and 
Secondary DNS

Enter the DNS server IP address. A DNS server translates between Internet 
and computer names and IP addresses. 

Primary and 
Secondary WINS 

Enter the WINS server IP address. A WINS server translates Windows 
computer names to IP addresses. 

Access the Internet 
user a Proxy Server

Select this box to enable the Proxy Server address and port settings. The Proxy 
Server forwards requests from the unit to other servers. The server retrieves 
data from remote web servers. 

Proxy Address Enter the IP address or the name of the proxy server. The name can be up to 
15 characters long. 

Proxy Port Enter the port number of the proxy server. The number can range from 80 to 
9999 with the default set to 80. 

Property Description
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Using the Import/Export Menu

With the Import/Export menu you can import the following:

• Images

With the Images menu option, you can import images into your PFD 
project. 

• Tags and Alarm Definitions

With the Tags and Alarm Definitions menu options, you can import and 
export tag and alarm definition files. 

• Input Lists and Message Tables

With the Input Lists and Message Tables menu options, you can import 
and export input lists and message tables. 

• Project and System Languages

With the Project and System menu options, you can import and export 
a file for use in translating your project and system text fields. 

Importing and Exporting Images

Using the Images screen, you can import images into your PFD project. 
Once an image is imported, you can insert it onto a panel and manipulate it 
just like any other object from the tool box. Refer to The Image Tool, for 
more information on using images in your panels. 

Note that you cannot drag and drop images from the desktop into the PFD. 
You must first import the image file before you can use it in your project. 

You can access the Image screen from the Shell environment or from any 
Images menu in the Panel editor, which is found in the Design 
environment. 

To import images into your project, follow the steps below. 

1 To access the Images screen:

From the... Follow these steps:

Shell 
environment 

a Click on the Import/Export button. The 
Import/Export menu is displayed.

b Click on the Images button. 

Panel editor Click on the Background > Image > Import 
Image... menu command from the Panel menu. 

Image tool 
menu

Click on the Image > Import Image... menu 
command from the Image menu. 
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The Images screen is displayed as shown below. 

Note that when accessing the Images screen from the Shell 
environment, "Back to Panel..." is changed to "Back to 
Import/Export...". Clicking either of these links will return you to 
where you started. 

2 Select the Browse button to search the machine or network for the 
image you want to import. You can import .JPG and .SWF files. 

3 Select OK. Uploading filename... is displayed on the screen. When 
the upload is complete, the image file is added to the Images table 
shown in the screen. 

4 Access the imported image file from any of the Image menus in the 
Panel editor. Imported images are listed in alphabetical order on the 
menu. 

Button, 
Indicator, or 
Range 
Indicator 
tool menus

a Click on the Appearance command from the 
tool menu. 

b Click on the lens state or limit range (Range 
indicator only) where you want to insert an 
image. 

c Select the Image > Import Image... 
menu command from the menu. 

Message 
editor

a Create or highlight a message in the 
message table. 

b Select the Image > Import Image... 
menu command from the Message editor 
menu. 

From the... Follow these steps:
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Importing and Exporting Tags and Alarm Definitions 

With the Tags and Alarm Definitions screen, you can import or export your 
tag and alarm definition files. To access the Tags or Alarm Definitions 
screen:

1 Click on the Import/Export button from the Shell environment. 
The Import/Export menu is displayed.

2 Click on the Tags or Alarm Definitions button. The appropriate 
screen is displayed. The Tag screen is shown below.

3 Select the Browse button to search the machine or network for the 
file you want to import or export. 

4 Select Import to import the file.

5 Select Export to export the file. The alarm definition file is named, 
"Projectname_Alarm.csv" and found in the ??? directory. 

6 To return to the Import/Export menu, you can either select the Back 
to Import/Export... link or the back arrow button on the top, left of 
the screen. 

Importing and Exporting Input Lists and Message Tables 

With the Input Lists and Message Tables screen, you can import or export 
your input list and message table files. To import or export your tables:

1 Click on the Import/Export button from the Shell environment. The 
Import/Export menu is displayed.

2 Click on the Input Lists or Message Tables button. 

3 Select the Browse button to search the machine or network for the 
file you want to import or export. 

a Select Import to import the file. 

When a file is imported, the input list file is added to the List 
Editor. If the imported list name matches a previously 
created/imported list, a warning to overwrite the list is 
displayed. List items are replaced in existing lists. If the file 
being imported is of the wrong format, an error message is 
displayed. 

b Select Export to export the file. A Save As screen is displayed. 
Enter a location for the exported file.

The exported file lists all of the items in the defined format. Only 
one list file at a time can be selected from the drop-down list 
box. The default file name for each exported list matches the list 
name.

To delete an input list or message table from your project, select the 
Remove link next to the list or table you want to delete. 
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To return to the Import/Export menu, you can either select the Back to 
Import/Export... link or the back arrow button on the top, left of the 
screen. 

Importing and Exporting Project and System Languages 

With the Project and System Languages screen, you can import or export 
your project and system files for translation. To import or export these files 
refer to Chapter 15 for complete details on Multiple Language support.

Using the Information Menu

With the Information menu you can view the system and project versions 
as well as system resources, such as memory usage and CPU type.

Viewing System Resources

With the System Resources screen, you can view processor, memory, and 
project information for your PFD machine. The processor type and speed 
are displayed as well as the size of your application files (such as the tag, 
alarm, and driver files, etc.). You can also view the available and total 
amount of memory for any storage device that the PFD detected. All 
memory information is displayed in KB. 

The following table describes the information displayed on the System 
Resources screen. 

Click on the Back to Information... link or the arrow in the top, left of the 
screen to return to the Information menu.

Resource Description

Processor Displays the CPU type and speed. 

Memory Displays the available onboard memory because it is 
integrated on the PFD hardware unit. 

If a storage card is used, memory information is also 
displayed if it is detected by the program. If there are 
more than one external storage devices, they will be 
listed as Storage Card 1, Storage Card 2, and so on. 

Project Displays each panel's memory size. It also displays 
the memory size of the alarm, tag, application, user 
admin, device configuration, and driver files if they 
are available in the application. Total information 
represents the total amount of memory that is used 
by all of the applications. 
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Viewing Versioning Information

With the Versions screen you can view the version information of the 
hardware platform, firmware file, the PFD project, and any driver that 
resides on the machine. The following table describes the information 
displayed on the Versions screen. If there are several drivers they are 
listed in alphabetical order. 

Click on the Back to Information... link or the arrow in the top, left of the 
screen to return to the Information menu. 

Using the Utilities Menu

With the Utilities menu you can print reports, view the logged on users and 
response times, as well as update the system.

Viewing the Alarm Log

With the Alarm Log screen, you can save the alarm log file to any 
accessible location or you can clear all logged items. 

You can save the alarm log as a .TXT file, to do so: 

1 Click on the Export button. The File Download dialog box is 
displayed. 

2 Click on Save. The Save As dialog box is displayed. 

3 Select the location where you want to save the alarm log. 

4 Click on Save to save the file. 

The alarm_log.txt uses the tab delimited format similar to other exported 
files, such as alarm definitions and tags. This allows you to also view the 
log file in a spreadsheet such as Microsoft Excel. 

Resource Description

Platform Displays the version number of the hardware 
platform. The sequence of numbers indicates 
processor type and other hardware related 
components. 

Firmware 
File

Displays the current version of the firmware file. The 
first release of the PFD software has a firmware file 
version of 1.8. 

Project Displays the current version information for all files 
specific to the application, such as HMI, shell settings 
and image files. This is user selectable during project 
development. 

Driver 
Versions

Displays the current driver versions used on the PFD 
machine. 
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Alarm Log File Format 
<column_headers> = first line 

<log_start_time> = second line 

<description>, <status>, <time>, <date>, <priority>, <alarm_value>, 
<group>, <user> = content lines 

<log_end_time> = last line 

Description = Enclosed in quotes. Text string description of the alarm. 

Status = active/inactive/acknowledged/enabled/disabled (string - quotes) 

Time = logged time of the alarm (string - quotes) 

Date = logged date of the alarm (string - quotes) 

Priority = priority of alarms as in the alarm definitions (urgent, critical, 
notice, warning, alert) (string - quotes) 

Alarm Value = numeric value of the alarm, text value of the alarm (string 
for discrete items - quotes) 

Group = name of the group this alarm belongs to (string - quotes) 

User = user name of logged on user (string - quotes) 

Clearing the Alarm Log
Use the Clear Log button to delete all of the items logged in the .TXT file. 
The Clear Log button is the same as using the _Alarm_ClearLog system 
tag. You are asked if you want to permanently delete all logged items. 
Selecting OK clears the log file. Selecting Cancel exits the dialog and 
returns to the Alarm Log screen. 

Select the Back to Utilities... link or select the back arrow on the top, left of 
the screen to return to the Utilities menu. 

Viewing Currently Logged On Users

With the Logged On Users screen, you can view a list of people who are 
logged on and are connected to the server unit. It displays the following 
information for each active user: Name, User Level, IP Address, and Access 
privileges. 

For more information on setting up users, refer to Using the User Admin 
Menu on page 5-3. The following table describes the columns in the Logged 
on Users list. 

Field Description

Name Represents the user that is currently logged onto the 
system. 
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Viewing Response Times

With the Response Times screen, you can view the round trip response 
times from a PFD machine. 

The information displayed on the Response Times screen is based of 20 
ping samples. With 20 ping samples at 3 seconds each, this means the PFD 
determines current, minimum, and maximum response times during that 
one minute then starts the next cycle of 20 samples. 

The following table describes the rows in the Response Times list. 

Select the Back to Utilities... link or select the back arrow on the top, left of 
the screen to return to the Utilities menu. 

User Level Represents the user's level of security. The default 
levels are Admin, Engineer, Supervisor, Technician, 
Operator, and Guest. 

IP Address Represents the IP address of the remote unit that is 
online and logged on to the server. The server is 
labeled LOCAL rather than listing an IP Address. 

Access This field displays either View Only or View & Control. 

View Only means that this user can only view and 
navigate through the Runtime environment. Runtime 
input is not allowed. However, in order for this user to 
navigate, button tools such as goto panel, log off, exit, 
and back are accessible in this mode. These tools, 
however, are controlled by the user level. 

View & Control means that this user can view, input 
value, and navigate through panels in Runtime. Tools 
that this user can access are based on the set up in 
the Designer which is tied to the User Level. 

For more information on setting access privileges, 
refer to Setting Up User Accounts on page 5-6.

Field Description

Average Represents the average of the response time samples 
collected in one minute.

Last Represents the last valid response time. 

Fastest Represents the fastest response time encountered 
during the one minute sample. 

Slowest Represents the slowest response time encountered 
during the one minute sample. 

Field Description
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Accessing Response Times in the Designer 
You can access this same information in the Design environment when you 
put the cursor on top of the status light as shown below:

When the status light is green, your latest ping was between 0 to 80 ms. 
When the light is yellow, your latest ping was between 81 and 250 ms. 
When the light is red, your latest ping was over 251 ms. 

Understanding Round Trip Response Times
The following chart shows how a round trip response time is calculated in 
the PFD. 

The server unit opens up the HMIPersit system tag to listen for a ping from 
the client. About every 3 seconds, the client sends out a ping message and 
waits to get the response, or echo, back from the server. The difference 
between the time the client pings the server and the time it receives the 
returned response represents the round trip Response Time value. When 
the client gets the returned response, it starts the next ping. This process 
starts as soon as the Shell environment is loaded. 
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Creating Reports

With the Reports screen, you can create a report and then view it. If you 
are accessing a PFD device remotely or from a desktop workstation, you 
can also print the report. The following table describes the type of 
information available. 

Select Create Report and View to create the selected report(s). Once the 
report is created, the Shell loads this report page. The Report page is an 
HTML page; therefore, you must click the Print button in the dialog box in 
order to actually print the report you created. (Remember, you can only 
print if you are on a workstation or accessing the device remotely.) 

To return to the Settings menu, select the Back to Utilities... link or select 
the back arrow on the top, left of the screen. 

Report Type Description

General 
Settings

Includes a list of the General settings that you have 
enabled or disabled in your project. 

Project 
Settings

Includes project information, such as project name, 
version, and last modified date as well as: 

•Security options 

•User Level settings 

•Users

Machine 
Settings

Includes information about all of the machine settings 
in your project. 

Panels Includes information about the panels used in your 
project. You can choose to view all panels or select an 
individual panel. 

Panel 
Graphics

If this option is checked, a picture of the panel in 
Runtime is displayed after each individual panel 
report. 

Tags Includes information about all of the tags used in your 
project. 

Alarms Includes information about all of the alarm used in 
your project. 

Message 
Tables

Includes information about all of the message tables 
in your project. You can choose to view all message 
tables or select an individual message table. 

Input Lists Includes information about all of the input lists in your 
project. You can choose to view all input lists or select 
an individual input list. 
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The Parker Factory Display has three main environments: 

• Shell

• Designer 

• Runtime

The Designer lets you create operator interface applications. This is where 
you build all of your panels for your application using tools, graphics, 
alarms, tags and other objects that perform specific tasks during Runtime. 
These tasks can include monitoring or controlling a machine or process. 
With the Designer, you can:

• Build Panels 

Create a representation of a machine or process by using tools, 
graphics, alarms, and other objects. Refer to Using the Panel Editor for 
more information. 

• Add Tags

Use tags with panel objects to control devices. Tags are objects with 
descriptive names configured to address data items residing locally or 
within a connected control device. Output tools are used to display tag 
values, and input tools are used to write new values to tags. 

Refer to Using the Tag Editor for more information. 

• Test Your Project

Simulate or run a project created in the Designer using the Runtime 
environment. While in Runtime, you can navigate panels, monitor real 
time machine or process operation, view detected alarm conditions, or 
review alarm history. 

Refer to Using the Runtime Environment for more information. 

The bulk of your development is spent in the design environment. For 
information on using the Shell environment, refer to Chapter 5, Using the 
Shell Environment. For information on using the Runtime environment, 
refer to Chapter 14, Using the Runtime Environment. 
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Design Environment 

To enter the Design environment, click on the Design button from the PFD 
Shell. Once in the Design environment, you should see a display similar to 
the one below. 

The Design environment contains the following components:

• Toolbar Icons

• Editor Tabs

• Workspace

• Menu

• Control Icons

• Connection Status

• Properties

Design
Tab

Menu

Control Icons

Workspace

Editor
Tabs

TooToolbar Icons
Help Button Connection Status

Icon
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Toolbar Icons

The Toolbar icons are located at the top of the Design window and are 
there to help you perform common tasks, such as copying and pasting 
objects, quickly and easily. The Toolbar icons are described below.

Editor Tabs

You access the different editors through the Design environment. The tabs 
at the top of the Design window (below the Toolbar icons) change the 

Icon Hot Key Description

f Expands the workspace area to occupy the entire display. Only the 
menu and workspace objects are accessible in this view. 

f Returns the workspace to the normal view. You can also use the 
"F" key as a toggle to go between a full screen display and a 
normal screen display. 

z 

SPACE BAR 
(for panning) 

Available only in the Panel Editor, zoom is used to enlarge the 
panel area surrounding the point where it is clicked by 4:1. While 
zoomed, press and hold the SPACE BAR, then click and drag the 
mouse to pan the zoomed panel. Click Zoom again, or press the Z 
hot key, to toggle back to normal 1:1 view. 

g

SHIFT

Displays a grid on the panel while in the Panel Editor, and forces 
objects to snap to the grid while moving or sizing. Use the G key 
to turn the grid on and off. Press and hold the SHIFT key to 
temporarily enable the grid, allowing for quick and easy object 
aligning. Use the G key to turn the grid on and off. 

CTRL + C Copies selected objects to the clipboard. Use paste to create a 
copy of the clipboard content in the current view's workspace 
area. Available only in the Panel and Project editors.

CTRL + V Copies the content of the clipboard to the workspace area. Can be 
used successively to create multiple copies of the item in the 
clipboard. Available only in the Panel and Project editors.

CTRL + Z Use this button to reverse or undo the last action performed on an 
object in the Panel editor. 

CTRL + Y Use this button to reverse the Undo command and return the 
object to the state it was in before pressing Undo. This is only 
available in the Panel editor. 

? Displays the PFD context-sensitive help information.
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workspace and menu depending on the editor you selected. The PFD 
editors are described in the table below. 

Refer to the specific editor chapters for more information.

Workspace

The Design workspace changes depending on what editor you are currently 
using. In the Project editor, the Design workspace contains all of the 
panels, lists, and tables in your project. In the Panel editor, the panel you 
are currently working on is displayed in the workspace. If you are using the 
Continuous Improvement (Alarm) editor, a list of alarms and their 
corresponding tags are displayed. The Design workspace is dynamic, 
adapting to your development needs. 

Below is an example of the Panel editor loaded into the Design workspace.

Editor Description

Project Editor Use the Project editor to access all of the elements within your 
project, such as panels, alarms, lists, and messages. You can 
add and delete these elements, setup runtime options, select 
the language, and configure pop-up tools such as a keypad or 
selection list to include on your panels. 

Panel Editor Use the Panel editor to design individual panels within your 
project. Using the Panel editor, you can add tools such as push 
buttons, gauges, meters, sliders, etc. and graphic objects such 
as rectangles, circles, or polygons to the panels in your project. 
You can also group these objects, rotate them, add text or 
images and even animate your objects. 

Tag Editor Use the Tag editor to configure tags for your project. A tag is a 
variable that is used in place of a controller-specific address or 
relational expression. Tags reference values from a control 
device or an expression of multiple values.

Continuous 
Improvement 
(Alarm) 
Editor

Use the Continuous Improvement (Alarm) editor to configure 
alarms for your project. You can control the different levels of 
alarms and how they are presented to the operator, from a 
notice to a critical error. You can set an alarm to blink and set 
off an audible alarm. 

List Editor Use the List editor to setup a list of variables used within your 
project. You can set input items that use an analog, discrete, or 
string value. 

Message 
Editor

Use the Message editor to setup messages displayed to the 
operator during runtime.
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Menu

Just as the Design workspace changes, the menu options on the left-hand 
side of the Design window also change depending on what editor you are 
using. Below is an example of the menu options available when you are 
using the Project editor, the Panel editor, and the Continuous Improvement 
(Alarm) editor. 
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The menu items above the line are generally property settings for the 
editor, tool, or object you currently have selected. The menu items below 
the line are menu commands, such as edit and delete that affect the editor, 
tool, or object you are currently using. 

Most submenus have a green OK and a red X icon in the top, right-hand 
corner of the menu as shown below. Clicking the green OK icon executes 
(or commits) the command. You can also click off of the submenu to 
execute the command. To cancel the command, click on the X icon.

For details on the common menu commands, refer to Using Common Menu 
Commands. Many of the menu commands can be accessed using keyboard 
shortcuts or hotkeys, for details see Using Keyboard Shortcuts. Lastly, see 
the appropriate editor for details on individual editor menus. 

Project Editor Menu Panel Editor Menu Alarm Editor Menu 
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Control Icons 

The icons on the bottom, left-hand side of the Design window are used to 
switch between the different PFD environments, and are described below. 

Connection Status 

The round icon on the top, right-hand corner of the Design window 
represents the status of the network connection. The LED icon changes 
color to reflect the range of response times in milliseconds, updated every 
3 seconds. 

Icon Description

Goto Shell Clicking this icon closes the Design environment and 
displays the Shell environment. For more information, 
see Using the Shell.

You can also press the Home key to go to the Shell 
environment. 

Test Runtime Clicking this icon tests your project in Runtime. For 
more information, see Running Your Project. Note that 
this is not available when using the Online Editing 
feature.

You can also press the F2 key to go test your project 
in Runtime. 

Nudge This icon is only available when an object is 
highlighted in the Panel editor. Clicking this icon 
moves the object using smaller increments. You can 
also use the keyboard arrow keys to nudge an object 
one pixel at a time for precise positioning. 

Complete the following steps to nudge an object: 

1 Select the object that you want to nudge. 

2 Press the arrow keys on the keyboard (Up, 
Down, Left, or Right) to nudge the object one 
pixel at a time. 

3 Use the SHIFT key plus the nudge icon to 
snap the selected object to the grid. 
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When the cursor hovers over the Connection Status icon, a message box 
appears displaying the most recent (last) response time, as well as the 
average, fastest and slowest response times over the past 60 second 
period. 

Properties

Use the Properties icon, to display a scrollable list of settings for the 
selected object, tool, or editor in a pop-up window, as shown below. 
Highlight an object you want view property information for and then click 
on the Properties icon. To show the properties of a particular editor, be 
sure nothing is selected in the editor workspace before selecting the 
Properties icon.

Icon Values Description

Indicates the status of the network connection 
to the server. 

0 – 80ms Green indicates an excellent network 
connection, where the average message 
response time is less (faster) than 81ms. 

81 – 250ms Yellow indicates a good network connection, 
where the average message response time 
ranges from 81ms to 250ms. 

> 250ms Red indicates a slow network connection, 
where the average message response time is 
longer (slower) than 250ms. 
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The values shown are for display only. This is very useful for displaying the 
properties of objects on a locked panel. A locked panel can still be viewed, 
but not edited. To lock a panel, refer to Using the Project Editor. 

You must use the appropriate menu to change object property values. To 
exit out of the pop-up window, click on the red X icon. 

Using the Panel Editor

Use the panel editor to develop all of your panels for your project. The 
workspace of the Panel editor is a blank slate for you to build as complex or 
as simple panels as you need for your project. The Panel editor is shown 
below. 

Using the Panel editor, you can add tools such as push buttons, gauges, 
meters, sliders, etc. and graphic objects such as rectangles, circles, or 
polygons to the panels in your project. You can also group these objects, 
rotate them, add text or images and even animate your objects. 

ToolBoxControl Icons

Graphic ObjectsPanel Tools
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For more information on using the tools available in the Panel editor, refer 
to the following topics:

• Panel Menu

• Tool Box

• Common Menu Commands 

Panel Menu 

Using the Panel menu, you can move between panels in your project, 
retrieve objects and modify panel background properties. 

Without any objects or tools selected in the Panel editor, the menu options 
below are available from the Panel editor. If you have a tool or graphic 
object selected, such as the Ellipse in the example above, the menu 
displayed is for the highlighted object. For more information on using these 
menus, refer to the specific tool or graphic object you are working with. 

Menu Item Description

Background From this menu, you can change the background color 
of your panel, add a gradient to the panel, or insert 
and modify a background image. 

For more information, refer to the following sections:

• Using the Color Picker

• Selecting a Gradient

• Inserting a Background Image

In order to insert an image onto your panel, you must 
first import the image using the Import/Export menu. 
See Importing and Exporting Images for more 
information. 

Previous 
Panel 

Next Panel 

These commands allow you to move between panels 
in your project.

Retrieve 
Objects 

The Retrieve Objects command is only available when 
objects have been moved completely off the panel 
during a design session. Clicking on this command 
brings any object outside of the panel window back 
into view. All recovered objects are selected. 
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Using the Color Picker

To change the color of a Panel, an object, or another tool, you have plenty 
of options to choose from. When you initially select the Color 1 menu 
command, you can choose one of 32 different colors as shown below:

If these colors don't suit your needs, you can expand the Color Picker 
screen by selecting the expand button on the upper-left of the Color Picker. 
The expanded Color Picker screen is displayed below. 

The following table describes the options available from the expanded 
Color Picker screen. 

Property Description

Current 
Color 

The color setting of the selected object is shown as 
the Current Color. The color is shown with its hex 
value and opacity percentage. You can select this color 
by clicking on it, making it easy to add to the Custom 
Palette. In doing so, you can save the color to apply 
later to another object. 
 Parker Factory Display User Guide  6-11



Chapter 6: Using the Design Environment Panel Menu
Color values are represented using #RRGGBB format. The # sign indicates 
hexadecimal notation, RR is the amount of red, GG is the amount of green, 
and BB is the amount of blue color. The values range from 00 to FF hex, 
where 00 is no color and FF is the maximum amount of color. Examples: 
#000000 is black; #FFFFFF is white; #008000 is medium green; #FFFF00 
is bright yellow. 

Selecting a Gradient

You can choose to use a gradient pattern on your panels or objects. To do 
so:

1 Select Color 1 from the Panel or object menu. Choose your initial 
color. See Using the Color Picker for more information. 

2 Select Color 2 from the Panel or object menu. Choose your 
secondary color. 

New Color The New Color field shows the color, hex value, and 
opacity percentage of the new color selection, which is 
applied to the object when the Color Picker is closed. 
Color and opacity may be set by typing values into the 
fields if desired. 

Custom 
Palette

The Custom Palette allows you to save up to 16 
custom colors. You can add colors to the palette by 
clicking on the + sign. Existing colors are shifted left, 
allowing up to 16 custom colors to be saved for later 
use. 

Note that you can not delete colors from the custom 
palette. To remove a color selection, you must 
continually add custom colors to the palette until the 
one you want to delete is replaced by a new color. 

Color 
Rainbow 

The Color Rainbow shows all possible color selections. 
The value under the cursor is shown in the lower right 
corner. Clicking on the color will set it as the New 
Color selection. 

Standard 
Palette 

The Standard Palette provides 16 standard VGA colors 
and 16 shades of gray. 

Opacity Bar The Opacity Bar sets the selected color as a 
percentage. Far right is 100% opaque, and far left is 
0% making the color transparent. Click anywhere on 
the bar to make a selection. 

Property Description
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3 Select Gradient from the Panel or object menu. The Gradient screen 
is displayed as shown below:

4 Choose one of the 20 gradient patterns available. Note that grey 
represents Color 1 in the displayed gradient patterns and black 
represents Color 2. The first option is a solid Color 1, there is no 
gradient or Color 2 used in this pattern. 

5 Select Swap Colors from the panel or object menu to swap Color 1 
and Color 2, if desired. 

Inserting a Background Image

Rather than having a solid color panel, you can opt to use a background 
image on your panels. To use an image in your project, you must first 
import it into your PFD project. You can do this from the Panel editor as 
shown below or from the Shell environment, refer to Importing and 
Exporting Images for more information. 

To insert an image onto a panel as a background:

1 Select Background > Image > Import Image... from the Panel 
editor menu.

The Images screen is displayed as shown below. 
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2 Select Browse... to find the image you want to include on your panel. 
You can import images in either JPG or SWF format. 

3 Select Import to import that image and return to the panel. 

4 Select Back to Panel... to return to the panel without saving. 

To force the image fit within the panel workspace, be sure to check 
the Stretch Image option on the Background menu. 

Deleting a Background Image 

To remove a background image from the panel, select the 
Background > Image > <None> menu option from the Panel 
editor. The picture is removed from the panel workspace, but the 
image itself remains available to the project, therefore you do not 
have to re-import the image. 

To delete an image from the project, select the Background > 
Image > Import Image menu option to access the Images screen. 
See Importing and Exporting Images for details on using this screen. 

Tool Box

The tool box is located on the bottom of the Design workspace and stores 
preconfigured tools and graphics that can be used in any panel. You can 
click and drag any object out of the tool box and place it on your panel. The 
tool box is shown below.
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For information on using the rectangle, ellipse, arc, line, polygon, or text 
objects, refer to Working With Graphic Objects. For more information on 
each tool (push button, gauge, etc.), refer to Working With Tools.

Common Menu Commands 

As you place objects on your panel, the menu on the left side changes 
accordingly. For example, if you place a button on the Panel editor, you will 
see the "Button" menu on the left side of the panel. These menus allow you 
to delete, group, align to panel, order and orient objects. They also allow 
you to change object properties, including color, font, size, etc. 

The following table describes the common menu commands. For more 
information about object properties, refer to Changing Object Properties.

Menu 
Command Description

Swap Colors Switches Color 1 with Color 2 and Color 2 with Color 1. 
This is only available with the rectangle, ellipse, arc, 
and polygon tools. 

Delete Deletes the object. 

Group Groups multiple objects together. Be sure to set the 
individual object properties (such as desired color) 
before grouping objects together. 

Align to 
Panel

Aligns the object with respect to the panel. Left, right, 
top and bottom commands align the object's edge 
with the panel's edge. Center and middle align their 
geometric center points. 
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Most submenus have a green OK and a red X icon in the top, right-hand 
corner of the menu as shown below. Clicking the green OK icon executes 
(or commits) the command. You can also click off of the submenu to 
execute the command. To cancel the command, click on the X icon.

Order Changes the "Z-order" of the object in relation to 
other objects on the panel. This creates a layering 
affect between the objects. 

• Forward One

Move the object one layer in front of where it 
currently sits in the stack of objects. 

• Backward One

Move the object one layer behind where it 
currently sits in the stack of objects. 

• Send to the Front

Place the object on top of all other objects. 

• Send to the Back

Move the object behind all of the other 
objects. 

By default, a newly created object is placed at the 
front of the panel, covering other objects where areas 
overlap. 

Orient Flips the line, arc, or polygon object horizontally or 
vertically. 

Select Flip Horizontal to reverse the object along its 
Y-axis.

Select Flip Vertical to reverse the object along its X-
axis.

Menu 
Command Description
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This chapter is a tutorial that assists you in becoming familiar with 
developing Parker Factory Display (PFD) panels with a small number of 
tools.

The tutorial takes about two hours to complete. It exposes you to most of 
the tool objects and a majority of their properties. It is recommended that 
you perform these steps to boost your knowledge of the PFD. 

Do not skip steps as each section of the tutorial builds upon previous 
sections. The project your developing will work successfully only if the 
steps are followed as described and in the order in which they are 
presented.

This tutorial assumes you are using the PFD interface to create this project. 
You can use a browser to connect to a remote PFD unit and perform the 
tutorial as well. To start the designer from your browser, enter the URL of 
the PFD device in your browser’s address bar. The PFD is displayed. Other 
than launching the PFD within your browser, all other steps described 
below can be accomplished either through the Manager or your browser. 

You should also perform the tutorial within the PFD Quick Start Guide. The 
tutorial in that manual is more specific to the types of applications more 
likely developed for use with the PFD.

You will accomplish the following objectives within this tutorial:

• Create a new project and panel

• Configure buttons and indicators

• Configure meters and numeric entry tools

• Create a second panel for your project

• Configure gauges and bar graphs

• Configure message tools and input lists

• Perform various tool manipulations

PFD panels are saved automatically, therefore as you progress through the 
tutorial, you will not have to perform any save operation as this is 
accomplished for you. This is another of the many great features of the 
PFD.

Creating a New Project

The first step in developing a PFD application is to create a new project.

1 Launch the PFD from your workstation by selecting the PFD icon 
from your desktop.
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The PFD launches and displays the welcome screen in the 
workspace.

2 Select the New   icon from the local pane.

The New Project dialog appears.

3 Enter a name for your project such as Tools Tutorial.

The project is created and displays an icon within the local pane. The 
project launches within the workspace and Shell appears as shown 
below.

Creating a New Panel

A project consists of many items, such as driver configurations, panels, 
message files, etc. The next step in developing your project is to create 
panels.

1 With the Tools Tutorial project loaded in the workspace, maximize 
the window or browser so that you can see the entire workspace.

2 Select the Design  button.

The PFD Designer launches within the workspace.

3 Within the PFD Designer, select the New command from the menu.
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The New fly-out appears.

4 Select Panel and enter a name for the panel in the Panel text box as 
shown below. A panel can also be created from a template. Refer to 
the online help system of information on templates. Name the panel 
Tools1.

5 Press Enter to save the panel and open the Panel Editor. You can 
also select the check mark in the upper right of the fly-out.

A blank panel appears. You are now ready to begin configuring your 
panel.

Adding Tools to a Panel

Panels can consist of tool and graphic objects. Follow these steps to add 
the following tools to your panel.

• Maintained button

• Indicator

• Exit button

When adding tools to your panel, you may wish to resize the tool in order 
to leave adequate space on your panel for further panel development.
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The final panel, Tools1, should appear similar to the figure below.

Adding the tool:
1 With the Tools1 panel open, select and drag the button from the 

toolbin onto the panel.

A button is created on the panel. Resize the button. The toolbin is 
shown below.

2 Place the button in the upper left corner of the panel by selecting the 
button and dragging it into place.

Moving the tool:
3 When an object is selected, selection handles appear on the object. 

An object can be moved anytime it’s selection handles appear.

Sizing the tool:
4 To resize an object, simply select the object, move the cursor over 

one of the selection handles, the cursor will change into an arrow, 
then move the selected handle and resize the object as desired.
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Configuring the Maintained button:
With an object selected on the panel, the menu reflects all the properties 
and commands associated with the selected object.

1 Select each property from the menu and configure the settings as 
listed in the table below.

There are properties with each tool that are not listed in the table below. 
Leave those properties at their defaults, only change those properties 
listed below. You may explore the other properties if you wish.

Under the Property heading in the table, select the first property, such as 
Appearance, this will either display a fly-out menu or a secondary menu 
with further selections. From the fly-out or secondary menu you select the 
second property such as Off Lens.  

A typical secondary menu is shown below. All secondary menus have an 
arrow in the upper left corner that, when selected, will take you back to the 
upper level menu. Therefore, selecting the left arrow in the Off Lens menu 
shown below returns you to the main menu.

Button Properties Setting

Type Maintained

Values - Switch Input
Values - Lens Output

Motor1_Start
Motor1_Start

Appearance - Off Lens - 
Edit Text

Appearance - Off Lens - 
Font Size
Appearance - On Lens - 
Edit Text
Appearance - On Lens - 
Font Size

Motor Stopped

10

Motor Running

10
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2 With the button selected, resize the button so that the text fits 
within the bezel.

Adding and Configuring an Indicator:
1 With the Tools1 panel open (the panel name is in the upper left 

corner), select and drag the indicator from the toolbin onto the 
panel.

An indicator is created on the panel.

2 Place the indicator in the upper left corner of the panel to the right of 
the button.Refer to the figure on page 7-4.

3 Select each property from the menu and configure the settings as 
listed in the table below.

Adding and Configuring another button:
1 With the Tools1 panel open, select and drag another button from the 

toolbin onto the panel.

A button is created on the panel.

2 Place the button in the upper right corner of the panel to the right of 
the indicator as shown in the figure on page 7-4. Adjust the size of 
the button as necessary.

3 Select each property from the menu and configure the settings as 
listed in the table below.

Indicator Properties Setting

Values - Lens Output1 Motor1_Start

Appearance - Lens State 
0 - Edit Text
Appearance - Lens State 
0 - Font Size
Appearance - Lens State 
1 - Edit Text
Appearance - Lens State 
0 - Font Size

Stopped

10

Running

10

Exit Button Properties Setting

Type Exit
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Testing the Panel in Run Mode

Once the panel has been developed you can test it in runtime. You can 
quickly enter test run mode to test the functionality of your application.

1 Select the Test Runtime  icon in the Designer. 

You enter test runtime.

2 Select the Motor Stopped button and notice that the indicator tool 
reflects the Motor1_Start bit’s change of state.

3 Select the Exit button and you return to the Designer.

Adding more Panel Tools

You will now add the following tools to your project on the current panel - 
Tools1. Explore each tools properties as you add the tool to the panel. Only 
change the properties listed in the table for each tool to ensure the tutorial 
works as planned.

• Increment Button

• Decrement Button

• Meter

• Range Indicator

Adding and Configuring an Increment button:
1 With the Tools1 panel open, select and drag a button from the 

toolbin onto the panel.

A button is created on the panel.

2 Place the button in the middle left edge of the panel, below the 
button/indicator combination. Resize the button if necessary.

Appearance - Off Lens - 
Edit Text

Appearance - Off Lens - 
Font Size
Appearance - Off Lens - 
Apply To All

Exit

10

Select this

Exit Button Properties Setting
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3 Select each property from the menu and configure the settings as 
listed in the table below.

Now you will create a Decrement button by copying the Increment button 
and changing properties so that it functions as a Decrement button.

Copying the Increment button and Re-configuring it as a Decrement button:
1 With the Tools1 panel open, select the Increment button on the 

panel.

2 Select the Copy  then the Paste  icon. 

An exact copy of the Increment button is displayed. When making a 
copy of a tool, the copy will have the same shape and property 
settings as the original tool.

3 Move the copy to the right of the Increment button.

4 Select each property from the menu and configure the settings as 
listed in the table below.

Now you will create an analog read only tool. There are several types of 
tools that can read analog data from a controller and display it on a panel. 
You will now create a meter tool.

Increment Button 
Properties Setting

Type Increment

Values - Switch Input
Values - Base Value
Values - Increment By
Values - Maximum

Motor1_Speed
Motor1_Speed
10
150

Appearance - Off Lens - 
Edit Text
Appearance - Off Lens - 
Font Size
Appearance - Off Lens - 
Apply To All

Increase Speed

10

Select this

Decrement Button 
Properties Setting

Type Decrement

Values - Switch Input
Values - Base Value
Values - Decrement By
Values - Minimum

Motor1_Speed
Motor1_Speed
10
0

Appearance - Off Lens - 
Edit Text
Appearance - Off Lens - 
Apply To All

Decrease Speed

Select this
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Select the down arrow in the toolbin to access additional tools. The Meter 
tool is located in the second drawer of the toolbin.

Adding and Configuring a Meter and a Range Indicator:
1 With the Tools1 panel open, select and drag a meter from the toolbin 

onto the panel.

A meter is created on the panel.

2 Place the meter at the bottom left edge of the panel, below the 
increment/decrement button combination.

3 Select and drag a range indicator from the toolbin onto the panel.

A range indicator is created on the panel.

4 Place the range indicator below the meter you just added.

5 Select each property from the menu and configure the settings as 
listed in the table below. The Meter properties are listed in the first 
table.

6 Select the range indicator on the panel and configure it’s properties 
as shown in the table below. You may have to resize the tool in order 
for the text to fit.

Meter Properties Setting

Values - Tool Value 
Output
Values - Min Value
Values - Max Value

Motor1_Speed
0
150

Accessibility - Show 
Output Motor1_Start

Range Indicator 
Properties Setting

Values - Tool Value 
Output
Values - Limit 1 Output
Values - Limit 2 Output

Motor1_Speed
50
100
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Testing the Panel with added tools in Run Mode

1 Select the Test Runtime  icon in the designer. 

You enter test runtime. Notice that the meter is not visible on the 
panel.

2 Select the Motor Stopped button.

The meter tool appears. This is because the Show Output property 
for the meter tool is assigned to the Motor1_Start tag which is 
controlled by the Motor Stopped maintained button.

3 Select the increment and decrement buttons.

The meter value increases or decreases depending on the value in 
the Motor1_Speed tag. Also notice that the range indicator reflects 
the current range of value.

4 Select the Motor Running button.

The meter tool disappears.

5 Select the Exit button and you are returned to the Designer.

Adding and Configuring Numeric Entry and Numeric Display Tools:
1 With the Tools1 panel open, select and drag a numeric entry tool 

from the toolbin onto the panel.

A numeric entry tool is created on the panel.

2 Place the Numeric Entry tool to the right of the Meter tool.

3 Select and drag a Numeric Display tool from the toolbin onto the 
panel.

Appearance - < Limit 1 - 
Lens Color
Appearance - < Limit 1 - 
Edit Text
Appearance - < Limit 1 - 
Font Size
Appearance - Limit 1 to 
Limit 2 - Lens Color
Appearance - Limit 1 to 
Limit 2 - Edit Text
Appearance - Limit 1 to 
Limit 2 - Font Size
Appearance - > Limit 2 - 
Lens Color
Appearance - > Limit 2 - 
Edit Text
Appearance - > Limit 2 - 
Font Size

Light Blue

Low Limit

10

Yellow

Med Limit

10

Red

High Limit

10

Range Indicator 
Properties Setting
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A numeric display tool is created on the panel.

4 Place the numeric display tool below the numeric entry tool you just 
added.

5 Select each property from the menu and configure the settings as 
listed in the table below. The Numeric Entry tool properties are listed 
in the first table.

6 Select the numeric display tool on the panel and configure it’s 
properties as shown in the table below. You may have to resize the 
tool in order for the text to fit.

You will now edit the tag you just created, Belt_Speed_Scaled, and 
have it multiply the value in the Belt_Speed tag by 10. The numeric 
display tool will then display whatever value is entered in the 
numeric entry tool multiplied by 10.

7 Select the Tags tab at the top of the Parker Factory Display panel.

The Tag Editor displays.

8 Locate the Belt_Speed_Scaled tag in the grid. Highlight the tag and 
select Edit Tag.

The Edit Tag Dialog appears.

Numeric Entry 
Properties Setting

Values - Numeric Entry 
Input
Values - Display Value 
Output
Values - Min Input Value
Values - Max Input Value

Belt_Speed

Belt_Speed
0
100

Numeric Display 
Properties Setting

Values - Tool Value 
Output
Values - Limit 1 Output
Values - Limit 2 Output

Belt_Speed_Scaled
250
750
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9 In the Address field enter; Belt_Speed * 10 as shown in the figure 
below.

10 Select the check mark in the upper right corner of the Edit Tag 
Dialog to accept your edits and close the dialog.

You can now run the project and observe the results.

Testing the Panel with Numeric Entry and Display tools in Run Mode

1 Select the Test Runtime  icon in the Designer. 

You enter test runtime. 

2 Select the Numeric Entry tool.

3 Enter a value between 0 and 100 and then press Enter.

The Numeric Display tool shows the value you entered multiplied by 
10.

4 Select the Exit button and you are returned to the Designer.

Finishing your first Panel

There are only a few more tools to add to this first panel. You will add the 
following objects to the panel. Follow the steps to create these tools.

• Time display

• Date display

• Go To Panel button

• Back Panel button

You will create a Time display tool, then copy and paste the tool and 
reconfigure it as a Date display tool. You will then test this panel before 
moving on and creating a second panel for your project.
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Adding and Configuring Time/Date, GoTo, and Back Panel tools:
1 Select the Panel tab to display the Tools1 panel in the workspace.

2 Select and drag a Time/Date tool from the toolbin onto the panel.

A Time/Date tool is created on the panel.

3 Place the Time/Date tool in the upper right corner of the panel below 
the Exit button.

4 Copy and paste another Time/Date tool onto the panel.

5 Select and drag the copied tool to the opposite side of the panel.

6 Select each property from the menu and configure the settings as 
listed in the table below. Configure the first Time/Date tool as a Time 
tool (right side of the panel) and the second (copied) Time/Date tool 
as a Date tool (left side of the panel). The Time tool properties are 
listed in the first table.

7 Select the second (copied) Time/Date tool on the panel and 
configure it’s properties as shown in the table below.

You will now create panel buttons that can be used to navigate 
between panels in your project. You will create GoTo Panel and Back 
Panel buttons and configure their properties. 

8 Select and drag a button from the toolbin onto the panel.

A button is created on the panel.

9 Place the button to the left of the Exit button.

10 Select and drag another button from the toolbin onto the panel.

11 Place this second button to the left of the button you just added. 

12 Resize the buttons so they fit next to each other on the panel. Refer 
back to page 7-4 to see proper tool placement. 

You will configure the first button as a GoTo Panel button and the 
second button a Back button.

13 Select each property from the menu and configure the settings as 
listed in the table below.

Time Properties Setting

Type Time

Appearance - Hour 
Format
Appearance - Time 
Format

24 Hour

HH:MM:SS

Date Properties Setting

Type Date
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Creating a Go To Panel button allows you to enter a name for the 
panel in the New Panel text box. This creates a new panel for your 
project. If you select the Project tab, there will now be two panels 
for the project, Tools1 and the newly created Tools2 panel.

14 Select the second button on the panel and configure it’s properties 
as shown in the table below.

15 Move the tools around on the panel so that the panel presents an 
aesthetically pleasing display. You will now run the project and 
observe the results.

The final panel should look something like the figure on page 7-4.

Testing the Panel with Time/Date tools in Run Mode

1 Select the Test Runtime  icon in the Designer. 

You enter test runtime. The Time and Date displays show the current 
time and date as read from  your workstation.

2 Select the Back Panel button.

Nothing happens because the Back panel button will take you to the 
last panel visited, functioning like the Back button on your Internet 
browser. Since there were no panels previously visited, selecting the 
Back button will do nothing. 

GoTo Panel Button 
Properties Setting

Type Goto Panel

Values - Panel - New 
Panel Tools2

Appearance - Off Lens - 
Edit Text
Appearance - Off Lens - 
Font Size
Appearance - Off Lens - 
Apply To All

Go To Panel

10

Select it

Back Button Properties Setting

Type Back

Appearance - Off Lens - 
Edit Text
Appearance - Off Lens - 
Font Size
Appearance - Off Lens - 
Apply To All

Back Panel

10

Select it
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3 Select the Go To Panel button.

The panel, Tools2, displays as that was the panel you configured this 
button to access. This panel is blank as we have not placed any tools 
on it for now. You can not return to the previous panel as there are 
no navigational buttons on this panel. 

This situation demonstrates the reason that you should ensure you 
create either an exit button or other navigational buttons on each 
and every panel you create to ensure you can exit your application.

4 Since we are running in Test Runtime mode, simply select the Exit 
Runtime  icon on the panel to return to the Designer.

Adding Tools to the Second Panel in your Project

This section of the tutorial continues with configuration of additional tool 
objects. Up to this point you have been working with the first panel in the 
project, Tools1. This second panel allows you to continue exploring the 
many tools available with the Parker Factory Display. 

The following tools will be added to this panel:

• All previous project navigation buttons (Exit, Go To Panel, Back Panel)

• Slider

• Gauge

• Bar Graph

The final panel, Tools2, should appear similar to the figure below.
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Copying Tools between Panels

The Tools2 panel needs to consist of all the navigational elements that are 
contained on the first panel you created. You can copy and paste objects 
among panels to save time in tool configuration. You will copy the Exit, Go 
To Panel, and Back Panel buttons from the Tools1 panel and make a small 
change to the Go To Panel button.

1 With the Tools1 panel open select the Exit, Go To Panel, and Back 
Panel buttons. 

Holding down the Ctrl key allows multiple object selections. As each 
object is selected, handles appear on the tool.

2 Release the Ctrl key.

3 Select the Copy  button on the Designer.

4 Select the background of the panel.

5 Select the Next Panel command from the menu.

6 Select the Paste  button on the Designer.

Position the tools in the lower right corner of the panel. The Tools2 
panel now has three navigational buttons located on the display.

7 Select only the Go To Panel button to change the tools configuration. 
Select each property from the menu and configure the settings as 
listed in the table below.

Just as was accomplished before, this creates a new panel for your 
project. If you select the Project tab, there will now be three panels 
for the project, Tools1, Tools2, and the newly created Tools3 panel.

Testing the Tools2 Panel navigation buttons in Run Mode

1 Before going into Test Runtime mode, select the Previous Panel 
command from the Tools2 panel.

The Tools1 panel displays in the workspace. 

2 With the Tools1 panel in the workspace, select the Test Runtime 
 icon in the Designer. 

You enter test runtime. 

GoTo Panel Button 
Properties Setting

Type Goto Panel

Values - Panel - New 
Panel Tools3
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3 Select the Go To Panel button.

The Tools2 panel displays as that was the panel you configured this 
button to access.

4 Select the Back Panel button.

The Tools1 panel displays because it was the previously visited 
panel. 

5 Select the Go To Panel button, again, from the Tools1 panel.

The panel, Tool2, displays.

6 Select the Go To Panel button from the Tools2 panel.

The panel, Tools3, displays as that was the panel you configured this 
button to access. This panel is blank as you have not placed any 
tools on it for now. 

Since you are running in Test Runtime mode, simply select the Exit 
Runtime  icon on the panel to return to the Designer.

Adding and Configuring the Slider, Gauge, and Bar Graph tools on the Tools2 Panel

1 Open the Tools2 panel in the Designer by either selecting it from the 
Project workspace or selecting the Next Panel command from the 
Tools1 menu. 

2 With the Tools2 panel open, select and drag a Slider tool from the 
toolbin onto the panel.

A Slider tool is created on the panel.

3 Place the Slider tool in the upper left corner of the panel.

4 Select and drag a Gauge tool from the toolbin onto the panel.

A Gauge tool is created on the panel.

5 Place the Gauge tool to the right of the Slider tool.

6 Select and drag a Bar Graph tool from the toolbin onto the panel.

A Bar Graph tool is created on the panel.

7 Place the Bar Graph tool to the right of the Gauge tool.

8 Resize the tools to achieve an aesthetically pleasing panel. Refer to 
page 7-15 for your reference.

9 Select each property from the menu and configure the settings as 
listed in the table below. First configure the Slider, followed by the 
Gauge and Bar Graph tools. Refer to the appropriate table for 
configuration settings.
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Testing the Tools2 Analog Tools in Run Mode

1 With the Tools2 panel in the workspace, select the Test Runtime 
 icon in the designer. 

You enter test runtime. 

2 Select the Slider tool and move the knob up and down.

The Gauge and Bar Graph tool values reflect the data input through 
the Slider. 

3 Select the Exit button.

You are returned to the Designer.

Creating a New Panel with Message Tools

The PFD is able to display ASCII messages using its Message Display tool. 
The Message Display tool can be configured in one of three different ways. 
It can display pre-configured messages based on a trigger, system 
information messages, or it can allow you to enter ASCII text messages to 
be written to a control device or another tool.

Slider Properties Setting

Values - Slide Input
Values - Slide Output
Values - Min Value
Values - Max Value

Slide_Data
Slide_Data
0
50

Gauge Properties Setting

Values - Tool Value 
Output
Values - Min Value
Values - Max Value

Slide_Data
0
50

Bar Graph Properties Setting

Values - Tool Value 
Output
Values - Limit 1 Output
Values - Limit 2 Output
Values - Min Value
Values - Max Value

Slide_Data
20
40
0
50
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The final panel, Tools3, should appear similar to the figure below.

1 With the Tools2 panel open, select the Exit, Go To Panel, and Back 
buttons from the panel.

2 Select the Copy button from the menu bar.

3 Click the background of the Tools2 panel.

The Panel menu displays.

4 Select the Next Panel command to open the Tools3 panel.

5 Select the Paste button from the menu bar and position the panel 
navigation buttons in the lower right corner of the Tools3 panel.

6 With the Tools3 panel open, select and drag a Message tool from the 
toolbin onto the panel.

A Message tool is created on the panel.

7 Place the Message tool in the upper left corner of the panel.

8 Select and drag another Message tool from the toolbin onto the 
panel and place it in the upper right corner.

A second Message tool is created on the panel.

9 Select each property from the menu and configure the settings as 
listed in the tables below. Configure the first Message tool (left 
corner) then configure the second Message tool you placed on the 
panel. Refer to the appropriate table for configuration settings.
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Testing the Message Tools in Run Mode

1 With the Tools3 panel in the workspace, select the Test Runtime 
 icon in the designer. 

You enter test runtime. 

2 Select the upper left Message tool. 

3 Type in a text message and press Enter.

The message now appears in this Message tool along with the 
Message tool to the right.

4  Select the Exit button.

You are returned to the Designer.

Adding a Message File and Message Tool to the Tools3 Panel

Another function of the Message Display tool is to read a message file of 
pre-defined ASCII text messages and display those messages on the 
runtime panel. Messages can be created in the PFD, as the following steps 
will demonstrate. You can also create messages in Microsoft Excel and 
import that message file into the PFD.

Left Message Display 
Properties Setting

Type Message Entry

Actions - Max Message 
Length
Actions - Clear Upon 
Select

200

Checked

Values - Message Input
Values - Message Output
Values - Message Source

Message_Text
Message_Text
Remote

Right Message Display 
Properties Setting

Type Display Only

Values - Message Output
Values - Message Source

Message_Text
Remote
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In this section of the tutorial you will create a list of messages and display 
them in the Message Display tool based on a trigger. You must first create 
the message file then correctly configure a Message Display tool in order to 
display messages.

Creating a Message File
1 Select the Project tab from the Designer workspace.

The Project view is opened.

2 Select New from the menu.

3 Select Message Table from the fly-out.

4 Enter MsgFile1 for the Message Table name.

The Message Editor opens as shown below.

Now add a list of five text messages for this file. Each of these 
messages correspond to a message number. In runtime each 
message will be displayed when its message number is loaded into 
the designated address.

5 Double-click on the row next to number 1 and enter the text 
“Message Number 1”. 

6 Click the check mark in the upper right corner.

7 Double-click on the row next to number 2 and enter the text 
“Message Number 2”.

8 Click the check mark in the upper right corner.

9 Double-click on the row next to number 3 and enter the text 
“Message Number 3”.

10 Click the check mark in the upper right corner.
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11 Double-click on the row next to number 4 and enter the text 
“Message Number 4”.

12 Click the check mark in the upper right corner.

13 Double-click on the row next to number 5 and enter the text 
“Message Number 5”.

14 Click the check mark in the upper right corner.

As you enter each message the menu displays the properties that 
apply to that particular message. This makes it possible for each 
message to have a unique font color, font size, and font style. You 
can also add images to a message text string. 

15 Select the Project tab from the menu bar.

The Project view is displayed with Message File - “MsgFile1” 
displayed as part of the project. Now you will add a Message Display 
tool to display the messages from this file.

Creating a Message Display Tool to display Message File text
1 Select the Tools3 panel from the Project workspace then select Edit 

from the menu.

The Tools3 panel opens.

2 Select and drag a Message tool from the toolbin onto the panel.

A Message tool is created on the panel.

3 Place the Message tool to the left of the panel, below the first 
Message tool.

4 Select each property from the menu and configure the settings as 
listed in the table below. 

5 With the Message tool selected, click the Next Message command 
from the menu.

The Message tool displays the first message from the message file. 
You may have to resize the Message tool in order to see the 
complete message text.

6 Continuing to click the Next Message command will cycle through 
all the messages in the message file.

Now you will add an Increment and Decrement button to allow cycling 
through the messages in the message file while in runtime.

Message Properties Setting

Type Display Only

Values - Message Output
Values - Message Source

Message_Number
MsgFile1
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Adding an Increment and Decrement button to the Tools3 Panel

1 Select and drag a button tool from the toolbin onto the panel.

A button tool is created on the panel.

2 Drag the button below the Message tool and to the left.

3 Select and drag another button from the toolbin onto the panel.

A second button is created on the panel.

4 Drag this button below the Message tool and to the right of the first 
button.

5 Select each property from the menu and configure the settings as 
listed in the table below for each button. Make the left button an 
Increment button and the right button a Decrement button. 

Increment Button 
Properties Setting

Type Increment

Values - Switch Input
Values - Base Value
Values - Increment By
Values - Maximum

Message_Number
Message_Number
1
5

Appearance - Off Lens - 
Edit Text
Appearance - Off Lens - 
Font Size
Appearance - Off Lens - 
Apply To All

Inc Msg

10

Select it

Decrement Button 
Properties Setting

Type Decrement

Values - Switch Input
Values - Base Value
Values - Decrement By
Values - Minimum

Message_Number
Message_Number
1
0

Appearance - Off Lens - 
Edit Text
Appearance - Off Lens - 
Font Size
Appearance - Off Lens - 
Apply To All

Dec Msg

10

Select it
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Each of the Message Display tools on this panel are configured for 
different functions. You will now add some text to the panel that 
names each displays purpose.

6 Select and drag a text object from the toolbin onto the panel.

A text object is created on the panel.

7 Select and drag two more text objects from the toolbin onto the 
panel.

8 Drag each text object to a position that is above each Message 
Display tool and centered over the tool.

The final panel should appear as shown on page 7-3.

9 Select each text object, select the Edit Text command and enter the 
text as shown in the figure on page 7-19.

Testing the Message Tools with a Message File in Run Mode

1 With the Tools3 panel in the workspace, select the Test Runtime 
 icon in the designer. 

You enter test runtime. 

2 Select the Increment button.

Each time you click the Increment button the Message Display tool 
displays the message text associated with the number. Message text 
is derived from the message file you created earlier. Use the 
Decrement button to move back through the message file.

3 Select the Exit button.

You are returned to the Designer.

Creating a New Panel with Selection Entry and Input List Tools

The Selection Entry and Input List tools provide extended control 
functionality for your application. The Selection Entry tool allows you to 
create a list of pre-configured numeric values for the operator to use in 
runtime.  The Selection Entry tool also allows you to assign a meaningful 
name or description for each value allowing the operator to associate a 
name for a particular setting rather than just a numeric value.

At this point in the tutorial it is assumed you have become familiar with the 
process of creating new panels and placing navigational controls on the 
new panel. Refer to previous sections for these details.

After adding the Selection Entry tool, you will add a Numeric Display tool 
that is used to verify items sent by the Selection Entry tool.
 Parker Factory Display User Guide 7-24



Chapter 7: Using the Tools
The final panel, Tools4, should appear similar to the figure below.

Adding a Selection Entry and Numeric Display Tool
1 Create a fourth panel for your project and name it Tools4. 

2 Copy the Exit, Go To Panel, and Back buttons from a previous panel 
and paste them onto the Tools4 panel.

You are now ready to add the Selection Entry and Input List tools.

3 With the Tools4 panel open, select and drag the Selection Entry tool 
onto the panel, placing the tool in the upper left corner of the panel.

4 Select and drag the Numeric Display tool from the toolbin and 
position the tool to the right of the Selection Entry tool. 

5 Select each property from the menu and configure the settings as 
listed in the tables below. Refer to the appropriate table for 
configuration settings.

Selection Entry 
Properties Setting

Values - Selection Entry 
Input
Values - Display Value 
Output

Select_Entry

Select_Entry

Selections - Click on the 
+ <icon> icon to add an 
item to the selection list. 

Name: Meters/Second - Select the Name box to enter this text.
Value: 1 - Select the Value box to enter this value.
Name: Feet/Second
Value: 2
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The selection list should look like the figure below when completed.

6 Click the check mark in the upper right corner of the Selection list to 
accept the values and close the list.

7 Select the Numeric Display tool and configure its settings as shown 
below.

Testing the Selection Entry Tool in Run Mode
1 With the Tools4 panel in the workspace, select the Test Runtime 

 icon in the Designer. 

You enter test runtime. 

2 Select the Selection Entry tool. 

The Selection List popup appears.

3 Select Meters/Second from the list then click Accept.

The Selection Entry tool displays the selection entered and the 
Numeric Display tool shows actual values that would be entered in 
the controller.

4 Select the Selection Entry tool again then select Feet/Second 
from the popup list. Click Accept to send this value.

5 Select the Exit button.

Numeric Display 
Properties Setting

Values - Tool Value 
Output
Values - Limit 1 Output
Values - Limit 2 Output

Select_Entry
0
2
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You are returned to the Designer.

Adding an Input List to the Project
The Input List tool allows you to configure multiple lists of data items that 
can be written to the controller. A list is a collection of controller variables 
that contain preset values that control the components and quantities used 
in a process. Each list includes a name for the list and an array of items 
consisting of a short text description and a data value.

You can configure buttons to select a list, edit data values, save new data 
values, and send the list to the controller.

The lists that are used by the Input List tool are configured through the List 
Editor interface. You will first create an input list then configure an Input 
List Viewer to display the list to the user. You will also configure buttons to 
perform the list operations discussed above.

1 Select the Project tab from the PFD toolbar.

2 Select New, then Input List.

3 Enter the name as My_List.

A new Input List is created for the project. The input list grid is 
displayed. You will now enter five items within the grid.

4 Select New Item from the menu. 

The Edit Input List Item dialog displays as shown below with the first 
input list item populated.
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5 Configure the five input list items as shown in the table below. Select 
the Create a New Input List item button  after entering 
each items configuration information.

Now that a list is configured, you will create an Input List Viewer tool along 
with button tools to load the list into the panel and then send the list.

Adding an Input List Viewer to the Panel
1 Select the Panel tab from the Parker Factory Display toolbar.

The Tools4 panel displays.

2 With the Tools4 panel open, select and drag the Input List Viewer 
tool onto the panel, placing the tool below the Selection Entry tool.

You will not need to configure Input List Viewer properties as you will 
use the current tool defaults.

Input List Item Dialog 
Configuration Setting

Input List Item 1 Name:                      ItemA
Send Value Input:    Item_1
Data Value:             Analog
Value:                      11
Minimum Value:     0
Maximum Value:       100

Input List Item 2 Name:                      ItemB
Send Value Input:    Item_2
Data Value:             Analog
Value:                      22
Minimum Value:     0
Maximum Value:       100

Input List Item 3 Name:                      ItemC
Send Value Input:    Item_3
Data Value:             Analog
Value:                      33
Minimum Value:     0
Maximum Value:       100

Input List Item 4 Name:                      ItemD
Send Value Input:    Item_4
Data Value:             Analog
Value:                      44
Minimum Value:     0
Maximum Value:       100

Input List Item 5 Name:                      ItemE
Send Value Input:    Item_5
Data Value:             Analog
Value:                      55
Minimum Value:     0
Maximum Value:       100
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You will now add and configure buttons that are used with the Input 
List Viewer to load and send a list during runtime. In addition, you 
will add Numeric Display tools to the panel in order to display the 
results of transferring a list to a control device.

3 Select and drag two buttons onto the panel. Place the buttons below 
the Input List Viewer.

4 Resize all the panel tools so that room is available for all tool objects.

5 Select and drag five Numeric Display tools onto the panel. Place 
them along the right side of the Input List Viewer. 

You can also create one Numeric Display tool, then copy the tool and 
paste it four additional times.

6 Configure the two buttons and five Numeric Display tools as shown 
in the tables below. Refer to the appropriate table for configuration 
settings. You must select each Numeric Display tool, individually, to 
display the tools properties in the menu.

The final Tools4 panel should look like the figure shown on page 7-
25.

Load List Button 
Properties Setting

Type Momentary

Values - Switch Input

Values - Lens Output

ListViewer.LoadList   Note: LoadList is an Input List Viewer system 
tag. You can select this tag from the drop-down list that appears.
ListViewer.LoadList

Appearance - Off Lens - 
Edit Text
Appearance - Off Lens - 
Font Size
Appearance - Off Lens - 
Apply To All

Load List

10

Click it

Send List Button 
Properties Setting

Type Momentary

Values - Switch Input

Values - Lens Output

ListViewer.SendList   Note: SendList is an Input List Viewer system 
tag. You can select this tag from the drop-down list that appears.
ListViewer.SendList
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Testing the Input List Viewer in Run Mode
1 With the Tools4 panel in the workspace, select the Test Runtime 

 icon in the designer. 

You enter test runtime. 

2 Select the Load List button. 

A Selection List popup appears.

3 Select My_List from the list then click Accept.

The Input List Viewer displays the list items along with their values.

4 Select the Send List button.

The list is sent and the Numeric Display tools display the value for 
each list item. This simulates sending a list to the control device. 

5  Select the Exit button.

Manipulating Objects

This section of the tutorial allows you to experiment with several object 
manipulation features such as those in the list below:

• Grouping/Ungrouping

• Ordering

Appearance - Off Lens - 
Edit Text
Appearance - Off Lens - 
Font Size
Appearance - Off Lens - 
Apply To All

Send List

10

Click it

Numeric Display Tool 
Properties Setting

First Numeric Tool Values - Tool Value Output: Item_1

Second Numeric Tool Values - Tool Value Output: Item_2

Third Numeric Tool Values - Tool Value Output: Item_3

Fourth Numeric Tool Values - Tool Value Output: Item_4

Fifth Numeric Tool Values - Tool Value Output: Item_5

Send List Button 
Properties Setting
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• Aligning

• Match Size

• Distributing

• Orienting

In order to experiment with these features, you will first create a new 
panel then place objects on the panel.

Creating a New Panel
At this point in the tutorial it is assumed you have become familiar with the 
process of creating new panels and placing navigational controls on the 
new panel. Refer to previous sections for these details.

1 Create a fifth panel for your project and name it Tools5. 

2 Copy the Exit, Go To Panel, and Back buttons from a previous panel 
and paste them onto the Tools5 panel.

You are now ready to add tools.

Grouping/Ungrouping Objects
The Group feature allows you to take several objects and apply the Group 
command to those objects. Once grouped together, the multiple objects 
are treated as one object and the selection highlight surrounding the group 
reflects that these are no longer manipulated as separate objects, but as a 
single group.

1 With the Tools5 panel open in the workspace, select and drag three 
buttons onto the panel.

2 Select each button and hold down the Ctrl key with each selection.

As you select each button, sizing handles appear on all three buttons 
indicating they are currently selected.

3 Select the Group command from the menu.

The buttons are formed into a single group. The menu displays all 
commands associated with this type of grouped object. You can 
move and resize the group as you would any other object.

4 With the group highlighted, select the Ungroup command.

The group is now split into individual objects. 
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Order Objects
Ordering objects refers to changing the layering of objects on the panel on 
top of or underneath other panel objects. This is also referred to as the Z 
order of the objects on a panel.

1 With the Tools5 panel open in the workspace, select the buttons on 
the panel and stack each one over the other so that a portion of each 
button is visible from the edge. 

This allows you to notice the order of each object on the panel. The 
first object placed on the panel appears underneath all other objects.

2 Select the topmost button on the panel. 

3 Select Order -> Backward One from the menu.

The selected object moves below the next object in the stack of 
layered objects.

4 With the object still selected, select Order -> Forward One from 
the menu.

The selected object moves to the top of the stack. Select the other 
objects and experiment with the Order command options.

Align Objects
Aligning objects is extremely useful for quick and easy lining up of multiple 
objects on the panel relative to one another. You can align objects; left, 
center, right, top, middle, bottom.

1 With the Tools5 panel open in the workspace, select two of the three 
buttons on the panel.

Two of the buttons are selected.

2 Select Align Objects -> Right from the menu.

The object with the special sizing handles on it is the object that all 
others will be aligned relative to. The last selected object on the 
panel is the one in which all others will align to.

Select the other objects and experiment with the Align Objects 
command.

Match Size
The Match Size command allows you to make one or more objects the 
same height and width as another selected object.
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1 With the Tools5 panel open in the workspace, resize the tools so 
each one is a different dimension then all the others on the panel.

2 Select two of the three buttons on the panel.

Two of the buttons are selected.

3 Select Match Size -> Width.

All buttons are made to match the last selected objects width. Select 
the other button and experiment with the Match Size command.

Distribute Objects
The Distribute command allows you to space selected objects evenly apart 
from one another on the panel.

1 With the Tools5 panel open in the workspace, move the tools so each 
one is separated from the other buttons on the panel.

2 Select all three buttons on the panel.

All the buttons are selected. You must select at least three buttons 
for the Distribute command to become available on the menu. 

3 Select Distribute -> Horizontally.

All selected buttons are spaced evenly within the distance of the 
right edge of the object located farthest to the right on the panel and 
the left edge of the leftmost object on the panel.

Orient Objects
The Orient command allows you to change the relationship between a 
selected graphical object and the panel. Since there are no graphical 
objects on this panel, the steps are not applicable at this point in the 
tutorial.

This completes the tools tutorial.
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This chapter is a tutorial that assists you in becoming familiar with 
developing Parker Factory Display panels with a small number of graphics. 
You also gain experience configuring all the available animation 
connections.

The tutorial will take about one hour to complete. It exposes you to most of 
the graphic objects and a majority of their properties. It is recommended 
that you perform these steps to boost your knowledge of the Parker 
Factory Display (PFD). 

Do not skip steps as each section of the tutorial builds upon previous 
sections. The project your developing will work successfully only if the 
steps are followed as described and in the order in which they are 
presented.

This tutorial assumes you are using the Offline interface to create this 
project. You can use a browser to connect to a remote PFD unit and 
perform the tutorial as well. To start the designer from your browser, enter 
the URL of the PFD device in your browser’s address bar. The Parker 
Factory Display is displayed. Other than launching the PFD within your 
browser, all other steps described below can be accomplished either 
through Offline or your browser. 

You should also perform the tutorial within the PFD Quick Start Guide. The 
tutorial in that manual is more specific to the types of applications more 
likely developed for use with the PFD.

You will accomplish the following objectives within this tutorial:

• Create a new project and panel

• Draw graphical objects on the panel

• Apply various animation connections to graphical objects

Parker Factory Display panels are saved automatically, therefore as you 
progress through the tutorial, you will not have to perform any save 
operation as this is accomplished for you. This is another of the many great 
features of the PFD.

Creating a New Project

The first step in developing a Parker Factory Display application is to create 
a new project.

1 Launch the Parker Factory Display from your workstation by 
selecting the PFD icon  from your desktop.
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The PFD launches and displays the welcome screen.

2 Select the New  icon from the local pane.

The New Project dialog appears.

3 Enter a name for your project such as Graphics Tutorial.

The project is created and displays an icon within the local pane. The 
project launches within the workspace and Shell appears as shown 
below.

Creating a New Panel

A project consists of many items, such as driver configurations, panels, 
message files, etc. The next step in developing your project is to create 
panels.

1 With the Graphics Tutorial project loaded in the workspace, 
maximize the window or browser so that you can see the entire 
workspace.

2 Select the Design  button.

The PFD Designer launches within the workspace.

3 Within the PFD Designer, select the New command from the menu.

The New fly-out appears.
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4 Select Panel and enter a name for the panel in the Panel text box as 
shown below. Name the panel Graphics1.

5 Press Enter to save the panel and open the Panel Editor. You can 
also select the checkmark in the upper right of the fly-out.

A blank panel appears. You are now ready to begin configuring your 
panel.

Adding Navigation Tools to a Panel

Panels can consist of tool and graphic objects. Follow these steps to add 
the following tools to your panel.

• Maintained button

• Exit button

When adding tools to your panel, you may wish to resize the tool in order 
to leave adequate space on your panel for further panel development.

The final panel, Graphics1, should appear similar to the figure below.
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Adding the tool:
1 With the Graphics1 panel open, select and drag the button from the 

toolbin onto the panel.

A button is created on the panel. Resize the button. The toolbin is 
shown below.

2 Place the button in the lower right corner of the panel by selecting 
the button and dragging it into place.

Moving the tool:
3 When an object is selected, selection handles appear on the object. 

An object can be moved anytime it’s selection handles appear.

Sizing the tool:
4 To resize an object, simply select the object, move the cursor over 

one of the selection handles, the cursor will change into an arrow, 
then move the selected handle and resize the object as desired.

Configuring the Maintained button:
With an object selected on the panel, the menu reflects all the properties 
and commands associated with the selected object.

1 Select each property from the menu and configure the settings as 
listed in the table below.

There are properties with each tool that are not listed in the table below. 
Leave those properties at their defaults, only change those properties 
listed below. You may explore the other properties if you wish.

Using the Property heading in the table, select the first property, such as 
Appearance, this will either display a fly-out menu or a secondary menu 
with further selections. From the fly-out or secondary menu you select the 
second property such as Off Lens.

A typical secondary menu is shown below. All secondary menus have an 
arrow in the upper left corner that, when selected, will take you back to the 
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upper level menu. Therefore, selecting the left arrow in the Off Lens menu 
shown below returns you to the main menu.

Adding and Configuring an Exit button:
1 With the Graphics1 panel open, select and drag the button from the 

toolbin onto the panel.

A button is created on the panel.

2 Place the button in the lower right corner of the panel to the left of 
the other button as shown in the figure on page 8-3. Adjust the size 
of the button as necessary.

3 Select each property from the menu and configure the settings as 
listed in the table below.

Button Properties Setting

Type Goto Panel

Values - Panel - New 
Panel

 
Graphics2

Appearance - Off Lens - 
Edit Text 
Appearance - Off Lens - 
Font Size 
Appearance - Off Lens - 
Apply to All

 
Go To Panel 
 
10 
 
Select this

Exit Button Properties Setting

Type Exit
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Drawing and Manipulating Graphic Objects

You will now place each type of graphic object on the panel and manipulate 
the graphic.

To add a line plus add and delete points:
1 Select the line object from the toolbin and drag it onto the panel.

A line object is created on the panel.

2 With the line object selected, press and hold the Ctrl+Shift keys.

The cursor changes into a + symbol. A grid appears on the panel. 
The grid is used to precisely place nodes for lines and polygons.

3 Click anywhere near the line.

A point is added to the line. Continue to click and press the 
Ctrl+Shft key combination and additional line points are created.

4 Move the cursor over a point, press and hold the Ctrl+Shift keys.

The cursor changes into a - symbol.

5 Click on the point. As long as there are more than two points on the 
line, clicking on the point deletes it from the line. The remaining 
points on the line will remain connected.

To add a polygon plus add and delete points:
1 Select the polygon object from the toolbin and drag it onto the 

panel.

A polygon object is created on the panel.

2 With the polygon object selected, press and hold the Ctrl+Shift 
keys.

The cursor changes into a + symbol.

3 Click anywhere near the polygon.

A point is added to the polygon. Continue to click and press the 
Ctrl+Shft key combination and additional polygon points are 
created.

4 Move the cursor over a point, press and hold the Ctrl+Shift keys.

The cursor changes into a - symbol.

Appearance - Off Lens - 
Edit Text 
Appearance - Off Lens - 
Font Size 
Appearance - Off Lens - 
Apply to All

 
Exit 
 
10 
 
Select this

Exit Button Properties Setting
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5 Click on a point. 

As long as there are more than three points on the polygon, clicking 
on the point deletes it from the polygon. The remaining points on the 
polygon will remain connected, reshaping the polygon.

To add a rectangle plus constrain the object as a square:
1 Select the rectangle object from the toolbin and drag it onto the 

panel.

A rectangle object is created on the panel.

2 With the rectangle object selected, move the cursor over one of the 
four corners of the rectangle object.

3 Press and hold the Ctrl+Alt keys.

The cursor changes into a double-headed arrow. As you move the 
corners of the rectangle, resizing the rectangle, it is constrained into 
a square. 

Selecting a point other than a corner point, then resizing the 
rectangle will not constrain the shape of the object.

Release the Ctrl+Alt keys.

Resizing the rectangle will only constrain it’s shape if the Ctrl+Alt 
keys are pressed.

To add an ellipse plus constrain the object as a circle:
1 Select the Ellipse object from the toolbin and drag it onto the panel.

An ellipse object is created on the panel.

2 With the ellipse object selected, move the cursor over one of the four 
corners of the ellipse object.

3 Press and hold the Ctrl+Alt keys.

The cursor changes into a double-headed arrow. As you move the 
corners of the ellipse, resizing the ellipse, it is constrained into a 
circle.

Release the Ctrl+Alt keys.

Resizing the rectangle will only constrain it’s shape if the Ctrl+Alt 
keys are pressed.

To add an arc:
1 Select the arc object from the toolbin and drag it onto the panel.

An arc object is created on the panel.

2 Resize the arc object by moving the cursor over one of the four 
corners of the arc object.
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The arc can be constrained in size using the same method as 
described for the other graphic objects (Ctrl+Alt key combination).

To add a text object:
1 Select the text object from the toolbin and drag it onto the panel.

A text object is created on the panel.

2 Resize the text object by moving the cursor over one of the four 
corners of the text object.

The text can be constrained in size using the same method as 
described for the other graphic objects (Ctrl+Alt key combination).

Delete the graphic objects on the Graphics1 panel by selecting them all:
1 Press and hold the left mouse button as you drag the mouse across 

all the graphic objects on the panel.

As you drag the mouse, a rubber-band appears across all the 
graphic objects. 

Each selected object will appear with selection handles. Make sure 
you have not selected the Exit or Go To Panel buttons. If you have, 
click off the selected objects and rubber-band through the graphic 
objects, again, ensuring you do not select either of the button tools.

2 Press Delete.

All graphic objects are deleted from the panel.

Animating the Graphics1 Panel

You will now create a simple animated panel containing graphical objects. 
You will experiment with location and appearance connections.

The final panel your creating will look like the figure on page 8-3.

Configuring Location and Appearance Connections
1 Select the Rectangle object from the toolbin and drag it onto the 

panel and place it in the upper left corner. Make the rectangle stretch 
across the panel. Refer to the figure on page 8-3.

A Rectangle object is created on the panel.

2 Select the Ellipse object from the toolbin and drag it onto the panel 
and place it in the upper left corner. Place the Ellipse on top of the 
Rectangle as if it were laying on a conveyor. Refer to the figure on 
page 8-3.

An Ellipse object is created on the panel.

3 With the Ellipse object selected, select Animations -> New -> 
Appearance. 

An appearance animation is created for the Ellipse object. The menu 
displays properties associated with the appearance connection.
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4 Select each property from the Appearance menu and configure the 
settings as listed in the table below.

You have now configured an appearance animation. When the value 
at cirapp1tag goes high, the appearance animation is applied. The 
ellipse object will then change color from it’s present state to Red.

5 With the Ellipse object still selected, click the left arrow located in 
the upper left corner of the menu.

The Ellipse object menu appears. From this menu, select another 
animation as described in the following steps.

6 Select Animations -> New -> Location.

A location animation is created for the Ellipse object. The menu 
displays properties associated with a location connection.

7 Select each property from the Location menu and configure the 
settings as listed in the table below.

Notice that there are nodes created for each point on the location 
path. The number next to each node represents the location of the 
graphic object based on the value read from the cirloc1tag address.

8 Select the node associated with the End Value (150) and stretch the 
node so that it ends at the end of the rectangle. 

Make sure you select directly on the node or you will return to the 
Rectangle properties menu. If that occurs, reselect the rectangle, 

Ellipse Appearance 
Properties Setting

Name cirapp1

Output Tag cirapp1tag

Color1 Select Red from the Color1 palette.

Ellipse Location 
Properties Setting

Name cirloc1

Output Tag cirloc1tag

Start Value 0

End Value 150

Path Roundness 0
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then select Animations -> cirloc1, to view the animation 
properties.  

9 Select the Button and Slider tools from the toolbin and drag them 
onto the panel. Place them below the Rectangle/Ellipse objects.

10 Select each property from the Button and Slider menus and 
configure the settings as listed in the tables below.

Testing the Graphics1 Panel in Run Mode
Once the panel has been developed you can now test it in runtime. You can 
quickly enter test runtime to test the functionality of your application.

1 Select the Test Runtime  icon in the Designer. 

You enter test runtime.

2 Select the maintained button and notice that the Ellipse graphic 
reflects the cirapp1tag bit’s change of state.

3 Select the Slider and move the knob position up and down the 
Slider tool.

As you move the knob, the data changes at the cirloc1tag which 
causes the Ellipse to move across the rectangular conveyor.

Button Properties Setting

Type Momentary

Values - Switch Input 
Values - Lens Output

cirapp1tag 
cirapp1tag

Appearance - Off Lens - 
Edit Text 
Appearance - Off Lens - 
Font Size 
Appearance - Off Lens - 
Apply To All

 
Cir App 
 
10 
 
Select it

Slider Properties Setting

Values - Slide Input 
Values - Slide Output 
Values - Min Value 
Values - Max Value

cirloc1tag 
cirloc1tag 
0 
150
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4 Select the Exit Run Mode button and you are returned to the 
Designer.

Adding another Location Animation
You will now add another Ellipse object with a location animation.

1 Select the Ellipse object from the toolbin and drag it onto the panel. 
Place the Ellipse below the rectangle. Refer to the figure on page 8-
3.

An Ellipse object is created on the panel.

2 With the Ellipse object selected, select Animations -> New -> 
Location. 

A location animation is created for the Ellipse object. The menu 
displays properties associated with a location connection.

3 With the Ellipse object selected, press and hold the Ctrl+Shift key 
combination then click along the location path to add additional 
nodes.

Each time you click the location path, a node is added to the path 
with a number displayed above each node. This number represents 
the location of the graphic object based on the value read from the 
cirloc1tag address. Add as many nodes as you wish. There is no 
specific path you need to create, be creative! 

You must continue to press and hold the Ctrl+Shift key combination 
in order to add the nodes to the path.

4 Release the Ctrl+Shift key combination after you have added all the 
nodes you wish.

5 After the path is created, you can click a node and move it around 
the panel to achieve the desired location animation path.
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Refer to the figure below for a sample path you may create.

6 Select each property from the Location menu and configure the 
settings as listed in the table below.

Selecting a closed path will complete the location path, bringing the object 
back to the starting node upon reaching the maximum value.

Testing the Graphics1 Panel with an added Location Animation
1 Select the Test Runtime  icon in the Designer. 

You enter test runtime.

2 Select the Slider and move the knob position up and down the 
Slider tool.

As you move the knob, the data changes at the cirloc1tag which 
causes the Ellipse to move across the rectangular conveyor. The 
second Ellipse you just created will follow the path you designated 
during development.

3 Select the Exit Run Mode button and you are returned to the 
Designer.

Ellipse Location 
Properties Setting

Name cir2loc1

Output Tag cirloc1tag (same address as the first Ellipse location animation)

Start Value 0

End Value 150

Path Roundness 100 - Notice that the nodes become rounded.

Closed Path Select it - Notice that the path end node overlaps the path 
beginning node.
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Creating the Graphics2 Panel

You will now create a second graphics panel to continue experimenting 
with additional animation connections.

Configuring the panel navigation buttons
You must first create panel navigation buttons on the Graphics2 panel. 

1 With the Graphics1 panel in the project workspace, select both the 
Exit and Go To Panel buttons.

2 Select Copy, go to the panel Graphics2, select Paste.

Both the Exit and Go To Panel buttons are pasted onto the Graphics2 
panel.

3 Select the Go To Panel button, select Values -> Panel -> 
Graphics1.

You modified the Go To Panel configuration so that during runtime 
operation, selecting this button will take you to the Graphics1 panel.

Configuring Size and Appearance Connections
The final panel you will create looks similar to the graphic shown below.

You will use rectangle objects to create tanks and tubing between the 
tanks. A Slider and Button tool are used to control the flow of fluid between 
the tanks and to open and close the tube.

In addition, a Polygon will be added to the panel and will contain a rotation 
animation connection. A second Slider tool will be used to control the 
rotation and transparency of the Polygon. This activity will firm up your 
understanding of the remaining animation connections.
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1 Select the Rectangle object from the toolbin and drag onto the 
panel.

2 Select Style -> Thick Border from the menu.

3 Select another Rectangle object from the toolbin and drag onto the 
panel, place the object inside the Rectangle you just created.

4 Resize the inner rectangle so that it fills up the majority of the outer 
rectangle space. Refer to the figure on page 8-13.

5 With the “inner” rectangle selected, select Color 1 -> Light Blue 
from the menu.

6 With the “inner” rectangle selected, click Animations -> New -> 
Size and configure the settings as listed in the table below.

7 Select both the “outer” and “inner” rectangles by holding down the 
Ctrl key as you select them.

8 Select the Copy button then the Paste button.

The tank is copied onto the panel.

9 Place the tank to the right of the first tank.

10 After placing the tank to the right of the panel, select only the 
“inner” rectangle of the pasted tank.

11 Change the size of the “inner” rectangle so that it appears almost 
“empty”. Refer to the figure on page 8-13.

Rectangle Size 
Properties Setting

Name tank1size

Output Tag tank1sizetag

Start Value 0

End Value 150

Direction Select the arrow pointing up. The inner rectangle will be selected. 
Move the highlighted point (white colored) down. This is the size of 
the rectangle at the End Value, as if the tank were almost empty.
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You will change the sizing direction of this rectangle, leaving all other 
properties the same as the first tank. Therefore, when the left tank 
is emptying, the right tank is filling up.

12 Click Animations -> tank1size and configure the settings as listed 
in the table below.

Now you will add a rectangle object and create the tubing between 
the two tanks. Refer to the figure on page 8-13 for a view of the 
panel.

13 Select a rectangle from the toolbin and place it on the panel. Move 
the rectangle and resize it so that it appears to connect between the 
two tanks. 

14 With the rectangle connecting the two tanks selected, click 
Animations -> New -> Appearance and configure the settings as 
listed in the table below.

Rectangle Size 
Properties Setting

Name tank1size

Output Tag tank1sizetag

Start Value 0

End Value 150

Direction Select the arrow pointing up. The inner rectangle will be selected. 
Move the highlighted point (white colored) up. This is the size of the 
rectangle at the End Value, as if the tank were almost full.

Rectangle Appearance 
Properties Setting

Name valveopen

Output Tag valveopentag

Color 1 Light Blue
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Now you will add a Slider to control the tank fill and a button to 
control the valve.

15 Select the Slider and Button tools and drag them onto the panel. 
Position the Slider and Button both below the tank objects.

16 Select each property from the Button and Slider menus and 
configure the settings as listed in the tables below.

Testing the Graphics2 Panel in Run Mode
1 Select the Test Runtime  icon in the Designer. 

You enter test runtime.

2 Select the Open Value button.

The rectangle connecting the two tanks changes color.

3 Select the Slider and move the knob position up and down the 
Slider tool.

As you move the knob, the data changes at the tank1sizetag which 
causes the left tank fluid level to decrease at the same time as the 
right tanks fluid level increases. 

4 Select the Exit button and you are returned to the Designer.

Configuring Rotation and Transparent Connections
You will now add a polygon and configure it with rotation and transparent 
animation connections.

Button Properties Setting

Type Maintained

Values - Switch Input 
Values - Lens Output

valveopentag 
valveopentag

Appearance - Off Lens - 
Edit Text 
Appearance - Off Lens - 
Font Size 
Appearance - Off Lens - 
Apply To All

 
Open Valve 
 
10 
 
Select it

Slider Properties Setting

Values - Slide Input 
Values - Slide Output 
Values - Min Value 
Values - Max Value

tank1sizetag 
tank1sizetag 
0 
150
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1 Select a polygon from the toolbin and place it on the panel. Move the 
polygon so that it is to the right of the Slider and Button tools. Refer 
to the figure on page 8-13.

2 Select the polygon and delete some of its points so that it appears as 
a pointed object. 

3 With the Polygon selected, click Animations -> New -> Rotation 
and configure the settings as listed in the table below.

4 Click off the Polygon, then reselect it to display the Polygon menu in 
order to apply the transparency animation. 

5 With the Polygon selected, click Animations -> New -> 
Transparency and configure the settings as listed in the table 
below.

Now you will add a Slider to control the rotation and transparency of 
the polygon.

6 Select the Slider tool and drag it onto the panel. Position the Slider 
next to the polygon object.

7 Select the property from the Slider menu and configure the settings 
as listed in the table below.

Polygon Rotation 
Properties Setting

Name polyrot

Output Tag polyrottag

Start Value 0

End Value 150

Direction Clockwise

Polygon Transparency 
Properties Setting

Name polytrans

Output Tag polyrottag - (you are using the same tag to both rotate and cause the 
object to turn transparent)

Start Value 0

End Value 150

Direction Opaque to Transparent
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You are now ready to perform the final test of the Graphics2 panel.

Final Test of the Graphics2 Panel
1 Select the Test Runtime  icon in the Designer. 

You enter test runtime.

2 Select the Slider and move the knob position up and down the 
Slider tool.

As you move the knob, the data changes at the polyrottag which 
causes the Polygon to rotate in a clockwise direction at the same 
time that it turns transparent. 

3 Select the Exit button and you are returned to the Designer.

This concludes the Graphics animation tutorial.

Slider Properties Setting

Values - Slide Input 
Values - Slide Output 
Values - Min Value 
Values - Max Value

polyrottag 
polyrottag 
0 
150
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The Tag Editor lets you create and set up new tags, modify tags, delete 
tags, and validate tags. Any tag you create is referred to as a user-defined 
tag, to differentiate it from system tags that have predefined functions. 

A tag is a variable that is used in place of a controller-specific address or 
relational expression. Tags reference values from a control device or an 
expression of multiple values. You define Panel tools using tags for their 
input and output references. The Tag Editor is used to associate the tags 
with controller references. Tags can reference: 

• An address reference string from the control device. 

• An internal memory value in the run mode workstation. 

• A scaling function or expression made up of other tags and/or 
controller-specific references. 

To learn more, refer to the following: 

• Tag Editor Window

• Creating and Editing Tags

• Deleting Tags

• Validating Tags

• Using System Tags

• Using expressions

• Using Data Types

• Tag Scaling

• Tag Rules

Tag Editor Window 

The Tag Editor consists of several columns of tag data. You can edit the 
name and address fields for every tag you create. The edits you make to 
these fields determine how the tag works in your project. The Tag Editor is 
shown below. 
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New tags are displayed at the end of the Tag Editor list until you sort the 
columns. The table below describes the information found in the tag list. 

Field Description

Status The column to the left of the tag name provides a summary of the tag status. 
Normally, this field is blank. However, an icon may appear here to give a summary of 
the tag status. 

• A dark grey X means that the tag is not currently used in your project, 
however there are no errors associated with it. 

• A yellow question mark (?) means the device address has not been 
validated. Tag validation occurs when you configure the tag in the Tag 
editor. 

• A red exclamation point (!) means that at least one of the tag fields is in 
error. 

Note that a warning does not necessarily mean that there is anything wrong with the 
tag definition, just that there could be. For example, if a tag is tied to a source that is 
not available at design time, then a warning appears in the address field specifying 
that address validation will not be performed. 

Tag Properties Tag List

Menu

Designer Frame

Click on tag to
select, then choose
a command from
the menu.
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Tag references can occur in panel tools or from the address of another tag. 
It is important to note that data transfers still occur for tags that are not 
referenced. For example, if a tag has an address of 

‘Ch1.D1.K1’ = ‘Ch2.D1.K1’ 

this transfer still takes place even if no other tool or tag refers to this tag. 

A data transfer simply means that when the expression Ch2.D1.K1 
changes value, the result is written to Ch1.D1.K1. This happens whether 
there is a reference to the tag or not. By default, this evaluation is not 
performed during initialization of the application in runtime. 

To configure data transfers to occur during initialization of the application 
in runtime, check the Perform Initial Data Transfers option located on the 
applications Runtime Settings menu.

Sorting Tags 

New tags are added to the bottom of the Tag Editor list. To sort the tags 
displayed in the Tag Editor, select the column header you want to sort. 
Columns are sorted in the following order: 

• blank 

• numbers 0 - 9 

• letters A - Z 

• underscores 

Name This column displays the tags currently used in the project. You can edit the names 
either by highlighting a tag name and selecting Edit Tag from the Tags menu or by 
double-clicking on a tag name. The Edit Tag screen is displayed. For details on using 
this screen, refer to Creating and Editing Tags. 

There are a few restrictions to what can appear in the Name field: 
• The first character must be a letter. 

• Names can have up to 32 characters. 

• Names must contain only alphanumeric characters and underscores (_), 
though they cannot begin with an underscore except for system tags. 

• Tag names must be unique. There can not be duplicate tag names. 

• Tag names are NOT case sensitive. Therefore, a tag named 'Switch1' is 
the same as a tag named 'switch1'. 

Note that the names of system tags are predefined. You cannot modify them. For a list 
of system tags available in the PFD, refer to System Tags. 

Address An address is the memory location for the tag that is located in the data source. The 
Parker Factory Display interprets an empty device address as a local tag. 

Field Description
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The Status column sorts in the following order: 

• tags in error 

• unreferenced tags 

• normal tags 

Tag and expression Icons

The following table describes the expression icons used in the Parker 
Factory Display. 

Property Description

Connections Drops down a list of connections available with the selected 
tool. For example, you can have a button connected to an input 
list and viewer. In Runtime, when the button is pressed an input 
list can be sent to the input list viewer and displayed. You can 
also send the displayed input list to the PFD device, save the 
list with another name, clear the list, etc. 

The connections are listed in the following format:

toolname.tag/command

For example, lets say you have an input list named 
"MachineSetup" in your project. To create a button that sends 
the input list to the PFD device:

1 From the Button menu, you would select the Values 
> Switch Input menu command. The Switch Input 
box is displayed.

2 Click on the connections icon. 

3 Use the drop down list to select the tag: 
MachineSetup.SendList. This connects the 
MachineSetup input list to the button you created. 

During Runtime, pressing this button will send the input list, 
(MachineSetup) to the PFD device.

Tag List Drops down a list of tags currently used in the project. You can 
select a user-defined tag or a system tag. Tags are listed in 
alphabetical order, user-defined tags followed by System Tags. 

Functions & 
Operators 
List

Drops down a list of available functions and operators for 
mathematical, logical, and relational expressions. 
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Creating and Editing Tags 

When you define a tool in the Panel editor, you use tags to reference input 
and output values in the PFD device. You also use tags to determine 
whether a tool is accessible during Runtime. Tags can reference: 

• An address reference string from the control device. 

• An internal memory value in the PFD device. 

• A scaling function or expression made up of other tags and/or 
controller-specific references. 

Any tag that you create is referred to as a user-defined tag in order to 
differentiate it from system tags that have predefined functions. 

A status bar with two lines of information is displayed at the bottom of the 
Tag Editor. The top line of the status bar lists the data type and initial value 
of the selected tag. The bottom line of the status bar contains a description 
of the tag or error information as shown below. 

You can select multiple rows of tags by pressing and holding the Ctrl key as 
you select each tag in the editor. 

To Create a Tag
• Select New Tag from the Tag Editor menu. The Edit Tag screen is 

displayed. 

To Edit Tag Information
1 From the Tag Editor, highlight the row containing the tag you want to 

edit. You can also double-click on the row containing the tag. 

Recent 
expressions 
List

Drops down a list of the 10 most recently entered tags, 
expressions, and control device addresses. Select an item in 
the list to reuse it for the tag assignment. 

Property Description
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2 From the menu, select Edit Tag. The Edit Tag screen is displayed. 

The Edit Tag Screen 

The Edit Tag screen is shown below. 

The following table describes the properties available on the Edit Tag 
screen. 

Item Description

Name Enter the name for the new tag within the text box. There are a few restrictions 
concerning tag naming conventions: 
• The first character must be a letter. 

• Names may have a maximum of 32 characters. 

• Names must contain only alphanumeric characters and underscores (_), 
though they cannot begin with an underscore. 

• Tag names must be unique. There can not be duplicate tag names. 

• Tag names are NOT case sensitive. Therefore, a tag named 'Switch1' is 
the same as a tag named 'switch1'. 

• You cannot close the Edit Tag dialog box until all required information is 
entered and valid. 
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Address An address is the memory location for the tag that is located in the data source. The 
Parker Factory Display interprets an empty address as a local tag. 

There are a number of rules for properly addressing tags. 

• The Address field can be left blank (in the case of a local tag), directly 
reference a memory address, or it can be an expression. 

• If referencing a memory address, it will be in the format of: 
Channel.Device.memory_address 

• Refer to the communications driver used for your project as the exact 
format is dependent upon the specific driver your using. 

• The address is validated upon leaving the Edit Tag dialog or otherwise 
committing the tag. Validation is based on the device driver selected for 
your project. 

• If the tag has an invalid address, you cannot save and close the Tag 
Editor window. 

The standard format for direct addressing a memory address is Channel.Device.m1 , 
where 

• Channel references the communication driver 

• Device references the model of the driver. 

• m1 references the memory address. 

However, the address format can vary depending on the model and manufacturer of 
the controller. The address format you use depends on what is expected by your 
communication driver. For more about defining channels and devices, see the PFD 
Manager Help system. 

Examples of what you can enter in the Address field: 

• Sim.PLC.sine(250, 0, 100, 2, 0), where Sim is the channel, PLC is the 
device, and the numbers in parentheses specify the behavior of the sine 
function. 

• Channel1.Device1.k100, where k100 is the memory address. 

Tag scaling is the adjustment of a value using functions or expressions. Tag scaling 
can occur either at the tool level or in the Tag Editor. See Tag Scaling for a complete 
description of scaling options. 

Item Description
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The following table defines the controls used on the Edit Tag screen. 

Data Type The Data Type field specifies the storage size and type of data for this tag. The 
communication driver will determine if the specified type is valid at the specified 
device address location. All system tag data types are predefined and can not be 
changed. 

Select the data type from the drop down list. The default selection is Default. If the 
type is Default, the tag is assigned the data type for the memory area of the device 
driver defined within the address field. 

When you are finished, the PFD validates the data type. 

• The Default data type is determined by the device driver selected for this 
project. 

• Validation is dependent upon the device driver used with this project and 
the memory address assigned. 

For more information, see About Data Types. 

Initial Value Select this field to enter the tag's initial value. If an initial value is specified, it is 
written to the tag when the PFD is connected, unless the tag is read only. Note that if 
there are multiple remote users, the initial value is only written when the user puts 
PFD in connected mode. 

If an initial value is not specified, the PFD initializes the tag to the value stored in the 
tag address at startup. 

There are several issues to consider when determining an initial value for your project. 

• Initial values can be left blank, a numeric value, or a string value. 

• Initial values are based on the tag's type. For example, a BOOL tag may 
have an initial value of either On/True (non-zero) or Off/False (zero). 

• Initial values can contain constants such as PI and E. 

• Validation is dependent upon the device driver used with this project and 
the memory address assigned. 

• Validation will occur when you select the OK button or the New Tag icon 
on the Edit Tag dialog. 

If nothing is specified in the initial value field, the address is read and the tag is 
initialized with that value. 

For more information, see Checking Tag Data for Errors. 

Description Select this field to enter a description of the tag. For system tags, this field provides a 
brief description of the tag's functionality. 

The Description field has an 80 character maximum limit. 

More information about individual system tags is available in the System Tag 
reference. 

Item Description
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Deleting Tags 

To delete tag information: 

1 Select the tag you want to delete in the Tag Editor. 

2 Select the Delete command from the Tags menu. The tag is deleted 
from your project.

Note: Be sure you want to delete the tag. Unless the tag is referenced or 
in error, there is no prompt asking if you really want to delete it. However, 
if you accidently delete a tag, you can use the Undo command to restore it. 

Validating Tags 

The PFD validates tags as they are entered in the Designer. There are 
three types of tag validation:

• Tag syntax checking

• Control device address validation

• Initial value validation 

For tag expression rules and examples, refer to Tag Scaling. 

Icon Function Description

Create a New Tag Saves the current tag properties, then initializes the fields to 
create a new tag. 

Goto First Tag Displays the properties for the first tag in the Tag List. 

Goto Previous Tag Displays the properties for the previous tag in the Tag List. 

Goto Next Tag Displays the properties for the next tag in the Tag List. 

Goto Last Tag Displays the properties for the last tag in the Tag List. 
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Syntax Checking 

Tag syntax is checked at the time the tag is committed (or saved). This 
occurs any time you enter a tag in a tool or when using the Tag editor. You 
commit the tag for validation by selecting the OK button in the dialog box 
or by pressing the Enter key. Within the Tag Editor, the syntax is checked 
whenever you leave the Name field within the Edit Tag dialog box. 

The PFD checks for proper tag naming and expression syntax. Tag naming 
rules are listed below: 

• The first character must be a letter. 

• Names can have a maximum of 32 characters. 

• Names can contain alphanumeric characters and underscores. 

If a tag syntax error is detected, a message is displayed on the address fly-
out for the object that indicates what the error is, and the cursor is placed 
within the entry field at the point where the error was encountered. 

For any tag syntax error, an icon appears over the tool in error. If entering 
the tag through the Edit Tag dialog, the Tag editor cannot be saved and 
closed if the address contains a syntax error. 

Control Device Address Checking 

The format of a tag address is validated whenever you try to commit (or 
save) the tag. The PFD checks for proper control device validation 
dependent upon the addressing rules for the particular control device. 

On the PFD device, if an error is detected in a tag address, an icon appears 
in the status column of the Tag Editor. 

To determine the addressing rules for a particular driver, refer to the online 
help for the driver of interest. 

Tag Initialization 

Initial value validation occurs when you commit the tag within the Edit Tag 
dialog. The PFD checks the initial value against the Data Type selected. If 
the Data Type is set to default, the initial value remains what the user 
entered. If the initial value is within range for the specified data type, the 
PFD retains the value. If the initial value is out of range for the specified 
data type, the field changes to blank. 

If an initial value is specified, it is written to the tag when the PFD is first 
connected, unless the tag is read only. If an initial value is not specified, 
the PFD initializes the tag to the value stored in the control device at 
startup. 

Additional initial value rules are listed below: 

• The initial value for local tags is 0 or empty. 
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• The default initial value of any tag is blank. 

• Blank initial values will remain blank if you change the data type. 

• Initial values you set to 0 will remain 0 if you change the data type. 

The following table shows some examples of tag initialization. 

Initial Data Transfers 

Upon entering runmode, if the Perform Initial Data Transfers option is 
checked in the Runtime Settings menu, then the data currently at the 
referenced address is read from the controller when the PFD is first 
connected. If the Perform Initial Data Transfers option is not selected, then 
no read transfer will occur upon the PFD first entering runmode. 

After initially entering runmode, read data will only be transferred to the 
PFD unit upon a data change in the control device.

Using System Tags

The following is a description of tags supplied with the PFD. The tags are 
listed in alphabetical order, tags that are highlighted are available on the 
local client only. 

Name Address Initial Value Result

Tag2 K2 * 2 25 Tag2 will initialize to the value of K2*2 and not to 
25. 

Tag6 empty 0 Tag6 will initialize to 0 (or empty if a string). 

Tag Description

_Alarm_AckAlarms Use this system tag to acknowledge all alarms, except those 
requiring individual acknowledgment, in the Alarm Summary. 

Type: Boolean

Initial Value: FALSE

Access: Read/Write

_Alarm_AckCount Use this system tag to display the number of alarms that have been 
acknowledged. 

Type:  UInt

Initial Value: 0

Access: Read Only 
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_Alarm_ActiveCount Use this system tag to display the number of alarms currently active. 

Type: UInt

Initial Value: 0

Access: Read Only 

_Alarm_AudibleControl Use this system tag to enable and disable the audible alarm tone. 

Type: Boolean

Initial Value: TRUE

Access: Read/Write 

_Alarm_BackupLog Use this system tag to initiate the backup operation of all logs.

Type: Boolean

Initial Value: FALSE

Access: Read/Write

_Alarm_ClearAlarms Use this system tag to remove the inactive alarms. Those requiring 
acknowledgment must be highlighted before being removed. 

Type: Boolean

Initial Value: FALSE

Access: Read/Write 

_Alarm_HighestPriority Use this system tag to indicate the highest priority (1-5) of all active 
alarms. 

Type: UInt

Initial Value: 0

Access: Read Only 

_Alarm_LoggingControl Use this system tag to enable and disable alarm logging. This tag 
also allows you to set the initial values. 

Type: Boolean

Initial Value: TRUE

Access: Read/Write 

_Alarm_LogMessage Use this system tag to write a message to the alarm log. 

Type: String

Initial Value: N/A

Access: Read/Write 

Tag Description
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_Alarm_UnackCount Use this system tag to indicate the number of alarms that have not 
been acknowledged, both active and inactive. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_DeviceAcknowledge Use this system tag to reflect the current state of the 
_HMI_DeviceWatchdog system tag. 

Type: Boolean

Initial Value: 0

Access: Read only 

_HMI_DeviceDay Use this system tag to display the current day of the week while in 
run mode. For example if today is July 19, 2009, the tag contains 19. 
The tag reads the day from the assigned device location. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_DeviceHour Use this system tag to display the current hour while in run mode. 
For example if the time is 4:19 PM, the tag contains 04. The tag 
reads the hour from the assigned device location. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_DeviceMinute Use this system tag to display the current minute while in run mode. 
For example if the time is 4:19 PM, the tag contains 19. The tag 
reads the minute from the assigned device location. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_DeviceMonth Use this system tag to display the current month while in run mode. 
For example if today is July 19, 2009, the tag contains 07. The tag 
reads the month from the assigned device location. 

Type: UInt

Initial Value: 0

Access: Read only 

Tag Description
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_HMI_DeviceSecond Use this system tag to display the current second while in run mode. 
For example if the time is 04:19:23, the tag contains 23. The tag 
reads the seconds from the assigned device location. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_DeviceTimeoutError Use this system tag to indicate that the system tag _HMI_DeviceAck 
did not reflect the expected state within the time-out period. 

Type: Boolean

Initial Value: 0

Access: Read/Write 

_HMI_DeviceTimeSync Use this system tag to set the server time/date to values read from 
the assigned device time/date system tags when TRUE. 

Type: Boolean

Initial Value: FALSE

Access: Read/Write 

_HMI_DeviceWatchdog Use this system tag to monitor a specific device input. This tag 
toggles the state of a bit at a specified rate. 

Type: Boolean

Initial Value: 0

Access: Read/Write 

_HMI_DeviceYear Use this system tag to display the current year while in run mode. 
For example if today is July 19, 2009, the tag contains 2009. The tag 
reads the year from the assigned device location. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_Exit Use this system tag to exit your run mode session. 

Type: Boolean

Initial Value: FALSE

Access: Read/Write 

Tag Description
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_HMI_ProjectName Use this system tag to assign a project name to your application.

Type: Boolean

Initial Value: FALSE

Access: Read/Write 

_HMI_RegionCode Use this system tag to change the region settings (including 
language) to the specified region code.

Type: DINT

Initial Value: 0

Access: Read/Write 

_HMI_SystemDay Use this system tag to display the day of the week while in run 
mode. For example if today is July 19, 2009, the tag contains 19. 
The tag reads the day from the settings in your run mode 
workstation. 

Type: UInt

Initial Value: 0

Access: Read only

_HMI_SystemHour Use this system tag to display the hour while in run mode. For 
example if the time is 4:19 PM, the tag contains 04. The tag reads 
the hour from the settings in your run mode workstation. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_SystemMinute Use this system tag to display the minute while in run mode. For 
example if the time is 4:19 PM, the tag contains 19. The tag reads 
the minute from the settings in your run mode workstation. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_SystemMonth Use this system tag to display the month while in run mode. For 
example if today is July 19, 2009, the tag contains 07. The tag reads 
the month from the settings in your run mode workstation. 

Type: UInt

Initial Value: 0

Access: Read only 

Tag Description
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_HMI_SystemSecond Use this system tag to display the seconds while in run mode. For 
example if the time is 04:19: 23, the tag contains 23. The tag reads 
the seconds from the settings in your run mode workstation. 

Type: UInt

Initial Value: 0

Access: Read only 

_HMI_SystemYear Use this system tag to display the year while in run mode. For 
example if today is July 19, 2009, the tag contains 2009. The tag 
reads the year from the settings in your run mode workstation. 

Type: UInt

Initial Value: 0

Access: Read/Write

_InputList_SendByName Use this system tag to send the specified Input List to the device. 

Type: String

Initial Value: N/A

Access: Read/Write 

_InputList_SendByNumber Use this system tag to send the specified Input List to the device.

Type: Fine Integer

Initial Value: N/A

Access: Read/Write 

_Panel_BackPanel Use this system tag to display the last panel loaded in the Runtime 
environment. When the new panel opens, the current panel closes. 

Type: Boolean

Initial Value: FALSE

Access: Read/Write 

_Panel_CurrentPanel Use this system tag to hold the index number of the current panel 
displayed in the Runtime environment. 

Type: UInt

Initial Value: 0

Access: Read only 

Tag Description
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_Panel_GoToPanel Use this system tag to jump to another panel in the Runtime 
environment. When the new panel opens, the current panel closes. 

Type: UInt

Initial Value: 0

Access: Read/Write 

_User_LogOff Use this system tag to log the local user off of the project while in 
Runtime. The log on page is displayed.

Type: Boolean

Initial Value: FALSE

Access: Read/Write 

_User_LogOn Use this system tag to initiate the log on popup, allowing the 
operator to log on to the Runtime machine. 

Type: Boolean

Initial Value: FALSE

Access: Read/Write 

_User_UserLevel Use this system tag to display the user level number assigned to the 
local user. 

Type: Integer

Initial Value: 0

Access: Read only 

_User_UserLevelName Use this system tag to display the user level name assigned to the 
local user. This is the name set on the User Administration page.

Type: String

Initial Value: N/A

Access: Read only 

_User_UserName Use this system tag to display the user name assigned to the local 
user. This is the name set on the User Administration page. 

Type: String

Initial Value: N/A

Access: Read only 

Tag Description
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Using expressions

When creating tags in the PFD, you can assign expressions to the address. 
An expression is a combination of functions, operators and other tags. A 
function is a pre-coded process that generates values for your expression. 
An operator indicates the action to perform on the number or tag.

For more information on using expressions, refer to the following:

• Accessing Operators and Functions 

• General Information on expressions 

• Available Functions and Operators

• Expression Errors

Accessing Operators and Functions

You can access all functions, operators, expressions, and tags from any 
dialog box where you enter an address. Simply select the appropriate icon 
on the dialog box to display a drop-down list. The expression icons 
displayed in the PFD are described below. 

_User_UserRegionCode Use this system tag to display the region code assigned to the logged 
on user.

Type: DINT

Initial Value: 0

Access: Read only

Property Description

Tag List Drops down a list of tags currently used in the project. You can 
select a user-defined tag or a system tag. Tags are listed in 
alphabetical order, user-defined tags followed by System Tags. 

Functions & 
Operators 
List

Drops down a list of available functions and operators for 
mathematical, logical, and relational expressions. 

Tag Description
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General Information on expressions 

Listed below are the general rules regarding expressions. 

• An expression can contain; tags, numbers, operators, and functions. 

• Spaces within expressions are ignored. 

• The Boolean value True will be evaluated as 1, and False will be 
evaluated as 0. 

• For bitwise manipulations Booleans are treated as if they are single bit 
values. 

• expressions are case insensitive. 

• Trigonometric functions are evaluated using degrees. 

• Supported constants in expressions are; TRUE, FALSE, E, and PI 

Available Functions and Operators

This section describes the following functions and operators available:

• Functions 

• String Functions

• Mathematical Operators

• Relational Operators

• Logical Operators

• Constants

• Order of Precedence 

You can access all operators by selecting the Operators and Functions icon 
located on any screen where you enter an address. 

Functions
The equations in the Functions table are based on the following graphic.

Recent 
expressions 
List

Drops down a list of the 10 most recently entered tags, 
expressions, and control device addresses. Select an item in 
the list to reuse it for the tag assignment. 

Property Description
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Symbol Example Description

SIN(x) SIN(b)=o/h Generates the sine of value x. 

COS(x) COS(b)=a/h Generates the cosine of value x. 

TAN(x) TAN(b)=o/a Generates the tangent of value x. 

ASIN(x) ASIN(o/h)=b Generates the arc sine of value x. This is also known 
as the inverse of sine. 

ACOS(x) ACOS(a/h)=b Generates the arc cosine of value x. This is also 
known as the inverse of cosine.

ATAN(x) ATAN(o/a)=b Generates the arc tangent of value x. This is also 
known as the inverse of TAN. 

LOG(x) LOG(tag) Generates the natural base logarithm of the value x. 

LOG10(x) LOG10(tag) Generates the base-10 logarithm of the value x. 

EXP(x) EXP(tag); EXP(2) Generates the natural exponential of irrational 
number e (approximately 2.718281) by raising it to 
the power of x. 

ABS(x) ABS(tag); ABS(-2) Generates the absolute value of x. 

SQRT(x) SQRT(tag); SQRT(2) Generates the square root of value x. 

POW(x, y) POW(tag1, tag2); 
POW(tag1, 2) 

Raises value x to the power of value y. 

RAD(x) RAD(tag); RAD(2) Converts degrees (value x) to radians. 

DEG(x) DEG(tag); DEG(2) Converts radians (value x) to degrees. 
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String Functions

Note: In the above examples, assume strString = "Parker Automation". 
Also assume strTrim = " PFD ", (there are 3 spaces on either side of the 
string tag strTrim).

Symbol Example Description

LEFTSTRING(string,Num
berOfCharacters) 

LEFTSTRING(strString,4) Returns "Park". See note.

MIDSTRING(string,Start
Position, 
NumberOfCharacters) 

MIDSTRING(strString,2,5) Returns "arker" . See note.

RIGHTSTRING(string,Nu
mberOfCharacters)

RIGHTSTRING(strString,3) Returns "ion" . See note.

STRLEN(string) STRLEN(strString) Returns 17. See note.

TRIMLEFT(string) TRIMLEFT(strTrim) Returns "PFD ". No spaces to the left of 
the string but keeps the spaces to the 
right. See note.

TRIMRIGHT(string) TRIMRIGHT(strTrim) Returns " PFD". No spaces to the right of 
the string but keeps the spaces to the left. 
See note.
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Mathematical Operators 

Relational Operators 

Logical Operators 

Symbol Example Description

+ tag1 + tag2 Addition - sums the left and right values. 

- tag1 - 45 Subtraction - subtracts the right value from the left 
value. 

* tag1 * 2.45 Multiplication - multiplies the left and right values.

/ tag1 / 100 Division - divides the left value by the right value. 

% tag1 % 3 Modulus - returns the remainder of the division of 
the left value by the right value. 

<< tag1 << 4 Bit shift left - shifts the bits of the binary value to the 
left, by the number of times specified by the right 
value. 

>> tag1 >> tag2 Bit shift right - shifts the bits of the binary value to 
the right, by the number of times specified by the 
right value. 

Symbol Example Description

< tag1 < 50.5 Less Than — TRUE if the left value is less than the 
right value. 

<= tag1 <= tag2 Less Than or Equal To — TRUE if the left value is less 
than or equal to the right value. 

> tag1 > tag2 Greater Than — TRUE if the left value is greater than 
the right value. 

>= tag1 >= 50.5 Greater Than or Equal To — TRUE if the left value is 
greater than or equal to the right value. 

== tag1 == tag2 Equality — TRUE if the left value is equal to the right 
value.

!= tag1 != 0 Does Not Equal — TRUE if the left value does not 
equal the right value. 

Symbol Example Description

&& (Tag1 > 2) && (Tag1 < 3) Logical And — Compares two values or expressions. 
The result is one only if both values are non-zero. 

|| 0 || Tag1 Logical Or — Compares two values or expressions. 
The result is one if one of the two values is non-zero. 

! ! (Tag1 < 5) Logical Not — Changes a non-zero value to a zero, 
and changes a zero value to a non-zero. 
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& Tag1 & 12 

Result: If Tag1 = 5

Bitwise And — Compares two operands bit by bit. 
The resulting bit is one only if both bits in the 
operands are one. 

| Tag1 | 12 

Result: If Tag1 = 5 

Bitwise Or — Compares two operands bit by bit. The 
resulting bit is one if one of the two bits in the 
operands is one. 

^ Tag1 ^ 12 

Result: If Tag1 = 5 

Bitwise Exclusive Or — Compares two operands bit 
by bit. The resulting bit is one if one of the two bits 
(but not both) in the operands is one. 

~ ~Tag1 

Result: If Tag1 = 5

5 in binary: 0101 therefore 
the result is 1010. 

Bitwise Not — Changes each one to a zero and each 
zero to a one. 

Symbol Example Description
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Constants 

Order of Precedence 
The precedence of operators determines the order in which operators are 
evaluated in an expression. Anything in parenthesis ( ) is evaluated first. 
For example, 

Symbol Example Description

_CONST_E E + 2 

Result: 4.718281. 

Natural exponential function — The value of E is 
approximately 2.718281. 

Returns the constant value of E. E is the natural 
logarithmic base used in mathematical equations to 
compute, among other things, compound interest 
and statistical bell curves. 

Use this tag in the Address field of the Tag Editor as 
part any mathematical equations you need. 

Type: LREAL

Initial Value: 2.718281828

Access: Read only 

_CONST_PI PI + 3 

Result: 6.141592. 

Pi— The ratio of the circumference to the diameter of 
a circle. Approximately 3.141592. 

Returns the constant value of pi. Pi is the ratio of the 
circumference of a circle to its diameter. 

Use this tag in the Address field of the Tag Editor as 
part any mathematical equations you need. 

Type: LREAL

Initial Value: 3.141592654

Access: Read only 

FALSE FALSE 

Result: Address reference 
is set to FALSE or zero. 

Returns a constant value of FALSE. In Boolean, False 
= 0.

Type: Boolean

Initial Value: FALSE

Access: Read only 

TRUE TRUE 

Result: Address reference 
is set to TRUE or one. 

Returns a constant value of TRUE. In Boolean,  
True = 1. 

Type: Boolean

Initial Value: TRUE

Access: Read only 
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2 * 3 + 4 = 10

but with added parenthesis, the expression is evaluated differently: 

2 * (3 + 4) = 14 

The following table lists the order of precedence, with the topmost operator 
evaluated first: 

Expression Errors

If there is an error in your expression, an error message is displayed on 
the address flyout, indicating what the error is, and the cursor is placed 
within the entry field at the point where the PFD encountered the problem. 

Errors will be shown for: 

Incorrect expression syntax such as: An equal sign as the first operator in 
the expression. For example: '= 10 + Tag1' 

• Unsupported operators or functions. 

• Consecutive use of two operators without the use of parentheses. 

• Excluding the value in the function: 'SIN( )' 

Within the Tag Editor errors will be shown for circular references, write 
scaling, and scaling of direct addresses. Examples are shown in the tables 
below. 

Circular references in scaling expressions 
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Write Scaling 

Scaling a direct address 

Using Data Types

A data type determines the type value of the tag. The PFD supports IEEE 
single precision floating point and double precision floating point numbers. 

Some additional rules used with data types are listed below. 

• All Strings are NULL terminated. 

• The Default data type is determined by the device driver selected for 
this project. 

• The data type field is validated when you select the OK button or by 
clicking off of the Edit Tag dialog. 

• Tag arrays, as well as Bytes, Words, and DWords are not supported. 

The table below describes each available data type and lists its size and 
range of value. 
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Tag Scaling

Tag scaling is the adjustment of a value using functions or expressions. 
There are two types of scaling, input (or write) scaling and output (or read) 
scaling. 

General Information on Scaling 

As you are working with the tools, you can create new tags from any input 
tool menu. Those tags are then automatically added to the Tag Editor and 
accessible to the rest of your project. All tags that you create from within 
the tools appear on the Tags drop-down list in the Edit Tag screen. 

Note that you cannot directly reference a device address in your 
expressions. Instead, you must create a tag in the Tag Editor and assign it 
to the device address. Then you can reference that tag in the tool. 

Input/Write Scaling

Write scaling is performed on the data value of a tag tied to an input tool. 
When you scale a tag value in an input tool, use a question mark (?) as the 
identifier for the input. 

Input scaling takes the form of mathematical equations. For example: 
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Tag1 = Tag2 + ? 

• The question mark ( ? ) is the identifier for the input to the tool. This 
represents where the tool writes the value. 

• Question marks are valid for input tools only. 

• You can have multiple question marks in an expression. 

• Values are updated only when the input changes, not when any tags in 
the expression change. This differs from the Tag Editor, where a write 
is performed when tags in the expression change. 

• Expressions must be read/write. In other words, you must use a 
question mark whenever you use an expression (that is, perform input 
scaling) in an input tool. 

• You can still specify a tag only (that is, without an expression and 
without scaling) in an input tool. 

Output/Read Scaling

Read scaling is performed on the data value of a tag tied to an output tool. 
Output scaling does not require the question mark, since there is no input 
identifier necessary for output tools. 

Output scaling does not use equal signs, either. An output scaling example 
may look like the following: 

Tag1 + Tag2 

• You can use constants in your output tool expressions. 

• You cannot use question marks with output tools. 

• Equals signs ( = ) are not valid in output tools. 

Additional Scaling Information

• You can use expressions to scale tags, both input scaling and output 
scaling, directly within the tag fields of input tools configuration menu.

• With input scaling, you must use the following format: MyTag = 
expression . With output scaling, you simply use the expression . 

• You cannot directly address PFD COMMServer addresses at the tool 
level. For example, 2 * channel1.device1.m1 is not allowed. You can 
create a tag with the address channel1.device1.m1, and then scale 
using that tag name such as 2 * <tagname>. 

• Equals signs ( = ) in an input scaling expression tell the application 
where to write. When you use an equals sign, you must specify a value 
to the left of it. 

• There are two things you cannot specify on the left of an equals sign: 
question marks and constants. 
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• You can create new tags in the tools. They will be automatically added 
to the Tag Editor. However you can only use existing tags on the left of 
an equals sign in an expression. 

• You can click the tag field then select the function or operator using the 
same icons that are available in the Edit Tag dialog. Selecting these 
icons lists the expressions, operators, functions, and all user and 
system tags available in your application. 

• If there is an error in your expression, it will appear in red in the Tag 
Editor. 

Examples 

• Some valid scaling examples for write scaling (input tools) are

•tag1 = ? + CONST_PI 

•tag1 = tag2 + ? 

•tag1 = sin(?) 

• The expression tag1 = ? tells the application to take the input of the 
tool and write it to tag1. 

• Specifying tag1 in an input tool is the same as specifying the 
expression tag1 = ? . 

• The expression = ? is not valid. You must specify a value to the left of 
the equals sign so that the application knows where to perform the 
write. 

• In the expression tag1 = ? , tag1 cannot be a constant. 

• Some valid scaling examples for read scaling (output tools) are:

•2 * Tag1 

•(Tag2 > 5) * 500 + Tag3 

•Sin(Tag4) 

•Tag2 && Tag3 

• For example, a Numeric Display tool has a Display Output assignment 
of '2 * Tag1'. Tag1 exists in the Tag Editor as a tag with the address 
assignment 'channel1.device1.m1'. When the value of the memory 
address m1 changes on the device, then the scaling expression is 
evaluated and the result of '2 * Tag1' will be displayed on the Numeric 
Display tool. 

• A second example is if a Numeric Display tool has a Display Output 
assignment of 'Tag2'. Tag2 exists in the Tag Editor as a tag with the 
address assignment '2 * Tag1'. Tag1 exists in the Tag Editor with the 
address assignment 'channel1.device1.m1'. When the value of the 
memory address m1 changes on the device, then the scaling 
expression is evaluated and the result of '2 * Tag1' will be sent to Tag2. 
Tag2's value will be displayed on the Numeric Display tool. 
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Tag Rules

The following topic outlines the rules for addressing local tags and tags tied 
to a controller address.

Local Tags 

A local tag reference virtual memory locations on your Runtime 
workstation. This type of tag is not connected to a controller and is not 
retentive. 

Rule 1 
To assign a tag, constant, or expression to another tag, simply enter the 
tag, constant, or expression in the Address field. 

Rule 2 
To assign a tag, constant, or expression to another tag without having a 
reciprocal relationship between them, use the equals sign (=). 

Important: Values on the right of an equals sign are assigned to what is 
on the left of the equals sign. However values written to the left of the 
equals sign will not be assigned to what is on the right of the equals sign. 

Name Address Type
Initial 
Value Result

Tag1 Tag2 Default The value of Tag2 is assigned to Tag1. When 
Tag2 changes, Tag1 changes to match. 
Whenever Tag1 changes, Tag2 changes to 
match as well. 

Name Address Type
Initial 
Value Result

Tag1 =Tag2 Default The value of Tag2 is assigned to Tag1. When 
Tag2 changes, Tag1 changes to match. 
However, when Tag1 changes, Tag2 does not 
change to match. 
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Rule 3 
To set the Access to Read Only, do not use the equals sign in an expression 
in the Address field.

Rule 4 
To set the Access to Read/Write, use the equals sign in an expression in 
the Address field. 

Rule 5 
You cannot assign a tag to itself. 

Name Address Type
Initial 
Value Result

Tag1 Tag2+Tag3 Default Keep Rule 2 in mind. When Tag2 and Tag3 
change, their sum is assigned to Tag1. 
However, if Tag1 changed, then Tag2 and 
Tag3 would also have to change. We cannot 
determine how Tag2 and Tag3 should 
change to accommodate a new value in 
Tag1. Therefore, the Access of Tag1 is 
automatically set to Read Only. In this case 
you would receive a write error symbol over 
the tool that is assigned to Tag1. 

Name Address Type
Initial 
Value Result

Tag1 =Tag2+Tag3 Default Keep Rule 2 in mind. When Tag2 and Tag3 
change, their sum is assigned to Tag1. And 
because the expression falls to the right of 
the equals sign, Tag1 can change without 
having to reciprocate that change in Tag2 
and Tag3. Therefore, the Access of Tag1 is 
automatically set to Read/Write. There will 
be no change in Tag2 or Tag3. 

Tag1 Tag2=Tag3 Default If Tag3 changes, both Tag1 and Tag2 will 
change to match. If Tag2 changes, Tag1 
changes to match, but Tag3 does not 
change because Tag3 appears to the right of 
the equals sign. And if Tag1 changes, Tag2 
changes to match, but Tag 3 does not 
change. The Access of Tag1 remains 
Read/Write. 

Name Address Type
Initial 
Value Result

Tag1 Tag1 Default Causes a Circular Reference error. 

Tag1 =Tag1 Default Causes a Circular Reference error. 
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PFD COMMServer Tags 

The hardware addresses in the examples below use the syntax ch1.d1.k1 , 
where ch1 represents the Channel, d1 represents the Device, and k1 
represents the memory address. 

Rule 1 
When directly addressing a controller you must assign a hardware address 
to the tag. 

Rule 2 
You can assign tags to hardware addresses in the Address field. The equals 
sign functions the same regardless if a local or COMMServer tag. 

Rule 3 
You can only assign hardware addresses to other hardware addresses. 
Furthermore, if you are using a hardware address to the right of an equals 
sign, you must place the hardware address in single quotes. 

Name Address Type
Initial 
Value Result

Tag1 ch1.d1.k1 Default The value of ch1.d1.k1 is assigned to Tag1. 
When ch1.d1.k1 changes, Tag1 changes to 
match. Whenever Tag1 changes, ch1.d1.k1 
changes to match as well. 

Name Address Type
Initial 
Value Result

Tag1 ‘ch1.d1.k1’=Tag2 Default If the value at Tag2 changes, the new 
value is assigned to both ch1.d1.k1 and 
Tag1. 

If ch1.d1.k1 changes, Tag1 changes to 
match, but Tag2 does not change. If 
Tag1 changes, ch1.d1.k1 changes to 
match, but Tag2 does not change. 

Name Address Type
Initial 
Value Result

Tag1 'ch1.d1.k0'='ch1.d1.k1'+Tag2 Default If the value at ch1.d1.k1 changes, 
the new value is added to Tag3 
and then assigned to both 
ch1.d1.k0 and Tag1. 

If Tag1 changes, ch1.d1.k0 
changes to match, but ch1.d1.k1 
and Tag3 do not change. 

If ch1.d1.k0 changes, only Tag1 
changes to match. 
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The Alarm Editor is a powerful feature of the Parker Factory Display (PFD). 
It allows you to monitor various events on the Runtime device. When you 
run your project, the PFD continuously monitors the tags for out-of-
tolerance (alarm) conditions. When the alarm condition you define goes 
TRUE, the alarm triggers. When the alarm is triggered, you can: 

• alert the operator

• provide information on the alarm condition

• allow the operator to acknowledge the alarm

• instruct the operator to take corrective action

In the Alarm editor, you can set different priority levels for each alarm or 
choose to group alarms together by priority. You can setup how the alarm 
is cleared, if it is audible or not, and how long the alarm is active. You can 
also log the alarm events to a file. 

The Alarm editor is accessed through the Continuous Improvement tab 
within the PFD designer. 

For more information on setting up alarms and using the Alarm editor, 
refer to the following:

• Alarm Editor Display

• Alarm Editor Menu

• Creating Alarms 

• Alarm Viewer Tool
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Alarm Editor Display 

The Alarm editor displays the defined alarms and their triggers. You can 
define a total of 999 alarm conditions. The Alarm editor is shown below. 

Notice that the Alarm editor contains a status line located at the bottom of 
the screen. The status area displays the number of alarms currently 
defined, as well as the values for the highlighted alarm. 
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Alarm Editor Menu

The following table briefly describes the menu options available in the 
Alarm editor. 

Setting Up Alarm Properties

Using the General Setup, you can define how an alarm is cleared, if it is 
audible or not, how long the alarm is active, as well as the time format. 

Select General Setup from the Alarms menu. The General Setup menu is 
displayed. 

The following table describes the alarm properties available from the 
General Setup menu. 

Menu Item Description

General Setup Under the General Setup menu you can define the following: 

• how alarms are cleared

• if an alarm is audible

• how long an alarm is active

• the displayed time format 

Groups Allows you to organize the alarms into logical groups. The Group menu is 
displayed with a listing of groups replacing the Alarm editor view. When a 
group in the grid is highlighted, the properties in the Group menu contain 
values that belong to the selected group. 

Priorities Allows you to change how a certain alarm priority is displayed in the alarm 
viewer. For example, you can define the color of a displayed alarm with an 
urgent priority, or have an alarm with a warning priority sound an audible tone. 
The Priority menu is displayed with a listing of priorities replacing the Alarm 
editor view.

File Logging Allows you to define what alarms you want to log. The File Logging menu is 
displayed. 

New Alarm Allows you to add an alarm. The Edit Alarm screen is displayed which allows 
you to define the alarm condition. For more information on defining alarms, 
refer to Creating Alarms.

Edit Alarm Allows you to edit an alarm. The Edit Alarm screen is displayed which allows 
you to change the alarm values. For more information on defining alarms, refer 
to Creating Alarms.

Delete Deletes the selected alarm. 
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Creating Alarm Groups

You can organize alarms together to create logical groups. Groups let you 
separate alarms into sets that share something in common such as: 

• All alarms on the same machine 

• All alarms of a given priority 

• All alarms related to the same process or function 

A typical use is to assign the alarms from each machine into separate 
groups. During Runtime, the operator can enable or inhibit an entire group 
of alarms at once. For example, this allows you to disable all of the alarms 
pertaining to a machine when that machine is taken off-line for 
maintenance. 

Note: Alarms not assigned to a group are automatically assigned to the 
default group Global. A group can contain alarms of different priorities. 

To setup an alarm group, select Groups from the Alarms menu. The Group 
menu and list is displayed as shown below. 
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The following table describes the properties available from the Group 
menu. 

Property Description

Name Enter or edit the group name. There are a few restrictions as to what can 
appear in the Name field:  

• Names can have up 32 characters. 

• The first character must be a letter. 

• Names must contain only alphanumeric characters and 
underscores (_). 

• The field cannot be empty. 

Enable at Startup When checked, the alarm group is enabled when you run the application. 

If this option is checked, each time you run the application, alarms assigned to 
the selected group are either enabled or inhibited depending on each individual 
alarm's Enabled at Startup property. 

If this options is not checked, each time you run the application, alarms 
assigned to the selected group are inhibited regardless of the setting of the 
individual alarm's Enabled at Startup property. 

This option is checked by default. 
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Setting Alarm Priorities

You can assign one of five different priority levels for an alarm. Priority 1 is 
the lowest priority and 5 is the highest. You can assign names to the 
priority levels to provide the operator with useful information. The priority 
name is optional and can be up to 32 characters long. The default names 
are shown below.

The priority number is used when you run the application to display and 
acknowledge alarms. For example, you can force an operator to 
acknowledge all priority 5 alarms individually instead of all at once. 

To set a priority for an alarm, select the Priorities property from the 
Alarms menu. The Priority menu and list are displayed as shown below:

New Group Allows you to add an alarm group. A new group is added with a default name 
of Group001. To change the name, highlight the new group and select the 
Name property. 

Delete Deletes the selected alarm group. You can use the Undo command to recover 
the last deleted group. 

Property Description
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Highlight a row in the Priority list and the menu changes to reflect the 
current settings for that priority level. The following table describes the 
properties available from the Priority menu. 

Property Description

Name Enter or edit the priority name. There are a few restrictions as to what can 
appear in the Name field:  

• Names can have up 32 characters. 

• The first character must be a letter. 

• Names must contain only alphanumeric characters and 
underscores (_). 

• The field cannot be empty. 
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Logging Alarm Events

You can setup a log file to capture all alarm events triggered during a 
certain time period. 

To setup a log file, select File Logging from the Alarms menu. The File 
Logging menu is displayed. The following table describes the menu items 
on the File Logging menu.

Acknowledgement You can allow the operator to acknowledge all alarms at once or choose to 
have the operator acknowledge each alarm individually. 

All Alarms: Select this option to acknowledge all alarms of the selected 
priority with a single press of the Acknowledge button. 

Individual Alarms: If you select this option, you must select each alarm in 
the Alarm Summary viewer before you press the Acknowledge button. 

You may want to configure individual Acknowledgment for critical alarms. This 
forces the operator to examine each alarm before acknowledging it. For 
example, set:  

• Priorities 1 through 4 for All Alarms. 

• Priority 5 for Individual Alarm. 

Note: To setup an Acknowledge button for individual alarms, use the 
AckSelectedAlarm connection point. For more information on using 
connections, see Creating Connections to the Alarm Viewer Tool on page 
10-14.

User Level You can assign an acknowledgment User Level to each priority. Use this feature 
to prevent unauthorized personnel from acknowledging high priority alarms. 

Normal Color Select the color the alarm has in its normal or active state when displayed in 
the Alarm viewer. 

Inactive Color Select the color the alarm has in its inactive state. 

Annunciate Color Select the color the alarm has if the alarm is triggered. 

Beep to Annunciate You can opt to have an alarm beep to alert the operator. A checkmark is 
displayed showing that this is turned on. Select it again to turn it off. 

Blink to Annunciate You can opt to have an alarm blink in the Alarm viewer. A checkmark is 
displayed showing that this option is turned on. Select it again to turn it off. 

Property Description
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Creating Alarms 

Alarms allow you to monitor various events on the Runtime device. When 
you run your project, the PFD continuously monitors the tags for out-of-
tolerance (alarm) conditions. When the alarm condition that you specify 
goes TRUE, the alarm triggers. You can define a total of 999 alarm 
conditions. 

Use the Alarm editor to setup alarms for your project. You can also import 
and export alarm definition files, for more information, see Importing and 
Exporting Tags and Alarm Definitions.

To create alarms in your project:

1 From the Project editor, select the Alarms tab. The Alarm editor is 
displayed. 

2 To add or edit an alarm: 

The following table describes the properties on the Edit Alarm screen. 

If you want to... Then...

Add a new alarm Select New Alarm from the Alarm editor menu. 
The Edit Alarm screen is displayed as shown 
below.

Edit an existing alarm Highlight an alarm and select Edit Alarm from 
the Alarm editor menu or you can highlight the 
alarm and double-click on it. The Edit Alarm 
screen is displayed as shown below.
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The Parker Factory Display checks for illegal tag names, improper data, 
etc. If an error is found, that field is skipped. As each field is checked, the 
status field is left blank in the Alarm editor for any fields found in error. 

Property Description

Description Enter the name of the alarm condition, you can use up to 256 
characters. The default name is Alarm001. If Alarm001 already 
exists, then the new name is Alarm002, and so on. 

Alarm 
Trigger

Enter a tag or an expression that when its condition is TRUE in 
Runtime, the alarm is active (or triggered). For example:

Priority Select a priority level for this alarm condition. You can choose 
between five different priority levels: Notice, Warning, Alert, 
Urgent, and Critical.

Group Select an alarm group. You can organize alarms into different 
groups, such as all notice level alarms. Before you can select a 
group, you must first define it. Refer to Using the Alarm Editor 
for more information on defining an alarm group. The default 
group is Global. 

Enable at 
Startup

When checked, the alarm is enabled when the project connects. 
If the alarm is initially disabled, you can enable it during 
Runtime. 

Alarm Value Select either Reference or Text. If Reference is enabled, a tag 
or expression can be entered during Runtime. 

If Text is enabled, you can instruct the operator to take 
corrective action. Enter a text message, up to 256 characters, 
in the blank field below the Alarm Value field. Whenever an 
alarm is triggered in Runtime, the text message is displayed in 
the Alarm Viewer.
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Alarm Viewer Tool 

Use the Alarm Viewer to display information on alarm conditions. You can 
view current alarm information as well as alarm history. You can also 
enable or disable alarms based on the alarm type you specify. 

The following table describes the properties available from the Alarm 
Viewer menu.

Property Description

Name Enter a unique name for the Alarm Viewer, up to 32 characters. Multiple Alarm 
Viewers can also share the same name. Names must start with a letter. 

The default name is AlarmViewer001, and increments by one with each new 
viewer added. 

Type Select the type of alarm data you want to view. 

Alarm Summary lets you view current alarm information in a variety of 
formats. You can acknowledge alarms, clear alarms, supply comments, and 
view detailed information on each alarm.

Alarm History provides you with logged history information including what 
time the alarm was triggered, the date the alarm was triggered, and so on.

Alarm Control lets you enable or inhibit alarms either individually or as a 
group.
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Fields Select the different fields you want to display in the Alarm Viewer. The fields 
available are based on the type of alarm data you want to display. The 
following is a list of fields available for each alarm type. 

Fields Available
Time On - Summary display
Time Ack - Summary display
Description - All display types
Priority - Summary and History display
Alarm Value - Summary and History display
Current Value - Summary display
Group - All display types
Time Off - Summary display
Date On - Summary display
Date Off - Summary display
Date Ack - Summary display
User - Summary and History display
Status - History display
Time - History display
Date - History display
Enabled - Control display

By default, all fields are displayed in the Alarm Viewer. Any checked item is 
displayed in its own column in the Alarm Viewer. Any field that is not checked is 
not displayed in the viewer. 

You can change the order of the displayed fields by highlighting them and 
using the up and down buttons at the bottom of the Fields pop up box. 

You can adjust the width of each field by using the sizing points displayed when 
the Alarm Viewer tool is selected as shown below. 

Appearance The appearance properties let you change the look of the Alarm Viewer. You 
can change the style, display area, header and grid color. For details on 
appearance properties, see Changing Tool Appearance. 

Accessibility The accessibility properties determine whether or not a tool is visible to all 
users during Runtime. For more information, refer to Changing Tool 
Accessibility.

Property Description
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Creating Connections to the Alarm Viewer Tool

Once you have created your alarm conditions, an Alarm Viewer Tool, and 
buttons on your panel, you need to create connections to your Alarm 
Viewer. Connections allow the Alarm Viewer Tool to talk to other tools on 
the panel. By adding buttons, indicators, and display tools on your panel, 
you can acknowledge, enable and disable, clear, and sort your alarms. 

The following connections are available for use with an Alarm Viewer tool. 
However, not all of the connections are available with each tool. Some 
connections are for use only with specific tools such as the Alarm Summary 
Viewer vs. an Alarm Control Viewer. 
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You can use the List editor to populate your input list with data items that 
correspond to a particular value sent to the control device. Input lists are 
similar to a recipe for the PFD device. You create a list of items that use 
analog, discrete, or string values to send all at once to the PFD device, 
rather than sending each value one at a time. 

You can setup a simple Button to send an input list to the PFD device, or 
you can use an Input List Viewer tool to display Input Lists to the operator 
and allow the operator to change values as needed. During Runtime, all of 
the Input Lists you define in your project are displayed in a Selection List 
popup tool.

For more information on using Input Lists and the List editor, refer to the 
following sections:

• List Editor Display

• Input List Menu

• Creating Input Lists

• Adding and Editing a List Item

• List Viewer Tool
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List Editor Display

The List editor displays the selected input list and all of the items currently 
in the list, as shown below. 

Each list item has a data value that is associated with it which corresponds 
to the type of data sent to the control device. You can have one of three 
data types:

• Analog: Sends an analog value to the PFD device. 

• Discrete: Sends a discrete value to the PFD device. 

• String: Sends a string value to the PFD device. 

Notice that the List Editor contains a status line located at the bottom of 
the screen. The status area consists of two lines of information. The first 
line displays the Send Value Input tag and it's corresponding value. The 
second line displays information according to the data type as shown in the 
table below. 
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Input List Menu

The following table describes the menu options available in the List editor. 
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Creating Input Lists

Input lists are similar to a to-do list for the PFD device. You create a list of 
items that use analog, discrete, or string values to send all at once to the 
control device, rather than sending each value one at a time. Use the List 
editor to populate your input list with data items that correspond to a 
particular value sent to the PFD device. 

To create an input list in your project

1 From the Project editor, select New > Input List from the menu.

2 Enter a name for the new input list. This name should relate to the 
type of list you are creating. 

3 Select the OK button in the Input List menu to accept the name and 
create the input list. 

4 Repeat steps 1 through 3 to create as many input lists as needed in 
your project. 

Whenever a new input list is created, by default the List editor is displayed. 
Use the List editor to add data items to your newly created input list. 

Notice that when you select the Project editor tab, the new input list is 
displayed in the Project workspace. You can either highlight the input list 
and select the List editor tab or double-click on the input list to return to 
the List editor. 
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Adding and Editing a List Item 

To add or edit a data item in the List editor:

1 From the Project workspace, either double-click the input list you 
want to add items to or highlight the list and select the List editor 
tab. 

The List editor is opened and the selected input list is displayed. For 
information on creating an Input List, refer to Creating Input Lists. 

2 Choose one of the following options. 

The Edit Input List Item screen is displayed as shown below.

The following table describes the properties on the Edit Input List Item 
screen. 

If you want to... Then...

Add a new data item Select New Item from the Input List menu 
to add a new data item to the input list.

Edit an existing data 
item 

Highlight a list item and select Edit Item 
from the Input List menu to edit the data 
item.

Property Description

Name Enter the name of the data item to add to your input list, you can use up to 15 
characters. The default name is ListItem001. If ListItem001 already exists, 
then the new name is ListItem002, and so on. 
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Send Value Input Enter a tag name that specifies a location where you want the data value to be 
written to when the input list is downloaded to the PFD device. The default 
value is blank. 

For more information on using tags, refer to Using the Tag editor. 

Data Value Choose between an analog, discrete, or string value. 

Analog: Sends a numeric value to the PFD device. When an analog data type 
is selected, the Minimum and Maximum Value boxes become active. The State 
0 and State 1 Label boxes remain greyed out. 

Discrete: Sends a discrete value (0 or 1) to the control device. When a 
discrete data type is selected, the State 0 and State 1 Label boxes become 
active. The Minimum and Maximum Value boxes remain greyed out. 

String: Sends a string value to the PFD device. The State 0 and State 1 Label, 
Minimum and Maximum Value boxes remain greyed out. 

Value Enter an appropriate value for the data type selected. 

Analog: Enter a numeric value that is written to an input address each time 
the list is downloaded to the PFD device. During Runtime, you can edit this 
value before sending the list to the PFD device. The value is then checked to be 
sure it falls within the minimum and maximum range before it is sent to the 
PFD device. You define these ranges by specifying the Minimum and Maximum 
values. The Value field can also accept E and PI for analog values. 

Discrete: Enter either 0 or FALSE for off and 1 or TRUE for on. 

String: Enter a string that is written to an input address each time the list is 
downloaded to the PFD device. During Runtime, you can edit the string value 
before sending the list to the PFD device. A cursor is displayed in the value 
field, where you can use either a keyboard or the Keyboard pop-up tool to edit 
the string. String values need to be in quotes. For example, "Hello". 

In order to edit and save any one of these values in Runtime before sending it 
to the PFD device, you need to setup connections to your input list. 

State 0 Label Enter the text you want to display when the discrete variable is 0 or Off. The 
field size for the label is 8 characters and the default value is Off. 

This option is only available when a discrete data type is selected. 

State 1 Label Enter the text you want to display when the discrete variable is 1 or On. The 
field size for the label is 8 characters and the default value is On. This option is 
only available when a discrete data type is selected. 

Minimum Value Enter the lowest value the operator can enter during Runtime. The value 
entered must be less than or equal to the Maximum Value, but greater than or 
equal to the Minimum Value. 

The default value is 0. If the field is left blank, it is set to 0. Negative values are 
acceptable. However, values below the Minimum value are invalid. 

Property Description
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The PFD checks for illegal tag names, improper data, etc. If an error is 
found, that field is skipped. As each field is checked, the status field is left 
blank in the list editor for any fields found in error. 

Maximum Value Enter the highest value the operator can enter during Runtime. The value 
entered must be less than or equal to the Maximum Value, but greater than or 
equal to the Minimum Value. 

The default value is 100. If the field is left blank, it is set to 0. Negative values 
are acceptable. However, values below the Minimum value are invalid. 

Property Description
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List Viewer Tool

Use the Input List Viewer tool to display an input list on your panel. The 
following table describes the properties available from the Input List Viewer 
menu. For a step-by-step tutorial on using this tool, refer to How to Use 
the List Viewer Tool.

Drag the tool from the tool box onto the panel, then resize and position it. 
To maintain aspect ratio, hold down the CTRL key while resizing from a 
corner. The following table describes the properties available from the 
Input List tool menu. 

Creating Connections to the List Viewer Tool

Once you've created your input list and populated it with data items and 
corresponding values, you need to create connections to your input list. 
Connections allow the Input List Viewer tool to talk to other tools on the 
panel. By adding buttons, indicators, and display tools on your panel, you 
can save, load, and send your input lists to the PFD device. You can also 
add indicators and display tools to monitor the status of an input list. 

The following connections are available for use with an Input List Viewer 
tool. 

Property Description

Name Enter a name for the Input List Viewer, up to 32 
characters. This name should relate to the type of list 
displayed in the Input List Viewer tool. 

The default name is InputList001, and increments by 
one with each new viewer added. 

Appearance The appearance properties let you change the look of 
the Input List Viewer. You can change the style, the 
display format and the display area. For details on 
appearance properties, see Changing Tool 
Appearance. 

Accessibility The accessibility properties determine whether or not 
a tool is visible to all users during Runtime. For more 
information, refer to Changing Tool Accessibility.
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Connection Description

ListStatus Use this connection with a Message Display tool to display status messages related 
to tool events. For example, when using a SendingList connection point, the 
Message Display tool displays the following information:

Note that ListStatus is a string data type.

ListChanged You can use this connection with an Indicator tool to monitor whether or not the list 
has changed from the originally loaded list. 

In Runtime, when you are using the Input List Viewer and you edit the list, the 
Indicator tool changes (and the ListChanged tag goes TRUE) to show that the list 
has been changed. When you save the list, the connection point is cleared and the 
Indicator tool returns to it's original state (the ListChanged tag resets to FALSE). 
The connection point to the tool is also cleared when a new input list is loaded. 

SendingList You can use this connection with an Indicator tool to monitor when the list is being 
sent to the PFD device. When the device receives the SendingList signal, the 
connection point is TRUE and the Indicator tool changes. When all of the values in 
the input list are sent and confirmation is received, the connection point 
automatically goes FALSE and the indicator tool is reset. 

You can refresh the panel while waiting for write confirmations.

SendList You can use this connection with a Button tool to send the displayed input list to the 
control address. 

LoadList You can use this connection with a Button tool to allow you to load a specified input 
list into the Input List Viewer. A Selection List popup tool is displayed, allowing you 
to choose which input list you want to load. 

ClearList You can use this connection with a Button tool to allow you to clear the Input List 
Viewer. 

UploadList You can use this connection with a Button tool to load the data values from the PFD 
device to the Input List Viewer. The operator can now save the list and change 
values as needed. The uploaded values are read from the input tag address ("Send 
Value Input") of each list item. 

SaveList You can use this connection with a Button tool to allow the operator to change a 
value in the input list and then save the changed list. Caution: Doing this writes 
over the original list, you will lose the original data values used in your input list! 
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SaveListAs You can use this connection with a Button tool to allow the operator to change a 
value in the input list and then save the list with a new name. A Selection Entry tool 
is displayed, allowing you to enter a new name for the input list This prevents 
someone from writing over the original input list values. 

Connection Description
 Parker Factory Display User Guide  11-11



USING THE MESSAGE EDITOR 12
You can use the Message editor to setup messages you want to display 
during Runtime. In the Message editor, you create message files or tables 
that are referenced by the Message Display tool. For example, you can use 
the Message Display tool to display warnings, notes, and error messages 
on your runtime device. The Message editor organizes all of these 
messages in one handy area as shown below. 

A message file lets you configure multiple lists of ASCII strings. A Message 
File can hold up to 535 messages. Use message files with a Message 
Display tool on your panel. Setup the Message Display tool to look at a 
register in the device. The register contains a numeric data value in the 
device. The data value indexes a string in the Message File. 

Message Files are composed of message strings and corresponding 
numbers. The number associated with each message string is the data 
value in the register. The number of the message (data value in the 
register) tells the Message Display tool which message string in the 
message file to display. 
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Creating Message Tables 

A message table lets you configure multiple lists of ASCII strings. A 
message table can hold up to 65,535 messages. Use message tables with a 
Message Display tool on your panel. Setup the Message Display tool to look 
at a register in the control device or a local tag. The register contains a 
numeric data value and the data value indexes a string in the message 
table. 

Message tables are composed of message strings and corresponding 
numbers. The number associated with each message string is the data 
value in the register. The number of the message (data value in the 
register) tells the Message Display tool which message string in the 
message table to display. 

To create a message table in your project

1 From the Project editor, select New > Message Table from the menu.

2 Enter a name for the new message table. 

3 Select the OK button in the Message Table screen to accept the 
name and create the message table. 

Whenever a new message table is created, by default the Message editor is 
displayed. You are now working on an individual message table in your 
project. Notice that when you select the Project editor tab, the new 
message table is displayed in the Project workspace. You can either 
highlight the message table and select the Message editor tab or double-
click on the message table to return to the Message editor. 

Adding and Editing a Message 

To add or edit a message:

1 Select your Message Table from the Project editor. The Message 
editor is opened. For information on creating a Message table, refer 
to Creating Message Tables.

2 Select an empty row in the message table to add a new message. 
Select an existing row in the table to edit the message. 

3 Select Text from the Table menu. The Text screen is displayed. 

4 Enter the message you want to display in Runtime. Select the check 
in the upper-right hand corner of the screen to save your message 
and return to the Message editor. 

5 With the new message highlighted in the table, you can control the 
look of the message displayed on the screen using the Font 
properties listed below. 
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The Parker Factory Display allows you to animate any graphic object. 
Graphic animation allows you to take a graphic representation of a 
machine or process that you have created (using the graphic tools) and 
then display it moving and/or changing color/state in Runtime. This gives 
the operator a clear understanding of machine operation. 

Types of Animation

There are five types of animation in the PFD, they are: 

• Appearance

This type of animation allows you to alter the color, gradient, and the 
line style and width of an object in Runtime. 

• Rotation

This type of animation allows you to gradually change the orientation of 
an object in Runtime.

• Transparency

This type of animation allows you to gradually change the visibility of 
an object in Runtime. 

• Location

This type of animation allows you to gradually change the location of an 
object in Runtime. As a result, the object appears to move across the 
panel. 

• Size

This type of animation allows you to gradually change the size of an 
object in Runtime. 

Animating an Object

To animate a machine process or diagram, create your graphics, and then 
connect these graphics to tags. The tags reference data in memory 
addresses in your device. Connect the graphics to tags using the 
Animations menu. The animation occurs when you run your application. 

The basic steps to animate an object, are listed below. For details on using 
each type of animation, refer to the specific animation type. 

1 Select the object you want to animate. 
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2 Click on the Appearance > Animations menu command. 

3 Click on the New menu command. 

4 Choose the type of animation you want to apply to your object 
(appearance, rotation, etc.). 

You can apply multiple animations to one object. As you add 
animation connections, you will see the name of each new animation 
listed in the Animations menu. Animation connections are evaluated 
in order and are cumulatively applied to the object if the assigned 
tag value falls within the configured range or state. If no connections 
are applied, the object is drawn in its original form. 

5 After choosing the type of animation you want to apply to your 
object, you need to set the animation properties. See Animation 
Connections for details. 

6 Next, you need to setup the Output Tag to connect your object to 
your controller. See the Tag Editor for details. 

7 Once your connections are set properly, you can run your project 
and view the animation. See Running Your Project for details. 
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The Parker Factory Display has three main environments: the Shell, the 
Designer and a Runtime environment. The Runtime environment is where 
you test and run your project. For more information on Running Your 
Project, refer to the following: The Runtime Environment

• Customizing the Runtime Environment 

• Testing Your Project in Runtime

• Entering Runtime

• Exiting Runtime 

For information on using the design environment, refer to Using the 
Designer. For information on using the shell environment, refer to Using 
the Shell.

The Runtime Environment

Runtime mode refers to the software environment that lets you run your 
project. Runtime mode includes the ability to display and interact with 
panels, monitor real-time and historical alarms, communicate with the built 
in drivers, and serve tags to clients. 

The server residing on the PFD device is the run mode component that 
drives your project. Your project can reside on a local PC, such as in offline 
development mode and remote access mode, or it can reside on the PFD 
device itself as in normal run mode operation. 

Customizing the Runtime Environment 

You can customize the Runtime environment for your project, by: 

• Configuring an exit key

You can opt to allow the operator to exit the Runtime environment 
through a combination of key strokes. You can choose from one of the 
following key combinations: None, SHIFT + Q, CTRL + Q, SHIFT + F3, 
or CTRL + F3.

The default setting is none, meaning you cannot use a keyboard 
shortcut to exit run mode, you must define an exit button on your 
panel. For more information on creating buttons, refer to the topic 
Button Tool.
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• Displaying data errors

The PFD has five types of Runtime errors: User Level, Syntax, Data, 
Math Scaling, and Write errors. You can choose to display these errors 
during Runtime when they are associated with a specific tool. 

When enabled, an icon is displayed over the input tool during Runtime 
if an error is detected during data transfer. The icons are also displayed 
when monitored data has not been received from the device. 

To customize Runtime:

• Select Runtime Settings from the Project editor menu in the Design 
environment. The Runtime Settings menu is displayed. 

Testing Your Project in Runtime 

Once you have created your project in the Designer, you can test it in 
Runtime. When the project is ready, you can then transfer it to the PFD 
machine that will run the project. 

To test your project, from the Designer:

• Press the Test Runtime icon or F5 to enter the test Runtime 
environment. 

To exit the test Runtime environment:

• Press the stop icon to exit Runtime and return to the Designer. 

Entering Runtime

You can enter Runtime either from the Shell environment or directly when 
starting the PFD device. 

To enter Runtime from the Shell:

• Select the Run icon from the PFD Shell main screen. The Runtime 
environment is displayed and the project is connected to the server 
with live data. 

In order to directly enter Runtime when starting up the PFD device, you 
must enable the Runtime option. This option must be enabled for each user 
you want to start directly in Runtime. Depending on the access rights 
assigned to each user, 

1 Select User Admin from the Setup PFD menu. The User Admin 
menu is displayed. 

2 Select Users from the User Admin menu. The Users screen is 
displayed. 

3 Select Edit... for each user you want to start in run mode. 
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4 Set the Startup Program option to Runtime. This option causes the 
PFD to boot straight into Runtime. The project is then connected to 
the server with live data. 

For more information on user administration, refer to Using the User Admin 
Menu.

Exiting Run Mode 

You can exit run mode by one of two methods: 

• Selecting a button that has it's type property set to exit. 

• Selecting a button that has it's switch input property set to the system 
tag "_HMI_Exit". 

Pressing these buttons causes your project to exit and takes you to the 
Shell, if the you have the proper access right. If you do not have access 
privileges to the Shell, the Shell ignores the command. Exiting run mode 
will then take you to a logon page. You can change Shell access in the User 
Levels screen, for more information refer to Using the User Admin Menu. 

Once you exit run mode, the communications session of the project ends. 
From the Shell, you can return to running or designing the project. 
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The PFD is divided into three translatable environments: PFD Manager, the 
Designer (including Shell), and a Runtime environment. 

Translating the PFD Manager

The PFD Manager can be translated by editing the 
"OfflineLanguage_001.txt" file. This file is located in the folder where PFD 
Manager has been installed. By default this is in C:\Program 
Files\Parker\Parker Factory Display Manager.

Adding a Language

1 Open "OfflineLanguage_001.txt" in an editor such as Microsoft Excel.

2 The default column, named "ENU", contains all translatable strings 
for the PFD Manager. Copy this column and paste it into the next 
column.

3 In the newly added column, replace the first row string from "ENU" 
to one of the supported languges Unicode abbreviation. For 
example, if translating into Spanish (Spain) you would change the 
string to “ESN”.

4 Replace text in each row you wish to translate then save the file.

Switching a Language

For the PFD Manager to display the translated text, Regional Options in 
Windows must be set to the match the added Language.

Translating Designer and Shell

Adding a Language

1 From Shell main meu select Import/Export, then select System 
Language. 

2 Select one or more of the languages from the selection list then 
select Export.

3 Save this txt file to your computer, its name will default to 
"SystemLanguage.txt". 

4 Open this file with an editor such as Excel.
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5 This file contains a new language column with a three-letter heading 
which is the Unicode abbreviation for the exported language. 

6 Translate the string in each row of the new column and save the file. 

7 From Shell main meu select Import/Export, then select System 
Language. 

8 Select Browse and choose the recently edited file. Note that the 
Browse button will only be available when the PFD is in disconnected 
mode. 

9 Select Import. You can now switch the Designer and Shell interface 
to display in this language.

Switching Designer and Shell Language

1 From Shell main meu select Import/Export, then select System 
Language. 

2 In the Imported Languages table, if it contains more than one 
language, select Set Current to switch the system language used in 
the Designer and Shell interface. 

Remove a Language

1 From Shell main menu, select Import/Export the select System 
Language.

2 Select Remove next to the language you wish to delete in the 
Imported Languages table. 

Translating Runtime

The project in Runtime mode can be translated to support multiple 
languages. The language must first be added to the project. Only then can 
a project be configured to use the imported language.

There are three ways to switch the project to display the translated 
language in Runtime.

• Using a Language button

• Using a system tag

• Using the logged-in users language

Adding a Language

1 From Shell main menu, select Import/Export, then select Project 
Language.

2 Select one or more of the languages from the selection list then 
select Export.
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3 Save this txt file to your computer, its name will default to 
"ProjectLanguage.txt".

4 Open this file with an editor such as Excel.

5 This file contains a new language column with a three-letter heading 
which is the Unicode abbreviation for the exported language. 

6 Translate string in each row of the new column and save the file. 

7 From Shell main menu, select Import/Export, then select Project 
Language.

8 Select Browse and choose the recently edited file. Note that the 
Browse button will only be available when the PFD is in disconnected 
mode. 

9 Select Import button. You can now switch the project to display in 
this language.

Working in Desinger with the added Language(s)

1 After adding and importing a project language as described in the 
steps above, enter the Designer.

2 Under the project work space, select Language from the menu on 
the left.

3 Select a language of your choice.

4 Open a panel, labels on your tools should now be translated.

Switching the Runtime Language using a Language Buttonr

1 In Designer, drag the Button tool from the tool box onto the panel, 
then resize and position it. To maintain aspect ratio, hold down the 
CTRL key while resizing from a corner. 

2 Select Type - Language from the Button menu to set the button type 
to Language. Notice the Button menu changes depending on the 
type of button chosen.

3 Select Values - Language from the Button and select one of the 
imported languages.

4 In Runtime mode, pressing this button will switch the current 
Runtime session to the specified language.

Switching the Runtime Language using a System tag

1 In Designer, assign the _HMI_RegionCode system tag to the input 
value of an input tool such as a Numeric Entry.

2 Entering a Region Code number to this system tag in Runtime mode 
will cause the local client Runtime to switch its language to match 
the specified region code. 
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Switching the Runtime Language using the Logged-In User

1 From the Shell main menu, select User Admin then Users. 

2 Choose to add or edit an existing user. 

3 Select one of the languages from the Locale drop down box and 
choose OK. 

4 The next time this user logs in and enters runtime, the project 
language will switch to match the language of that user.

Remove a Project Language

1 From the Shell main menu, select Import/Export then Project 
Language.

2 Select Remove next to the language you wish to delete in the 
Imported Languages table. 

Supported Languages

The following table lists the Unicode abbreviations and code numbers for 
each supported language. 

Unicode Abbreviation Language Code Number

ENU English (U.S.) 1033

SQI Albanian 1052

EUQ Basque 1069

BGR Bulgarian 1026

HRV Croatian 1050

CSY Czech 1029

DAN Danish 1030 

NLD Dutch (Netherlands) 1043 

NLB Dutch (Belgium) 2067 

ENG English (United Kingdom) 2057 

ENA English (Australian) 3081

ENC English (Canadian) 4105

ENZ English (New Zealand) 5129 

ENI English (Ireland) 6153 

ENS English (South Africa) 7177
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ENJ English (Jamaica) 8201 

ENB English (Caribbean) 9225 

ENL English (Belize) 10249 

ENP English (Republic of the 
Philippines) 

13321

ENT English (Trinidad and Tobago) 11273

ENW English (Zimbabwe) 12297

FIN Finnish 1035 

FRA French (France) 1036

FRB French (Belgian) 2060 

FRC French (Canadian) 3084

FRS French (Switzerland) 4108

FRL French (Luxembourg) 5132

FRM French (Principality of Monaco) 6156

DEU German (Germany) 1031 

DES German (Switzerland) 2055

DEA German (Austria) 3079 

DEL German (Luxembourg) 4103

DEC German (Liechtenstein) 5127

HUN Hungarian (Hungary) 1038

ITA Italian (Italy) 1040

ITS Italian (Switzerland) 2064

PLK Polish (Poland) 1045 

PTB Portuguese (Brazil) 1046

PTG Portuguese (Portugal) 2070 

ROM Romanian (Romania) 1048

RUS Russian (Russia) 1049 

SRB Serbian (Cyrillic) 3098 

SRL Serbian (Latin) (Serbia) 2074

SKY Slovak (Slovakia) 1051

ESS Spanish (Argentina) 11274

ESB Spanish (Bolivia) 16394

ESL Spanish (Chile) 13322

Unicode Abbreviation Language Code Number
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ESO Spanish (Colombia) 9226

ESC Spanish (Costa Rica ) 5130

ESD Spanish (Dominican Republic ) 7178

ESF Spanish (Ecudador) 12298

ESE Spanish (El Salvador) 17418

ESG Spanish (Guatemala) 4106

ESH Spanish (Honduras) 18442

ESM Spanish (Mexican) 2058 

ESI Spanish (Nicaragua) 19466

ESA Spanish (Panama) 6154

ESZ Spanish (Paraguay) 15370

ESR Spanish (Peru) 10250

ESU Spanish (Puerto Rico) 20490

ESN Spanish (Spain) 3082 

ESY Spanish (Uruguay) 14346

ESV Spanish (Venezuela) 8202

SVF Swedish (Finland) 2077

SVE Swedish (Sweden) 1053

Unicode Abbreviation Language Code Number
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In order for your application to communicate with a controller, you must 
configure the PFD Manager to work with a COMM Server. To do this, select 
the COMM tab as shown below. 

In the COMM server window, you can launch wizards that help you 
configure channels (communication drivers) and devices (models of 
those drivers). Once you have configured at least one channel and device, 
the PFD Manager can communicate with the COMM server. 

The PFD is designed to run on a standard that makes it compatible with the 
manufacturers of many different communication drivers. For more 
information on the specific driver used with your system, refer to that 
driver's help file. 
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Adding a Channel

A channel is a way of communicating from the PC to one or more external 
devices. A channel can be used to represent either a serial port or a card 
installed in the PC. 

Before adding devices to a project, you must define the channel to use 
when communicating with these devices. A channel and a device driver are 
closely tied. After creating a channel, only devices that the selected driver 
supports can be added to this channel. 

To Add a Channel

Depending on the drivers you have installed, you can define a number of 
channels within a single application. To add a channel you must use the 
Channel Wizard. The wizard guides you through the channel definition 
process. To start the wizard: 

1 Click on the COMM Tab in the PFD Manager. The screen on the 
previous page displays.

2 Click on the Add Channel icon. The Channel Wizard is displayed as 
shown below.

3 The wizard first prompts for a logical name to use for the channel. 
This name must be unique among all channels and devices defined 
in the project. 

4 The wizard then prompts for the device driver to use. A list box is 
displayed with all of the device drivers that are installed in the 
system. 

5 All serial drivers can be used with multiple channels in the same 
project. 

If the device driver supports multiple channels, the wizard then 
prompts for the communication parameters to use. Multiple channels 
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cannot share identical communication parameters, i.e. two serial 
drivers cannot use COM1. Refer to the manufacturer's 
documentation and the driver's online help for the correct 
communication parameters to use for a particular device. 

6 The flow control settings for serial drivers are primarily used when 
connecting RS422/485 network devices to the RS232 serial port via 
a converter. Most RS232 to RS422/485 converters require either no 
flow control (None) or that the RTS line be on when the PC is 
transmitting and off when listening (RTS).

7 The wizard finishes with a summary of the new channel. 

The channel appears in the PFD Manager with a small red x below 
the channel icon. This x denotes that the channel does not contain a 
valid configuration. The channel is not valid because a device has not 
yet been added to the channel. 

8 See Adding a Device, to continue setting up the COMM server. 
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Adding a Device

Once you have defined a channel in your application, you must add a 
device to it. In most cases a device refers to the identification of a physical 
node or station on a communications link. A device is also referred to as a 
model. Only devices that the selected driver supports can be added to a 
channel. 

A device can also be viewed strictly as a way of defining a connection to a 
specific point of interest in your application. In this respect, a device can be 
used as a term when describing the connection to a database object. 

To Add a Device 

After you have added a channel, the Manager window on page 16-3 is 
displayed:

1 Click the Add Device icon. 

The New Device wizard launches as shown below. The device wizard 
lets you name the device and set the node ID. 

2 Accept the default device name of Device1 as shown below: 

3 Depending on the driver you are using in your application, the 
number of dialog boxes in the wizard varies. Follow the instructions 
on the screen. For more information on the specific driver options 
used with your system, click on the Help button to access the 
driver's help file.
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Once you have added both a channel and a device, your COMM Server 
window appears as follows: 

With a channel and device added to your application, the COMM Server is 
ready to start providing data to clients. With the server's online full time 
mode of operation, the server can start providing data immediately. 
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